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STUDY AT A
GLOBAL TOP 2%
UNIVERSITY IN
ONE OF THE MOST
LIVEABLE CITIES
IN THE WORLD
*



**

* TIMES HIGHER EDUCATION WORLD UNIVERSITY RANKINGS 2016-2017
** ECONOMIST INTELLIGENCE UNIT 2016
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INNOVATION & ENTERPRISE
PARTNERSHIP WITH
FOX SCHOOL OF BUSINESS,
US TOP TEN BUSINESS SCHOOL
FOR ENTREPRENEURSHIP
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$120M INNOVATION CENTRE
AT TONSLEY FOR COMPUTER
SCIENCE, ENGINEERING
AND MATHEMATICS

From day one, Flinders University
encourages you to explore
new ideas and discover what
inspires you. We’re constantly
creating an environment rich
with possibilities, where your
academic, social and professional
aspirations are supported and
sustained. Relevant, real world
research drives what you learn
in the classroom and our strong
industry links give you the
experience that can accelerate
your career.
We are delighted that you are considering
Flinders University to begin your exciting
journey of studying in Australia.
As a Flinders international student, you’ll
receive a world-class education that will
equip you to achieve all you aspire to,
wherever in the world that may be.
Flinders lecturers and academics are
leaders in their fields, dedicated to
helping you reach your potential. For more
than 50 years our students, academics
and alumni have contributed significantly
to research and innovation and made a
positive difference in the world. Flinders
is the only university in Australia to offer
innovation and enterprise learning in
each and every course. Our outstanding
links to industry and wide ranging work
placement programs provide valuable,
real world experience while you study.

Adelaide is a lively, safe and friendly place
to study. You can enjoy our beautiful
beaches, spectacular hills and dynamic
city centre, all within easy distance.
Flinders University has recently invested
more than $200 million to develop one
of the most technologically advanced
teaching and research institutions in the
nation. Our main campus at Bedford
Park is located in a natural parklike
setting overlooking the city and the sea,
and our new student hub in the heart
of the campus has been designed and
equipped to transform the way you’ll
learn. Our cutting-edge Computing,
Science Engineering and Mathematics
innovation hub at nearby Tonsley abounds
with collaboration opportunities, and our
business-focused city campus is perfectly
located in Victoria Square in the Central
Business District.
When you choose Flinders, you’re
choosing outstanding student support
networks, modern study resources and
lecturers who genuinely care about your
learning. We give you the confidence to
grow, learn and have an extraordinary
university experience. Whatever your
background, we know you will find
Flinders University an inspiring and
vibrant place in which to develop the skills
that enable you to succeed.
We look forward to welcoming you to
Australia and Flinders University, where
you can achieve the extraordinary.

Professor Colin Stirling
Vice-Chancellor and President
Flinders University

Flinders has a diverse community of
students from more than 90 countries
and values the global perspective they
bring. We take pride in our international
student community and our strong links
with universities and research institutions
worldwide.

186 START-UPS CREATED
AND 1928 INDIVIDUALS
TRAINED BY FLINDERS’
NEW VENTURE INSTITUTE
3

CHOOSE
FLINDERS
$

FAST FACTS
• 3 LOCATIONS
• 24,000+ STUDENTS
• 3,000 INTERNATIONAL
STUDENTS ON CAMPUS
• ADELAIDE, AUSTRALIA

Studying at Flinders University
offers you an outstanding
education in one of the world’s
most liveable cities. Our
courses combine academic
excellence with industry
experience, providing you with
the skills you need to succeed
in your career.

THOUGHT LEADER

RESEARCH THAT MATTERS

Flinders is amongst the top 2% of
universities in the world.* The University
was ranked in the world’s top 400
universities by the Times Higher
Education Rankings 2016-17. Flinders has
earned a reputation for delivering worldclass courses that students love.

Flinders has a world-class reputation
for research and innovation, informing
the professions that shape our society
and developing technologies that are
transforming people’s lives. Ninety
percent of Flinders University’s research
was ranked at or above world standard
in the 2015 Excellence in Research
Australia (ERA) assessment, and the
discoveries of our researchers influence
what you learn in the classroom.

GEARED FOR CAREERS
Flinders University courses are renowned
for being practical, as well as providing
graduates with a clear set of knowledge
and skills that they will be able to use
in their career. There are plenty of
opportunities to undertake a range of
work placements; every year Flinders
students choose to do an internship at
the US congress, study part of their
degree overseas or undertake work
integrated learning opportunities with
employers in Adelaide and across
Australia.

LOVE TO LEARN
Flinders University offers an excellent
staff-student ratio – rated 5 stars by
the 2016/17 Good Universities Guide,
reflecting the University’s commitment
to teaching. Flinders students frequently
comment that they value access to
lecturers and the learning environment
created on campus.

A MULTICULTURAL
UNIVERSITY
Flinders University is a truly multicultural
university with a diverse number of
cultures represented on campus. We
currently have more than 24,000 students
from over 90 countries studying with us.
Studying at Flinders means you join a
global community and can make friends
with many different people from around
the world.

CAMPUS DESTINATIONS
Whether you are relaxing in the leafy
surrounds of the Bedford Park campus,
immersed in the Adelaide city centre
at the Victoria Square campus, or
contemplating the future of international
business at our brand new Tonsley
building, Flinders prides itself on offering
students a great on-campus experience.

STUDENT SUPPORT
We do an excellent job of looking after
our students – academically and also
in support services. Our students are
among the most satisfied university
students in Australia, according to the
2016 i-graduate survey (International
Student Barometer). Flinders is ranked
number one in Australia for overall student
support.**

NEW STUDENT HUB
The $63 million Flinders Student Hub and
Plaza opened in 2016. This extraordinary
new facility incorporates a new retail
precinct, cafés and a pub, alongside
a 2,000-seat outdoor amphitheatre
for concerts, night cinema and even
yoga classes! With Adelaide’s best
panoramic views from a rooftop garden
and new social learning spaces, Flinders
has a wide range of facilities available
to provide you with the best possible
campus experience.

* TIMES HIGHER EDUCATION WORLD UNIVERSITY RANKINGS 2016-2017
** I-GRADUATE INTERNATIONAL STUDENT BAROMETER 2016
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FLINDERS
LOCATIONS
Flinders University offers
you an authentic on-campus
student experience in a
beautiful natural environment.
BEDFORD PARK
Flinders University’s Bedford Park
campus is one of the best-kept secrets
among Australian universities. It is our
main teaching and research campus
and is located in the stunning foothills of
Adelaide, one of Lonely Planet’s Top 10
cities of the world*. The campus offers
panoramic views of the central business
district (CBD) to the north and a long,
stretching coastline to the west.
Just 15 minutes from the beach and
20 minutes from the Adelaide city centre,
Flinders is a superb environment in which
to study, relax and meet with friends.

FLINDERS AT
TONSLEY

VICTORIA SQUARE

Tonsley is the University’s centre for
innovation and entrepreneurship, and
home to the School of Computer Science,
Engineering and Mathematics. It is
Australia’s first innovation district, with
some of Adelaide’s biggest businesses
and industries working alongside and
with Flinders students, academics and
researchers.

Victoria Square is our city location.
Situated in the centre of Adelaide’s
business district, it encourages close
collaboration with surrounding industry
and the opportunity to develop industry
links. It is an alternative location where we
provide information to students and teach
a selection of our courses and topics.
These include:
• Accounting
• Business and Business Administration
• Public Policy and Public Administration
• Social Work
• Law
• Health and Aged Care Administration
• Languages

It is a short five-minute drive from the main
Bedford Park campus. There is a free
bus service that links the Bedford Park
campus with the Tonsley campus and the
Flinders Medical Centre.
Study areas taught at Tonsley include:
• Computing and Mathematics
• Engineering and Design
• Science

Located on Sturt Road, just south of the
central business district of Adelaide,
the campus is well serviced by public
transport and gives our students
everything they need to study and relax.
The campus boasts state-of-the-art
student and learning facilities (including
a brand new Student Hub and Plaza),
sport and fitness facilities and student
accommodation – all nestled within a
beautifully landscaped environment.

TONSLEY
FAST FACTS
• $120 MILLION
INNOVATION CENTRE
• 28 LABORATORIES
• 150 STAFF
• 2,000 STUDENTS

Flinders at Tonsley is the heart of
South Australia’s new industrial future.
It embodies world’s best practice in
education, teaching and research. It’s a
place where innovation, collaboration and
entrepreneurial spirit combine to create
the products and processes of the 21st
century – and beyond.
More than 150 staff and 2,000 students are
housed there, including two state-of-the-art
lecture theatres and expansive, modern
collaborative teaching spaces.
The building has 28 specialised
laboratories in which students can
study a range of disciplines including
biomedical, civil, electrical, electronic,
mechanical and software engineering,
information technology, network systems
and mathematics.

An integral part of studying engineering at
Flinders is the opportunity to experience
future employer environments firsthand with a 20-week work-integrated
learning (WIL) placement. The close
business-industry relationships that will
be spawned by Flinders at Tonsley will
further expand these WIL opportunities,
which play an invaluable role in preparing
job-ready graduates.
Flinders at Tonsley is home to the New
Venture Institute, Flinders Partners,
Medical Device Research Institute,
and Centre for Nanoscale Science and
Technology alongside some of Adelaide’s
biggest businesses and industries.

2018 RAIL EXTENSION
Getting from Flinders to the city is easy. And it’s about to get even easier.
Expected to be completed in 2018, a new $85-million train extension will transform
travel between Flinders and the city, so you can step in and out of the Flinders
environment seamlessly.
With a swift, 20-minute commute, you’ll be able to reach the city after classes to
shop, eat, or catch up with friends. You can also visit Flinders at Victoria Square,
an accessible and alternative space for students, staff and the general public.

* LONELY PLANET TOP 10 CITIES OF THE WORLD TO VISIT 2014

Students relaxing at Flinders’ Bedford Park campus
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Flinders’ city location, Victoria Square

Flinders at Tonsley; centre for innovation and entrepreneurship
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CONNECT WITH
INDUSTRY

INNOVATION &
ENTERPRISE
FLINDERS NEW VENTURE
INSTITUTE

At Flinders we prepare you
for the careers of tomorrow,
providing you with the
‘personal enterprise’ skills
you need for the many career
changes you are likely to have
over your lifetime.
Flinders University now offers all students
the opportunity to embed innovation and
enterprise topics within their degree.
At Flinders, we recognise that careers
are evolving and the workplace of the
future will look very different from today’s.
We’re constantly fine-tuning our degrees
to empower you to create the jobs of the
future.

FOX SCHOOL OF BUSINESS
The new innovation and enterprise
suite is powered by the Fox School of
Business, a U.S. top ten business school
for entrepreneurship* and cutting-edge
online teaching. Each topic is embedded
with the philosophy of Flinders New
Venture Institute, our innovation and
entrepreneurial arm.
By providing you with the skills necessary
to enhance your creativity, understand
and embrace innovation, and think
like an entrepreneur, we’ll prepare you
for graduate success. You’ll gain an
understanding of the forces of disruption,
using new technology and business
models to succeed in the industries of
today, and challenge the industries of
tomorrow.
Expand your learning experience and
excel in a future that will be automated,
globalised and collaborative, by adding
innovation and enterprise topics to your
degree.
For more information, visit:
study.flinders.edu.au/ie

Flinders’ New Venture Institute
(NVI) is the home of innovation and
entrepreneurship at Flinders.
Established in 2013, the NVI accelerates
graduate careers across all disciplines,
building entrepreneurship skills, inspiring
bold new ways of thinking, educating for
the careers of tomorrow and industries
of the future, and connecting business,
research and students.
NVI’s location at Tonsley embeds
education with business and innovation,
providing a catalyst to address business
challenges through experiential education.
By inspiring, educating and providing
invaluable industry links, NVI endeavours
to create an ambitious, industry savvy
community at Tonsley.
For more information, visit:
nviflinders.com.au

FLINDERS NEW VENTURE
INSTITUTE HAS INCUBATED
186 START-UPS, INCLUDING:

* THE PRINCETON REVIEW AND ENTREPRENEUR MAGAZINE, 2016

Flinders University has
strong links with industry
and our students learn beyond
the excellent facilities on
campus.
Flinders has forged strong relationships
with numerous industry partners locally
and internationally, with the intention of
producing job-ready graduates who meet
employers’ expectations.
Many of our degrees are professionally
accredited by independent industry
bodies including Certified Practicing
Accountants of Australia (CPA),
Chartered Accountants Australia and
New Zealand, the Institute of Public
Accountants, the Australian Human
Resources Institute and the Australian
Psychology Accreditation Council
(APAC).
Many of our engineering degrees are
accredited by Engineers Australia and the
Australian Computer Society. Both bodies
are signatories to international agreements
allowing graduates from accredited
courses to practise around the world.
Some of the many important industry and
project-based partnerships Flinders has
formed include:

BUSINESS
AUSTRALIAN FASHION LABELS
Australian Fashion Labels (AFL) is a
top fashion apparel company based
in Adelaide, with over 3,000 stockists
worldwide and international offices in
Los Angeles and Shanghai. Flinders
Business School students can
undertake work placements at AFL and
gain hands-on experience in public
relations, social media, international
marketing and accounting. Students
have the opportunity to contribute to
real campaigns, implementing marketing
strategies, assisting with photoshoots and
networking with industry professionals.

INFORMATION TECHNOLOGY
CISCO AUSTRALIA
Cisco, a worldwide leader in networking
and the provider of state-of-the-art
campus network infrastructure at Flinders,
will support high quality research
in emerging and innovative health
technologies. Flinders and Cisco have
also established a Cisco Academy at
Tonsley, which delivers a curriculum to
train students for the jobs of the future.

MEDICINE, HEALTH &
NURSING
SA HEALTH
Flinders works in partnership with the
South Australian Department of Health
and Ageing to provide clinical training
placements to our medicine, nursing and
health sciences students in hospitals and
health services across South Australia,
primarily through the Southern Adelaide
Local Health Network (SALHN) and
Country Health South Australia (CHSA).
These placements ensure our students
are well equipped to apply the theory
they learn to patients and communities in
a variety of health service settings. The
Flinders School of Medicine is co-located
with Flinders Medical Centre – a major
South Australian hospital. This means
our medical and other health students
have the opportunity to be exposed
to authentic, patient-centred clinical
experiences from early on in their course.
Rural placements are also a focus of
our degrees, exposing students to a
professional multidisciplinary environment
where patient presentations cover a wide
range of needs.

Work in the area has the potential to
radically change how people interact with
health services, and how they manage
and maintain their health throughout life.

elppy.com

voxon.co

populize.co

“The best thing about studying
at Flinders is gaining real life
experience, and implementing
those experiences wherever you
may work.”
Vinh Tran
Bachelor of Business
Vietnam

thenurturedchild.com.au

Collaboration space at Flinders at Tonsley
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GREAT CAREERS
START HERE
AWARDED
for graduate salaries
2016 Good Universities Guide

Studying at Flinders is the
first step towards your future
success. We have a range of
services and resources to help
you achieve your career goals.

Flinders is committed to preparing you
for a career. To explore which career
best suits you and to develop the skills
and knowledge required to achieve your
career goals, Flinders provides you with
great education opportunities that go
beyond the classroom.
We provide you with dynamic learning
experiences that empower you to think
big and instil within you an entrepreneurial
mindset that is highly sought after
globally.
Our students are encouraged to pursue
international exchange opportunities,
integrated work placements, fieldwork
opportunities and double-degree options
available across a wide range of degrees.
Flinders has been awarded 4 stars for our
graduate starting salaries (2016 Good
Universities Guide) and our alumni are
making significant contributions locally,
nationally and internationally, in fields as
diverse as the arts, business, sciences,
humanities, linguistics, and mathematics.

WORK INTEGRATED LEARNING
We know that our students will have
better career options if they graduate with
both qualifications and work experience.
That’s why many of our degrees give
you the opportunity to undertake work
components and industry initiatives, and
why the Careers and Employer Liaison
Centre provides a comprehensive range
of career resources.
Through work placements, you will spend
part of your study time with industry,
applying your new knowledge and testing
yourself in real-world situations. These
work placements give you an insight that
greatly enhances both your learning and
your future career prospects.

“Flinders lecturers have both
academic and real world
experience. This means I can
learn from many perspectives, and
I now apply my learning in
my future career.”
Danaphone Chaluensouk
Master of Public Administration
Laos

CAREERS ADVICE ON CAMPUS CAREER RESOURCES FOR YOU
Flinders University has a dedicated Careers
and Employer Liaison team on campus who
offer information, support, advice, seminars
and events specific to international
students. They can help you familiarise
yourself with the structure, environment and
expectations of the Australian workplace.
These services continue to be available
to you for up to eighteen months after you
complete your studies.
A team of specialist career development
consultants is also available to help you:
• develop your résumé
• write application letters
• address selection criteria
• make online applications
• find your career direction
• practise interview skills
• get career advice and support

MENTORING
The Flinders Ignite Mentoring Program
offers you a career mentor to assist you
get ready for the transition from study to
employment. The program enables you
to expand your professional networks,
develop your skills and prepare for your
future career. Find out more at
flinders.edu.au/ignite
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• WorkReady Program provides an
opportunity to undertake unpaid work
experience and develop the skills
employers want while learning about
working in a professional environment.
• Horizon Professional Development
Award provides you with a range of skill
development opportunities to stand out
and gain skills to become work ready.
• Daily Jobs List postings every week
provide you with jobs from a range of
sources relevant to you while you are
studying and after you graduate.
• Career development consultants
offer drop-in advisory services and job
searching assistance. These services
are offered in Flinders Connect.
Find out more from the careers service
website: flinders.edu.au/careers

$

WORK
RIGHTS FOR
INTERNATIONAL
STUDENTS
The Australian Government allows
international students to work up to
40 hours per fortnight, and full-time
during semester breaks. Work rights
are granted automatically when you
receive your visa. For more
information, visit:
flinders.edu.au/internationalstudents/services/working-inaustralia.cfm
Flinders University Student Association
lists a range of job vacancies at
fusa.edu.au/jobs and local job
websites include seek.com.au and
careerone.com.au
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ACADEMIC
EXCELLENCE

WORLDCLASS
RESEARCH
IG
NOBEL
PRIZE

2015 IMPROBABLE
RESEARCH AWARD
WON BY FLINDERS
CHEMISTRY PROFESSOR
COLIN RASTON FOR
UNBOILING AN EGG

SA SCIENTIST OF
THE YEAR

QS WORLD UNIVERSITY
RANKINGS BY SUBJECTS 2017

Our academic staff are
committed to providing
both first-class education
and research that makes a
difference.

• Top 100 of universities worldwide
for nursing

Flinders University seeks to foster
excellence, innovation and flexibility in
teaching in order to enrich the learning
environment and enhance effective
learning by its students.

• Top 200 of universities worldwide
for sociology

Flinders is a member of the International
Network of Universities (INU) and the
Innovative Research Universities (IRU),
a group of six internationally recognised,
student-focused, research-intensive
universities.
Flinders is ranked amongst the top 2% of
universities worldwide.*
*TIMES HIGHER EDUCATION WORLD UNIVERSITY RANKINGS
2016-2017

• Top 200 of universities worldwide for
education and training
• Top 200 of universities worldwide
for psychology

• Top 200 of universities worldwide
for English language and literature
• Top 250 of universities worldwide
for medicine
• Top 300 universities worldwide
for agriculture and forestry
• Top 300 of universities worldwide
for law and legal studies
• Top 315 of universities worldwide
for life sciences and medicine
• Top 337 of universities worldwide
for arts and humanities

“At Flinders, we teach not
just for now, but for what
is coming. Our students
need to be ready for
employment in five years’
time. The speed of change
in our range of disciplines
is massive, so we need
to ensure we don’t just
connect to industry, we
contribute to it.”
Professor John Roddick
Dean of the School of
Computer Science,
Engineering and
Mathematics

• Top 401 of universities worldwide
for social sciences and management
• Top 451 of universities worldwide for
biological sciences

2015 Craig Simmons
2013 Graeme Young
2012 Karen Reynolds

Our courses draw on the world-class research conducted at
Flinders, ensuring you are taught the latest thinking across a
wide range of fields.
Flinders is home to a vibrant and constantly evolving research community. Our areas
of research strength operate across a range of disciplines broadly housed under five
themes: biomedical and clinical sciences; culture, policy and society; health and human
behaviour; molecular science; and technology, water and environment.
Ninety percent of Flinders University’s research has been ranked world-standard or
above in the Australian Federal Government’s most recent Excellence in Research for
Australia assessment (2015).
Flinders also appoints elite international and Australian researchers as strategic
professors to sharpen the University’s research profile and build strength in areas of
strategic research significance.
For more information on our research capabilities, visit: flinders.edu.au/research
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YOUR RESEARCH
OPPORTUNITIES

Coursework: where you usually attend
lectures and tutorials, with assessment and
possibly some practical work throughout the
course.
Research with a coursework component:
A research degree where coursework is only
a minor part of the research program.
Flinders offers masters research degrees
with a coursework component. These
include:

With new research constantly
making headlines, we offer an
invigorating student research
culture for you to immerse
yourself in during your
postgraduate education.
Research at Flinders explores fundamental
questions and tackles the most important
real-world challenges of our time.
Flinders maintains a significant and growing
presence in research and innovation in
Australia and internationally.
We host national research centres and
collaborate with universities and research
institutes across the world to explore a wide
range of issues, ideas and problems, finding
new possibilities and solutions, further
questions and new knowledge.
We engage closely with industry partners
and end-users to ensure that our research
makes a difference.
Our Medical Device Research Institute,
for example, develops, tests and makes
available practical tools to assist people
with both physical and cognitive disabilities,
as well as social disadvantage. Many of
our researchers work alongside rural and
regional populations to ensure a vibrant and
sustainable future for Australia’s remote and
regional populations. Flinders molecular
technologists are working with industry
to create more effective products and
cleaner industries, and Flinders cultural and
humanities researchers are opening the
world of the creative arts to new analysis
with their e-research initiatives.

Flinders’ research is changing the world.
Our research strengths include:
Ageing – Our multidisciplinary research
focus aims to gain a deeper insight into
individual and societal ageing to improve the
health and wellbeing of older people.
Cancer research – Seeking to reduce
the impact and burden of cancer through
excellence in cancer research and its
translation into clinical practice. This work
is supported by a new $27 million research
and treatment facility.
Clean technology – Creating a zero-waste
society through products and processes
that are benign by design.
Climate research – This cross-disciplinary
research centre is exploring the adaptive
capacity of organisms to respond to
environmental change in terrestrial and
marine environments.

Vision – World Class researchers and
state of the art facilities are bringing quality
research on the highly complex link between
optics of the eye and visual performance,
quality of life for patients in a clinical setting
and clinical trials on new imaging devices to
validate their reliability to the fore.
Water and the environment – Research
expertise linking biophysical study with
social sciences and humanities to tackle
complex water (including groundwater) and
environmental problems. Researchers and
professionals from multiple disciplines are
pooling their expertise in major research
programs to unlock the secrets of subsurface water systems.
For more information regarding these
research areas and more, visit:
flinders.edu.au/research/our-research

YOUR STUDY OPTIONS

Clinical change – Filling critical gaps in our
knowledge on chronic disease management
and research into the development of more
cost-effective health care interventions.

You can undertake postgraduate study with
a program of research, coursework or a
combination of both.

Health, society and equity – A national
centre for research into the social
determinants of health and wellbeing.

Pathways

Health technologies – Medical devices
and digital technologies represent one of the
most rapidly growing and dynamic sectors of
the global economy. Our research has won
numerous awards.
Nanotechnology and material science –
Flinders molecular scientists are working
with industry partners on projects from
cosmetics manufacturing to food flavouring
research.
Neuroscience – Exploring how nerve cells
in our brain, spinal cord and peripheral
nervous system control our behaviour.
Psychology – A leading group applying
psychological research to five broad
areas: applied cognitive psychology, social
psychology, clinical health psychology,
developmental psychology, and
psychophysiology and neuroscience.

Flinders University has a range of pathways
to help students enter a research higher
degree. Interested students can apply
directly after their honours year, or upon
completion of a Masters (Coursework)
with an 18-Unit Thesis component. We’ve
also developed a special pathway with
our exclusively offered Graduate Diploma
in Research Methods. This is the first
course of its kind offered in Australia, and
is suitable for those with no or out of date
honours or Masters degree, clinicians and
working practitioners, students transitioning
from one discipline to another or working
professionals who need an academic
pathway to meet research higher degree
eligibility requirements.
For further information please visit:
flinders.edu.au/research-degrees/

• Master of Arts in Applied Population
Studies
• Master of Clinical Education
• Master of Clinical Rehabilitation*
*This course may be undertaken as a
coursework higher degree where the
research component is only a minor part of
the total program.
Research: Where your degree is awarded
primarily on the basis of a thesis embodying
the results of a unique research project.
Most students undertaking a research
degree at Flinders enrol in one of the
following masters or doctorate courses:
Masters
•
•
•
•
•
•
•

Master of Arts
Master of Business
Master of Engineering
Master of Laws
Master of Science
Master of Surgery
Master of Theology

Doctorate
• Doctor of Philosophy (PhD) in all
disciplines
• Doctor of Philosophy (Clinical
Psychology) which includes some
coursework
Professional Doctorate
• Doctor of Education (EdD) which includes
some coursework
• Doctor of Public Health (DrPH) which
includes some coursework
For more information about available
postgraduate courses please visit:
flinders.edu.au/courses/postgrad

SUPPORT AND SCHOLARSHIPS
Flinders University encourages strong personal
relationships between staff and students
offering a safe, friendly and stimulating
environment for you to become a part of. We
take pride in our reputation for providing a wide
range of services for students.
International postgraduate students applying
to study at Flinders may be eligible to apply
for a number of university and government
funded scholarships to assist with the cost
of living and studying in a foreign country.
For further information on available
scholarships, visit:

Cotutelles
Cotutelle Doctoral Degrees allow research
higher degree students the opportunity
to experience an extended overseas
research stay abroad (one third of their
candidature), and obtain a joint PhD in
the process. This enhanced program
offers invaluable international networking
opportunities, prized professional and
personal development experience in an
overseas research environment, support of
two principal supervisors and an enriched
PhD candidature. The Office of Graduate
Research offers tailored advice and support
throughout the application process. For
more information about this program please
visit: flinders.edu.au/graduate-research/
cotutelle-doctorate-degrees/

RESEARCH HIGHER
DEGREE PROFESSIONAL
DEVELOPMENT PROGRAM
Our Research Higher Degree Professional
Development Program is available free
to all students. The program helps build
confidence and motivation through a series
of workshops, seminars and lectures to
equip you with the necessary professional
and research skills upon graduation. More
information can be found at the Office of
Graduate Research website:
flinders.edu.au/graduate-research/
programs-and-courses/rhdpdp.cfm

OFFICE OF GRADUATE
RESEARCH
The Office of Graduate Research (OGR)
develops policies and programs that
support research higher degree students
from the commencement of their degree
to their final thesis submission. The Office
connects prospective students with trained
high-quality supervisors, offers international
travel and research opportunities, and
is constantly improving and streamlining
administrative processes and policies
to enhance the research higher degree
experience. The OGR provides tailored
comprehensive advice to candidates
as they progress through their PhD. It
manages the Register of Research Higher
Degree Supervisors, cotutelle degrees
and the research higher degree policies
and procedures. The staff in the Office of
Graduate Research are able to provide
advice to postgraduate research students.
Visit the Office of Graduate Research
website for useful resources and information
about managing your candidature:
flinders.edu.au/graduate-research
In addition to services outlined elsewhere
in this course guide, our commitment to
international research students studying on
campus includes:
• work space and secure storage facilities
• use of a computer with internet access
and email account
• maintenance support for consumables
such as stationery, photocopying, printing,
library and other research-related items.

flinders.edu.au/scholarships
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STUDENT HUB
& PLAZA
Your Student Hub and Plaza
is open 24/7 to help you get
the most out of your
on-campus experience.
The Hub brings the best of coffee and
street food culture to the heart of the
Bedford Park campus, with retail
options, innovative study spaces
and free wi-fi access. With an exciting mix
of vegan, vegetarian and halal options
available, there is something for everyone.

FOOD
• Alere Restaurant

• Kutchi Deli Parwana

• Tavern by Burger Theory
• Subway

LEARN
Whether you want a quiet space for
individual study, a group study area to
collaborate with your peers, or a more
formal meeting room with audio-visual
facilities for presentations, the Hub
provides flexible variety of study spaces
to suit your needs.

PLAZA

• Grind & Press Café

• Toly Vietnamese

Designed with input from
students and staff, the
Student Hub and Plaza is a
great place to learn, connect
and play.

• Urban Paddock Co.
• Café Bon Voyage
• Student kitchen

RETAIL
• Pharmacy

The Hub provides easy access to the
Central Library so you can research,
study and relax within close reach of the
resources you need. The Central Library
serves the whole Flinders community,
while specialist libraries act as
information hubs for those studying law,
legal studies, nursing and health, and our
medical programs. You will find more than
one million books and journals, extensive
electronic collections, and a wide range
of services and facilities to support your
learning and research interests.

YOUR CAMPUS
EXPERIENCE
CONNECT
Find a computer on campus or bring your
own and connect to our free, secure and
fast eduroam wi-fi network.

Flinders provides a range of
venues and services to help
you enjoy your life on campus.

You can also access print stations in the
Hub and Library using a Mac or PC, or
by connecting your device using your
Unicard.

FLINDERS UNIVERSITY
STUDENT ASSOCIATION (FUSA)

PLAY
Soak up the fresh air in the 2,000-seat
terraced amphitheatre, which features
a giant super screen and plays host
to everything from video-game
challenges to moonlight cinema and
Adelaide Fringe events.
You can also relax in the Hub’s Club
Lounge, where you can hang out with
friends and watch TV, play Xbox or just let
the rest of the University hurry by.

Run for students by students, the
Flinders University Student Association
(FUSA) develops life and culture on
campus. Membership is free.
FUSA represents your rights and
interests, and provides a range of services
to students looking for support or advice.
FUSA can help with academic support,
student advocacy and financial guidance.
Financial assistance through annual
grants and emergency loans is available,
and a range of services including casual
employment placements and DVD lending
is also on offer. For more information, visit:
fusa.edu.au

CLUBS AND SOCIETIES
Non-sporting clubs operate under
the umbrella of the Flinders University
Student Association, as does the studentrun magazine Empire Times.
Flinders has a range of clubs and
societies to cater to your interests,
whether they are related to your degree,
religion, culture, political affiliation, or
just for fun. Becoming a part of a club
is a great way to get involved in campus
life, to meet people and to gain valuable
organisational experience. If you can’t find
a club or society that meets your interest,
start your own! For more information, visit:
fusa.edu.au/clubs

FLINDERS UNIVERSITY ART
MUSEUM AND CITY GALLERY
Established as a dynamic teaching
resource, the Flinders University Art
Museum houses an expanding collection
of art to excite your senses, inspire the
imagination and foster new ways of
thinking.
The museum connects with and actively
engages students of all ages with its
historical and contemporary collections
of European Master prints, Aboriginal
and Torres Strait Islander art, Australian
political posters and post-object
collection.
The museum serves both the University
and the community through the delivery
of exhibitions, public programs and
research opportunities. Visit:
flinders.edu.au/artmuseum

• Post Office
• Campus Store
• Co-op bookstore
• STA Travel
• Wholefood Store

SERVICES
• Flinders Connect
• Flinders University Student
Association (FUSA)
• Central Library
• Individual and group study spaces
• Computer access
• Wi-fi and printing
hub.flinders.edu.au
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The new Student Hub and Plaza is the very heart of our Bedford Park campus for study,
socialisation, recreation and student services

Students taking a break in the Student Hub and Plaza

Study space in the Student Hub and Plaza
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CHOOSE
ADELAIDE
ADELAIDE IS THE CAPITAL OF
SOUTH AUSTRALIA – A CITY OF
FESTIVALS, RELAXED LIVING AND
EDUCATION EXCELLENCE.
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CHOOSE
ADELAIDE
A HIGH STANDARD OF LIVING
Studying in Adelaide means you are
also residing in one of the world’s most
liveable cities. We have a relaxed, easygoing lifestyle and Adelaide has been
acknowledged as Australia’s safest city.
Adelaide is in the Top 5 liveable cities in
the world (Global Liveability Study 2016)
and one of the world’s Top 10 cities to visit
(Lonely Planet 2014). Adelaide is ranked the
26th best city in the world for student living
worldwide (QS Best Student Cities 2016).

AUSTRALIA’S MOST
AFFORDABLE MAINLAND
CAPITAL
Your money will go much further in Adelaide.
Statistics show it costs around 20%
less to live in Adelaide than Sydney and
Melbourne.* This means more money to
discover Australia during your study breaks.
*2016 ECONOMIST INTELLIGENCE UNIT

STUDENT SUPPORT

AN AUTHENTIC ‘AUSSIE’
EXPERIENCE
South Australia offers an authentic
Australian experience. The state offers a mix
of beautiful landscapes, sparkling beaches,
rolling hills and a vibrant urban centre. Visit
our world famous wine regions, the rugged
Flinders Ranges, and popular metropolitan
beaches, or see Australian wildlife on
Kangaroo Island. All this, and more, is
waiting for you.

ADELAIDE IS AUSTRALIA’S
MOST AFFORDABLE
MAINLAND CAPITAL.
IT COSTS AROUND
20% LESS TO LIVE IN
ADELAIDE THAN SYDNEY
AND MELBOURNE.*

Study Adelaide runs a year-long calendar
of free and discounted events especially
for international students. From tickets
to sporting matches and arts events to
employment seminars and regional tours,
you can discover everything Adelaide has to
offer. As soon as you arrive, you’ll be given
a free welcome backpack and guide with
everything you need to know about living in
Adelaide. For more information, visit:
studyadelaide.com

$

FAST FACTS

NO . 9

Lonely Planet’s Top 10 cities
in the world to visit
Lonely Planet
2014

MOST AFFORDABLE
MAI N L AN D AUSTR ALIA CAPITAL CITY
Studies in Australia

Global Liveability
Study 2015

LIVEABLE CITIES
OF THE WORLD
South Australia has beautiful beaches
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ADELAIDE:
A VIBRANT CITY
Enjoy a safe, relaxed lifestyle
in our vibrant city.
SAFETY AND SECURITY
Safety and security is another key part of
life in Adelaide. It is a relatively safe city
by international standards and has been
recognised as Australia’s safest city.*
On campus, students are able to enjoy the
safe environment provided by our 24-hour
security service.

GETTING AROUND
Adelaide is well serviced by public transport,
which covers the greater metropolitan region
with trains, buses and trams. International
students in Adelaide receive the same
transport concessions as local students,
saving you up to $700 per year on transport
costs. A free tram and bus service runs in
the Adelaide city centre.
Buses run frequently to and from Flinders
University and the adjacent Flinders Medical
Centre, with various routes running directly
from the city and suburbs. As of 2018, a new
train extension will connect Flinders to the
city, making it even easier to get around.
Adelaide is also a cycling-friendly city, with a
large community of cyclists and world-class
cycling events. There are plenty of opportunities
to buy new and second-hand bikes.

FESTIVALS

SHOPPING

South Australia is often called the ‘Festival
State’, and there are regular cultural and
social events including WOMADelaide,
the nation’s favourite outdoor world music
festival, and the world-renowned Adelaide
Festival and Fringe. As well as the music
and multicultural events, you’ll also enjoy
a number of sporting festivals including
cycling’s Tour Down Under and the V8
Supercar Clipsal 500 carnival. There is
something for you to enjoy year round
whatever your taste! For more information
visit: southaustralia.com

From high-end brands to local retailers,
Adelaide has a wide range of choices,
making it easy to shop for any taste or
budget. Westfield Marion, the biggest
shopping mall in Adelaide, is located just
10 minutes from our Bedford Park campus.
Rundle Mall, located in the city centre, offers
a strip of pedestrianised shopping with
department stores and high street brands,
while the café-lined Rundle Street is home
to designer labels. Further out of the city
there is a host of charming shopping streets:
Norwood Parade, Unley Road and King
William Road all offer the best of designer
and high-street shopping.

FOOD
South Australia has a reputation for being a
food centre, with a higher ratio of cafés and
restaurants to residents than any other city
in Australia.
Our state is well-known for the quality of our
produce – from fresh fruit and vegetables
through to the finest meat and seafood.
We have a vibrant market culture. The city’s
proximity to well known produce regions,
such as the Barossa Valley and McLaren
Vale, offers residents easy access to a
number of farmers markets selling fresh,
seasonal and regional goods. The range
of food available is also a reflection of our
multicultural city. Adelaide is well-equipped
for vegan and vegetarian students. There is
also a range of grocery stores, restaurants,
butchers and takeaway food outlets that
offer Halal or Kosher food.

*SUNCORP BANK FAMILY FRIENDLY CITY REPORT 2013

“Adelaide is a great place
to live. There is always a
market or festival for me to
enjoy and there are plenty
of opportunities to make
friends, de-stress and enjoy
the beautiful surroundings
Adelaide has to offer.”
Victoria Yeo
Bachelor of
Clinical Sciences
Singapore
Adelaide Central Markets
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Clockwise from top: The Gallery rooftop bar; Santos Tour Down Under cycling race; Adelaide Oval; Glenelg beach; Adelaide skyline
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ADELAIDE
FAST FACTS
SOUTH AUSTRALIA

TOP 5

REGIONS IN THE WORLD
LONELY PLANET’S BEST IN TRAVEL 2017

TIME ZONES

LIVING IN ADELAIDE

Australia is divided into three time zones,
with Adelaide coming under Australian
Central Standard Time (ACST).

Living in Adelaide is easy. Adelaide is one of
Australia’s most liveable cities and a great
place to study.

Time difference between Adelaide and
overseas:

Adelaide is more affordable than Sydney,
Melbourne, Perth and Brisbane.

Autumn (March to May)
20˚C to 25˚C / 68˚F to 77˚F

• Indonesia – less 2.5 hours

Winter (June to August)
10˚C to 15 ˚C / 50˚F to 59˚F

• Malaysia – less 1.5 hours

Spring (September to November)
20˚C to 25˚C / 68˚F to 77˚F

• United Arab Emirates – less 5.5 hours

It is recommended that individuals budget
between $19,830 to $26,288 for annual
living costs in Australia. This estimate will
increase if individuals are accompanied by
partners and children.

WEATHER
With a population of
South
Australia is fortunate to have
1.23 million, Adelaide stretches a Mediterranean
climate, with long, hot
along 70 kilometres of
summers and cool to cold, snowless winters.
Summer (December to February)
coastline in South Australia.
25˚C to 35˚C / 77˚F to 95˚F

ADELAIDE: CAPITAL OF
SOUTH AUSTRALIA
Adelaide is the capital of South Australia
– a region of many contrasts, from rugged
outback wilderness, to beautiful beaches.
The region was recently voted by Lonely
Planet as one of the top five places in
the world to visit in 2017*. Known for our
unique wildlife, iconic natural landscapes
and friendly, laid-back people, you will be
warmly welcomed as you begin your journey
from wherever you are in the world to South
Australia.

• Singapore – less 1.5 hours
• China – less 1.5 hours
• Germany – less 7.5 hours
• United Kingdom – less 9.5 hours
• USA – less 18 hours

Websites to assist you in developing a
budget for living costs include:
studyinaustralia.gov.au/global/live-inaustralia/living-costs
education.gov.au/australianpostgraduate-awards
moneysmart.gov.au/managing-yourmoney/budgeting

ADELAIDE COST OF LIVING
ESTIMATES
Average weekly costs*
Accommodation
(shared or single)

$ AUS
$135-250

Public transport

$20-35

Food (eating at home)

$90-135

Utilities
(Electricity/gas/water)

$40-55

Telephone and internet

$20-40

Clothes/Entertainment

$50+

Total

$355-565

*These prices are estimated for 2018

* LONELY PLANET’S BEST IN TRAVEL 2017

ESTIMATED FLIGHT TIMES TO ADELAIDE

London

Beĳing 13 hours

22 hours

Dubai

13 hours

New Delhi
10 hours

Tokyo 9 hours
Guangzhou
9 hours

Lagos

22 hours

Buenos Aires
19 hours

Nairobi

16 hours

Singapore

7 hours

Johannesburg 12 hours

Auckland

4 hours

There are many direct flights into Adelaide from all around the world.
Flinders University also offers a free meet-and-greet service at the airport
for new international students. See page 28 for details.
Barossa Valley vineyards
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Rundle Street

Adelaide Central Markets

25

ACCOMMODATION
IN ADELAIDE
Flinders is the only university in UNIVERSITY HALL
Adelaide where you can choose The University Hall is a catered collegiate
residence with a strong collegial atmosphere.
to live on-campus. Experience The hall has accommodation for over 250
in fully-furnished single rooms,
all the friendship, support and students
secure storage and car parking and small
communal kitchens. You can mix with other
social opportunities that help
students in common areas, sporting areas,
make Flinders such a great
the outdoor cinema, gazebos and gardens
including a landscaped central courtyard.
place to live and study.
ON-CAMPUS LIVING
The Flinders campus is safe, affordable
and convenient. By living on-campus you
will be part of a diverse community of
students from across Australia and over
30 countries worldwide.
You have the option of living either at the
catered University Hall or independently
in the self-catered Deirdre Jordan
Village. Both options offer academic and
personal support from in-house tutors
and coordinators. Public bus services run
regularly to the local shopping precinct,
beach and city centre.
Temporary accommodation is also available
when you first arrive in Adelaide during
the December to mid-February period
(depending on availability).
More information and current fees can be
found at: flinders.edu.au/living

Cost:
$395 per week for a single room, including
15 professionally prepared meals per week.*

DEIRDRE JORDAN VILLAGE
The Deirdre Jordan Village provides
modern accommodation in self-catered
fully-equipped units. The village also offers
a range of culturally inclusive activities in
the community centre for those who wish to
develop a strong community atmosphere.
The village has accommodation for over
300 students, living areas (some private),
landscaped gardens and outdoor areas
with barbecues and secure storage and car
parking. Single gender accommodation is
also available.
Cost:
$250 per student per week, including all
utilities.*
For more information, please visit:
flinders.edu.au/living
*costs are based on 2017 rates

$

LIVING
OFF-CAMPUS
AUSTRALIA’S NO.1
university campus suburb
for student housing
affordability in 2017*
*rent.com.au

With Flinders University’s convenient
location and so many transport and
accommodation options available,
living off-campus is easy.
Flinders Living runs a free service
that lists the private rental
accommodation available off-campus
in the local area. They can also
provide advice on your rights and
responsibilities as a tenant.
For more information about the
type, cost and availability of
accommodation in Adelaide,
please visit:
flinders.edu.au/living/short-termprivate/private-accommodation
realestate.com.au
homehound.com.au
domain.com.au
homestaynetwork.org
adelaidehomestaysearch.com

Deirdre Jordan Village
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SERVICES
FOR YOU
GETTING SETTLED
We approach our services for
help you to settle in here at Flinders,
students in the same way that We
from arrival at the airport through to your
we approach our academic and first day on campus and beyond. There are
a range of on-campus services to help you
research activities – with a
quickly settle into your new life at Flinders.
commitment to excellence.
We realise that students who are new to
Australia may need some extra support
to acclimatise and start their studies
confidently. We have a range of support
services and resources to help you transition
to a new environment:

INTERNATIONAL STUDENT
SERVICES (ISS)
International Student Services (ISS), located
in Flinders’ International Centre, is the first
point of contact for international students.
It offers a range of programs supporting your
enrolment, study and social life, as well as a
referral service to facilities on campus and
within the local community. ISS organises
a general orientation program for new
international students, monthly morning teas,
and tours. Visit:
flinders.edu.au/international/services

ORIENTATION

The first few days of university are exciting
but can also be daunting, which is why
we have a number of orientation sessions
and programs to help you get used to the
University community. These include the
Flinders International Student Orientation
(covering enrolment and important
government regulations relating to your stay
in Australia) and APP (a series of lectures
based on academic strategies and skills).
Finally, your own faculty or school will also
have special induction events that will
introduce you to the teaching team and help
you to get to know your colleagues in class.
Our commitment to excellent student
services goes well beyond helping you to
settle in when you arrive. We also have a
range of student services available to assist
you throughout your studies. Visit:
flinders.edu.au/international/services

FLINDERS CONNECT

CHILDCARE

HEALTH AND COUNSELLING

Flinders Connect provides you with
centralised access to frontline University
services. With a physical location next to
the new Student Hub at Bedford Park, as
well as phone and online channels, Flinders
Connect is an initial point of contact and
first port of call for information and support
services queries. The Flinders Connect
team can assist you with enquiries relating to
enrolments, fees, ID cards, parking permits
and a range of other general enquiries.

The Flinders University Childcare Centre
offers childcare for children under school
age. Community-based and not-for-profit,
the centre has attained the highest level of
accreditation. The experienced and qualified
staff offer exceptional care and education
in a nurturing and stimulating environment.
Please note, places are limited and booking
is essential. More information is available at:
flinders.edu.au/childcare

The Flinders University health service is
a fully equipped and accredited medical
centre providing a wide range of medical
services. Male and female medical
practitioners are available by appointment.

Flinders Connect face-to-face and phone
services are available Monday to Friday, 9am
to 5pm. You will also have access to an easy
to use online self-service area where you can
search for answers on the FAQs database at
any time. Visit:
flinders.edu.au/flindersconnect

EMPLOYMENT AND CAREERS
Flinders has a dedicated Careers and
Employment Liaison Centre on-campus,
and offers a number of career resources to
support you. For more information, please
see page 11, or visit:
flinders.edu.au/careers

YOUR ARRIVAL SERVICES
Flinders University is a leading Australian
university in terms of arrival support for new
students from overseas. Even before you
leave your home country, ISS will assist you
to plan your arrival with useful information
about Flinders and living in Adelaide. They
will help you to settle in by connecting you
with a range of on-campus support services
and staff in your academic area, making your
transition to Flinders as smooth as possible.

FREE MEET AND GREET
SERVICE
The ISS offers a free meet-and-greet service
for new international students. You will be
met at Adelaide airport, the railway station
or the central bus station and taken directly
to your new accommodation. The service is
also free for accompanying family members.
To book, visit:
flinders.edu.au/international/services

DISABILITY SUPPORT
Flinders is committed to providing access
and equity for students with disabilities
and helping everyone fully participate in the
academic, cultural and social life at Flinders.
Our disability advisers provide
a free, confidential service and are the
first point of contact for students who
may need assistance because of their
disability. They are here to help you better
access university study, act as advocates
on behalf of individuals or groups, and
liaise with lecturers to negotiate reasonable
adjustments to teaching or assessment
methods. Visit:
flinders.edu.au/disability-services

The free and confidential counselling
service assists students who may be
experiencing difficulties studying due to
personal or social problems. Counsellors
are available to talk to you about issues
relating to study, relationships, family, or
specific learning disabilities. Whatever
your health and counselling needs, our
psychologists and social workers can help
you get back on track. Visit:
flinders.edu.au/healthcounsel

FAST FACTS
in Australia for
student support
International Student Barometer 2016 (Overall Support benchmark).

International students also have access to
discounted optometry services on-campus.
Visit: flindersvision.com.au

OASIS
Oasis is a multifaith, multicultural centre
where support is provided by chaplains of
all faiths to meet the spiritual and religious
needs of the Flinders community. Oasis
offers various forms of prayer and meditation,
seminars, and study and discussion groups,
as well as a drop-in centre for friendship over
tea and coffee. Visit:
flinders.edu.au/oasis

International Student Barometer 2016

FREE

WELCO

ME

MEET & GREET

SERVICE

from Adelaide airport, railway station or central bus station

“Flinders is full of opportunities,
the international student support
team and counsellors are
amazing.”
Dharshinie Vimalanathan,
Bachelor of Psychological Sciences,
Malaysia

The Student Hub provides a flexible variety of study spaces
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ACADEMIC
SUPPORT
$

FAST FACTS
student satisfaction
%
88 with learning
International Student Barometer 2016

1 MILLION BOOKS AND
JOURNALS ARE HOUSED IN THE
FLINDERS LIBRARY SYSTEM

AWARD-WINNING
STUDENTS
Flinders University provides a
range of support services to
help students to achieve their
full academic potential.
ACADEMIC SUPPORT IN CLASS
We pride ourselves on the quality of Flinders
University academic staff, their expertise and
knowledge. When you are learning in our
environment, you are often learning from a
world leader in their field.
But the quality of academic staff is not
just measured in terms of knowledge. Our
academics are approachable and willing to
work with you to help you meet and exceed
your own expectations.

STUDENT LEARNING CENTRE
(SLC)
The SLC provides learning support for
Flinders University students, ranging from
writing and maths support to assistance with
study and time-management skills. More
information is available at:
flinders.edu.au/slc

LIBRARY

“Flinders has given me the
opportunity to gain both
professional and practical
experience…It has ensured
that I have the best possible
chance to succeed.”

Across our four library sites, you will find
more than one million books and journals,
extensive electronic collections and a wide
range of services and facilities to support
your learning and research interests. The
main library serves the whole Flinders
community while specialist libraries act as
information hubs for those studying law,
legal studies, nursing and health, and our
medical programs. The libraries are more
than collections of books – each library has
study areas with dedicated internet and
email workstations, computers for student
work, and printing and photocopying
services. The library, with its thousands of
journal articles and electronic books, can be
accessed online at:
flinders.edu.au/library

WORLD-CLASS INFORMATION
AND COMMUNICATIONS
TECHNOLOGY
Flinders offers one of the fastest, most secure
campus wireless networks in the Southern
Hemisphere. You will have access to worldclass communications technology thanks
to our $14 million investment with leading
international supplier, Cisco.
The system allows students and staff to
connect to a high density, high speed
wireless network that will support interactive
student experiences, lectures by high
definition video, video conferencing, stronger
research capability, and enhanced social
media relationships.

COMPUTER FACILITIES
Our campus is wired for 21st-century
learning. You can work at your own pace
anywhere in the University by accessing our
many computer labs or by connecting to the
University’s extensive wireless network.

FLINDERS LEARNING ONLINE
(FLO)

Our students are recognised
as leaders who drive positive
change. The impact of their
work is being felt across
the globe.
Flinders University student, Dr Emmanuel
Ita Bassey, beat hundreds of entrants from
major South Australian universities to win
South Australian International Student
of the Year 2016.
The former clinician, who lost his sight
to cataract disease several years ago,
has established a visual rehabilitation
unit in a tertiary eye hospital in Nigeria to
save people travelling up to 2,000km for
treatment. As well as being Medical Officer
(Visual Rehabilitation) at the hospital, he is
Acting Secretary of the Nigerian Computer
Association of the Blind.
“Receiving this award is such an amazing
honour,” Dr Bassey says.
“When I lost my sight, I couldn’t practise
medicine any more and that’s why I’m in
Australia to do this disability study.

“Now I’ve applied to Flinders to commence
a PhD in disability studies in July 2017
to continue helping Nigerians with adultonset visual impairment and many other
disabilities.”

He also was joint winner with Flinders
Master of Teaching (Early Childhood)
student Zijia Wong (Singapore) for the
Excellence in Academic Postgraduate
Coursework Award.

Studying at Flinders as an Australia Awards
scholar, Dr Bassey has received a letter
of commendation from Flinders University
Chancellor and been recognised by the
Golden Key International Honours Society
for academic excellence.

Other Flinders University international
students acknowledged at the award
ceremony were:

Vice-President and Pro Vice-Chancellor
(International) Sebastian Raneskold says
there are hundreds of nominations every year
from across South Australia’s educational
institutions for the International Awards.
“Emmanuel’s outstanding academic
capabilities, and inspiring career goals and
personal attributes, made him a very worthy
recipient of the International Student of the
Year and Academic Excellence awards this
year,” Mr Raneskold says.

Undergraduate Academic Excellence –
winner Rachel Mesler (from Norway / US)
who is studying Bachelor of Information
Technology (Digital Media) Honours, and
highly commended Keren Wu (China)
Bachelor of Clinical Sciences,
Doctor of Medicine.
Community Engagement – high
commendations to Guiqing (Henry) Liu
(China) and Anupol Bordoloi (India), both
studying Master of Social Work at Flinders.
Artistic Achievement – highly commended
Li Jiaming (China), Master of Social Work.

“Even more importantly, he will use his
Flinders University study to further improve
the lives of many more Nigerian people living
with disabilities to reach their full potential.”

FLO enables you to access course materials
and resources, enrol or withdraw from topics,
check your email accounts, and keep up-to
date with University-wide announcements.
Visit: flo.flinders.edu.au

ENGLISH LANGUAGE SUPPORT
PROGRAM
The Student Learning Centre (SLC) offers
a free program to support Non-English
Speaking Background students who need to
improve their English in the academic context.
More information is available at:
flinders.edu.au/slc

Aqeel Asad
Bachelor of Business
Pakistan
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Deputy Vice-Chancellor (Students) Professor Clare Pollock with Dr Emmanuel Ita Bassey and Mrs Helen Bassey at the International Student
Awards at Government House

31

OUR GLOBAL
NETWORK

SHORT-TERM
STUDY
STUDENT EXCHANGE
Study Abroad and Student
If you’re studying at one of our partner
Exchange are short term
institutions, you may be eligible for the
student exchange program. Contact your
programs that enable you
home institution for application information.
to study for six to twelve
months (one or two semesters)
STUDY ABROAD
in Adelaide.
If you are not studying at a Flinders
University exchange partner or currently
enrolled at an overseas university, we offer
you the opportunity to study on a fee paying
basis. Flinders University offers multiple
options to suit your academic, career and
lifestyle goals.

OVER 100
PARTNER INSTITUTIONS

ACROSS

33
COUNTRIES

Flinders University’s links
span the globe. We have
partnerships in areas of
research, teaching and
offshore delivery, and
offer exchanges with over
100 institutions globally.

BRAZIL
University of Sao Paolo
CANADA
Simon Fraser University
CHILE
Universidad de Valparaiso
CHINA
Capital Normal University
Central South University
Chinese Academy of Social Sciences
Nankai University
GERMANY
Dresden University of Technology
HONG KONG
The Chinese University of Hong Kong
University of Hong Kong
INDIA
Amity University
Manipal University
INDONESIA
Universitas Airlangga
Universitas Gadjah Mada
Universitas Indonesia
JAPAN
Hiroshima University
National Institute for Materials Science
KOREA
Kyung Hee University
Chungnam National University

MALAYSIA
HELP University
Universiti Kebangsaan Malaysia
Universiti Malaya
MALAWI
University of Malawi
MEXICO
The Autonomous University of Queretaro
NETHERLANDS
Utrecht University
Maastricht University
SINGAPORE
Nanyang Technological University
Parkway College of Nursing & Allied Health
Social Service Institute (SSI)
SWEDEN
Malmö University
THAILAND
National Nanotechnology Centre
UK
St George Hospital Medical School
University College London
University of Stirling
USA
Johns Hopkins University
Temple University – Fox School of Business
University of Arizona
University of Texas at Austin

Study Abroad and Student
Exchange enable you to live
in a new city, enhance your
You are required to study a minimum of three
career prospects, undertake
topics per semester to maintain a full-time
professional development
study load. You are also able to study four or
five topics per semester.
opportunities, experience a
different culture and meet new TUITION FEES
people without interrupting
3 topics: $6,750 AUD
your studies or career path.
4 topics: $9,000 AUD
5 topics: $11,250 AUD
To find out more, visit:

Avery Cheatham
Butler University, USA

“Go for on-campus
housing! You’ll
meet a lot of people
and it will help
you adjust to the
Australian culture
easier! It was very easy living on
campus; I lived with a lot of other
[foreign] students which made it
easier to make friends and meet the
locals.”
Arjen van Lil, Utrecht University,
Netherlands

flinders.edu.au/studentexchange

Students chatting in The Tavern, Bedford Park campus
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“The different
perspectives I was
able to experience
were the most
rewarding to me.
I learned how to
really enjoy my time, learned so many
things from the people I met, and was
able to see that I had more options in
what I wanted to do with my life.”

Flinders’ Bedford Park campus has coastal
views and lots of green spaces to relax
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OUR COURSES
Flinders University offers over 110 world-class postgraduate courses
across 15 study areas. The following pages provide a summary
of these courses and their entry requirements. For more detailed
information on our courses, visit: flinders.edu.au/courses
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ACCOUNTING

ACCOUNTING AND FINANCE

Master of Accounting

Master of Accounting and Finance

Course length:
2 years full-time

>

2018 fee:
AUD$30,700*

>

Course length:
2 years full-time

>

2018 fee:
AUD$30,700

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

>

Opportunity for
industry experience

>

Opportunity for
industry experience

6.5 (S6 • W6 • R6 • L6)
>

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution. Students with a degree in accounting
that is recognised by Australian professional accounting bodies are
not eligible for admission into the Master of Accounting.

6.5 (S6 • W6 • R6 • L6)

Professional accreditation

Entry requirements: Applicants must normally hold an approved
bachelor degree or equivalent qualification in any discipline (other
than accounting degree accredited in Australia). Applicants with
an Australian accredited degree in accounting are not eligible for
admission into the Master of Accounting and Finance.
flinders.edu.au/international-students/applying-flinders/
entry--and-english-requirements/postgraduate-entryrequirements.cfm

Note: Taught at Flinders City Presence, Victoria Square, Adelaide CBD

Note: Taught at Flinders City Presence, Victoria Square, Adelaide CBD

The Master of Accounting is designed to provide undergraduates
of non-accounting degrees with a study program that fulfils the
requirements to commence a professional accounting career.
Flinders Business School provides excellent teaching, small classes
and opportunity to network and develop professional acquaintances
through interaction in these programs.

The Master of Accounting and Finance offers the right balance of practice and
theory to prepare students for a successful career as an accounting or business
professional and to cultivate research practices for independent, industry and
discipline related research in a business context.

Industry experience: Students may have the opportunity to
undertake an industry placement and/or industry project.
Professional accreditation: The Master of Accounting meets the
admission requirements of the Certified Practicing Accountants
of Australia (CPA), Chartered Accountants in Australia and New
Zealand (CAANZ) and the Institute of Public Accountants (IPA).

STUDY PROGRAM
Topics may include:
> Accounting Fundamentals
> Information Systems and Accounting Processes
> Quantitative Methods
> Economics for Business
> Management and Cost Accounting
> Principles of Commercial Law
> Financial Accounting Issues
> Financial Management
> Corporate Accounting
> Auditing and Assurances
> Business Research Methods and Project
> Academic Skills for Business - specifically aimed at Non-English
Speaking Background postgraduate students.

CAREER OUTCOMES
Graduates are suitable for careers such as auditor, budget
accountant, cost accountant, finance manager, investment analyst,
systems accountant, and taxation consultant. Organisations seeking
postgraduate accounting qualifications include financial management
and planning firms, investment advisory organisations and government
departments. Opportunities also exist for self-employment.

FURTHER COURSE INFORMATION >>>

The role of accounting and finance professionals in contemporary society
will be explored with reference to ethics, globalisation and sustainability
issues.
Industry experience: The opportunity to undertake Work Integrated
Learning in this program is dependent upon whether CPA accreditation
is also sought. (Note - Taking this topic may preclude entry into the CPA,
please speak to a student advisor prior to taking this topic)
Professional accreditation: The Master of Accounting and Finance meets
the admission requirements of the Certified Practicing Accountants of
Australia (CPA), Chartered Accountants in Australia and New Zealand
(CAANZ) and the Institute of Public Accountants (IPA).

STUDY PROGRAM
Students will have core and advanced Accounting and Finance topics to
choose from including Accounting Fundamentals, Financial Accounting
Issues, Derivatives and Risk Management and Investments and Portfolio
Management. For further details refer to: flinders.edu.au/courses/rules/
postgrad/mac.cfm
We offer an ‘Academic Skills for Business’ topic, specifically aimed at NonEnglish Speaking Background postgraduate students. (Note - Taking this
topic may preclude entry into the CPA, please speak to a student advisor
prior to taking this topic).

CAREER OUTCOMES
Potential roles include accountant, auditor, business analyst, client service
adviser, finance officer, investment consultant, superannuation manager and
tax accountant. Potential employers include financial management firms,
investment advisory organisations, financial planning firms and government
departments. Opportunities also exist for self-employment.

FURTHER STUDY
Students may chose to undertake further postgraduate study in research.

flinders.edu.au/courses/postgrad/macc

FURTHER COURSE INFORMATION >>>

CRICOS Code: 064258M

flinders.edu.au/courses/postgrad/accfinance
CRICOS Code: 089466G

>

PTE: 58* (see pg 85)
>

Professional accreditation

*Students may be eligible to qualify for a partial fee scholarship (15%
reduction to their course fees). For more information visit:
flinders.edu.au/sabs/business/study-with-us/partial-feescholarship-international-students.cfm
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Graduate Certificate in Archaeology; Graduate Diploma in Archaeology and
Heritage Management; Master of Archaeology and Heritage Management

>

PTE: 58* (see pg 85)

ARCHAEOLOGY AND HERITAGE
MANAGEMENT

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
2 years full-time
Masters Advanced:
1.5 years full-time
Intake:
Graduate Certificate and
Graduate Diploma:
Semester 1
Masters:
Semester 1 • Semester 2

>

>

2018 fee:
Graduate Certificate:
AUD$13,400
Graduate Diploma:
AUD$26,800
Masters:
AUD$26,800
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Graduate Certificate and Graduate Diploma:
Must normally hold an approved bachelor degree or equivalent
qualification from an approved tertiary institution. Masters (2 years):
An approved bachelor degree in any discipline; an honours degree
in any discipline; or a Graduate Certificate or Graduate Diploma
in Archaeology, Heritage Studies, or a related discipline. Masters
Advanced Entry (1.5 years): An approved Bachelor degree or
honours degree in Archaeology, Heritage Studies, or a related
discipline. In addition, admission is by quota, based on academic
merit and a Credit average or better is required.
This articulated program aims to meet the research and professional
needs of graduates with an interest in Indigenous pre-colonial
and historical archaeology, cultural heritage management, and
archaeological method and theory. It aims to increase your knowledge
of key debates and issues within the discipline, from a uniquely
Australian perspective, while helping you to develop your skills and
experience in archaeological research methods, including: field survey
and excavation; laboratory research; archival, historical, and oral
history research; community archaeology; and geomatics and digital
approaches in archaeology. The program draws on both theoretical
and practical material and provides you with the opportunity to
apply both the principles and the practical skills developed during
the course. In addition, the Master of Archaeology and Heritage
Management provides you with the opportunity to complete a
substantial independent research project (thesis) with guidance from
academic archaeologists. Upon graduating from the Masters degree
you will be competitive for graduate positions in archaeology, both in
the public and private sectors in Australia and abroad.

STUDY PROGRAM
You can choose from a range of archaeology topics, including topics
in heritage management, maritime archaeology, rock art, field methods,
historical archaeology, indigenous archaeology and forensic archaeology.
You may also choose topics from a number of related disciplines.

CAREER OUTCOME

AQUACULTURE
Graduate Certificate in Science (Aquaculture); Graduate Diploma in Science
(Aquaculture); Master of Science (Aquaculture)
>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

2018 fee:
Graduate Certificate:
AUD$16,500
Graduate Diploma:
AUD$33,000
Masters:
AUD$33,000

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Opportunity for
industry experience

Entry requirements: Applicants must normally hold a degree in
any relevant discipline of science or equivalent qualification from
an approved tertiary institution. The Faculty Board may, under
certain circumstances and subject to specific conditions, admit
others who can show evidence of fitness for candidature.
The courses develop an understanding of aquaculture principles
and practices in nutrition and water quality, reproduction and
genetics, hatchery management, ecology and physiology,
husbandry and production, health management and disease
control, product quality, aquaculture system and technology,
experimental design and statistics for biology, fisheries biology
and management and bio-business. The program involves
practicals in laboratories, aquaria and tanks, meeting with
aquaculture professionals and a flexible choice of elective topics
available from different disciplines. The Master of Science
(Aquaculture) course can be fast-tracked in 18 months.
Industry experience: Students will have the opportunity to
undertake work placements.

STUDY PROGRAM
Topics in first year may include:
> Aquaculture Nutrition and Water Quality
> Aquaculture Reproduction
> Experimental Design and Statistics for Biology

CAREER OUTCOMES
Graduates find work in roles such as aquaculture development
officer, aquaculture consultant, aquaculture research scientist,
aquaculture development officer aquarist, business manager, farm
manager, hatchery manager, laboratory manager or technician.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/scaq
CRICOS Code: Graduate Certificate in Science (Aquaculture)
082816C. Graduate Diploma in Science (Aquaculture) 082817B.
Master of Science (Aquaculture) 082818A

These courses make you highly qualified for a professional career in
archaeology throughout the globe in research, policy development,
consulting, hands-on surveying and excavation. Organisations
seeking postgraduate archaeology qualifications include independent
archaeological consultants, heritage agencies, museums, academic
institutions, the public service, wildlife services and sanctuaries.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/arch
CRICOS Code: Graduate Certificate – External only. Graduate
Diploma – 080523K. Masters – 080524J. Masters Advanced
Entry 1.5 years – 085900E.
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AUDIOLOGY

BIOTECHNOLOGY

BUSINESS

BUSINESS ADMINISTRATION

Master of Audiology

Graduate Certificate in Biotechnology; Graduate Diploma in Biotechnology;
Master of Biotechnology Studies

Master of Business

Graduate Certificate in Business Administration; Graduate Diploma in
Business Administration; Master of Business Administration

>

Course length:
2 years full-time

>

2018 fee:
AUD$41,200

>

Intake:
Semester 1

>

English requirement:
IELTS:

>

Opportunity for
industry experience

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)
>

Professional accreditation

Entry requirements: Approved bachelor degree with a minimum
of credit average. No specific undergraduate degree is required
for admission. Admission will be based on the combined scores
from a structured interview (may be by skype) and the applicant’s
best GPA using a minimum of 36 units of a qualification from an
approved tertiary institution.
Note: A limited number of places are available. All students who
undertake the Master of Audiology are required to undertake specified
health checks, immunisations and criminal history checks as per
University and Health Department guidelines.

The Master of Audiology is a professionally oriented course for
graduates interested in acquiring knowledge and skills in the
evaluation and management of auditory disorders (hearing loss
and tinnitus) and their consequences. It prepares graduates to
begin clinical practice as audiologists in a range of urban, rural
and remote settings, to be well-informed health professionals,
and to acquire critical skills in appraising scientific and
clinical information which will assist their further professional
development. The program offers innovative learning experiences
including problem-based learning tutorials, clinical skills classes
and clinical placements.
Industry experience: Students will have the opportunity to
undertake a clinical placement.
Professional accreditation: Graduates of the Master of
Audiology will meet the standards set out by Audiology Australia
for practice by entry-level audiologists.

STUDY PROGRAM
Topics towards the Master of Audiology may include:
> Audiology
> Clinical Audiology
> Professional Studies
> Research Methods
> Research Project

CAREER OUTCOMES

There is a great demand for qualified and trained professionals in
audiology, both within Australia and worldwide, and the Flinders
course enjoys particularly high employment outcomes. Graduates
are suitable for careers in the public and private sectors in
diagnostic and rehabilitation practices, hospitals, education
settings, special schools, early intervention centres, universities,
research facilities and hearing aid companies. Opportunities exist
in city-based, rural and remote settings across the globe.
This course has a specific application deadline. Please contact
the International Centre at internationalapply@flinders.edu.au
for further information.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/maud
CRICOS Code: 027824D
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>

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters: 2 years full-time
Intake:
Semester 1 • Semester 2

>

>

2018 fee:
Graduate Certificate:
AUD$16,400
Graduate Diploma:
AUD$32,800
Masters:
AUD$32,800
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelors degree or equivalent in biological,
agricultural or medical science with a GPA of 5.0 or higher.

Biotechnology is the use of living organisms and their biological
components to create products or perform tasks. Flinders
University was one of the pioneers of biotechnology teaching in
Australia. The Biotechnology Program has combined the best
expertise in both the School of Biological Sciences and the
School of Medicine.

>

Course length:
2 years full-time

>

2018 fee: 			
AUD$30,700

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

>

Opportunity for
industry experience

*Students may be eligible to qualify for a partial fee scholarship
(15% reduction to their course fees). For more information visit:
flinders.edu.au/sabs/business/study-with-us/partial-feescholarship-international-students.cfm
Entry requirements: A bachelor degree is required. Applicants
do not require work experience. For Master of Business
prerequisites, please refer to: flinders.edu.au/courses/
postgrad/mbus.
Note: Business topics are taught at Flinders City Presence, Victoria
Square, Adelaide, CBD. Some topics are taught in intensive delivery
mode. Some specialisation and elective topics may be taught at Bedford
Park campus. Some topics are available online.

Our programs in Business are designed to provide a strong
foundation in appropriate business knowledge, understanding,
skills and attitudes for successful careers as managers of
organisations including private sector business, not-for-profit,
government and public sector entities. Flinders Business School’s
teaching philosophy and small class sizes ensure that you can
really engage with your teacher, while getting to know your fellow
students.

STUDY PROGRAM

> Human Resource Management
> International Business
> Finance
> Marketing

CAREER OUTCOMES
Potential roles include bioanalytical chemist, biodiscovery
research scientist, business development manager, medical
scientist, biotechnologist and clinical researcher. Graduates
of these programs are job ready and highly skilled for medical,
pharmaceutical, agricultural, industrial and environmental
applications.

FURTHER STUDY
The courses articulate and the sequentially developed topics
allow progression through the three awards. The Masters program
can provide a pathway to a PhD for those who want to pursue a
research career.

Industry experience: Students may have the opportunity to
undertake an industry placement and/or project.

STUDY PROGRAM
MBus specialisations include:

We offer an ‘Academic Skills for Business’ topic, specifically
aimed at Non-English Speaking Background postgraduate
students.

CAREER OUTCOMES
These programs provide a strong foundation in appropriate
business knowledge for a successful career in areas including
business, international marketing, banking and finance,
management consulting, and negotiation and planning. Potential
roles include senior product marketing manager, equity analyst,
operational risk manager, finance manager, process improvement
consultant and senior business development manager.

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/mbus
CRICOS Code: 085302E

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters (MBA):
1.5 years full-time

>

2018 fee:
Graduate Certificate:
AUD$15,900
Graduate Diploma:
AUD$31,800
Masters: 			
AUD$31,800

>

Intake:
Semester 1 • Semester 2

>

English requirement:
IELTS:

>

Opportunity for
industry experience

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

In addition to teaching, staff run world class research programs
in a wide range of areas of biotechnology including cancer and
immunology research, bio-processing, plant disease resistance
and bio-control, therapeutic drug discovery, functional foods,
bio-energy, water quality and marine biotechnology. The
biotechnology courses at Flinders are designed to provide
students with advanced theoretical scientific knowledge and
training, and an understanding of business issues required
for modern biotechnology. Theoretical scientific knowledge
is complemented by relevant practical laboratory training and
backed up by business training in financial, marketing and
management skills. The law, ethics, society and the environment
have great relevance in biotechnology and all are examined.

Topics studied may include:
> DNA to Genome
> Protein to Proteome
> Molecular Biotechnology
> Legal, Ethical and Social Aspects of Bioscience
> Professional Skills for Biotechnology
> Industrial and Pharmaceutical Biotechnology
> Environmental Biotechnology
> Plant and Food Biotechnology

>

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

*Students may be eligible to qualify for a partial fee scholarship
(15% reduction to their course fees). For more information visit:
flinders.edu.au/sabs/business/study-with-us/partial-feescholarship-international-students.cfm
Entry requirements: Entry into the Graduate Certificate requires
a Bachelor degree plus 3 years post-graduate work experience, or
7 years work experience. Graduate Diploma requires a Bachelor
degree plus 3 years work experience, or equivalent. A Bachelor
degree plus 3 years work experience post graduation, or
completion of a Graduate Certificate in Business Administration
and relevant work experience is required for entry into the MBA.
Applicants without work experience can apply for the Master of
Business. Note that entry into the Health specialisations in the
MBA requires additional qualifications and/or work experience.
For all prerequisites and entry requirements please refer to:
flinders.edu.au/courses/postgrad/ba.
Note: Business topics are taught at Flinders City Presence, Victoria
Square, Adelaide, CBD. Some topics are taught in intensive delivery
mode. Some specialisation and elective topics may be taught at Bedford
Park campus. Some topics are available online.

Our programs in Business Administration are designed to
provide a strong foundation in appropriate business knowledge,
understanding, skills and attitudes for successful careers as
managers of organisations including private sector business, notfor-profit, government and public sector entities. Flinders Business
School’s teaching philosophy and small class sizes ensure that
you can really engage with your teacher, while getting to know
your fellow students.
Industry experience: Students may have the opportunity to
undertake an industry placement or project.

STUDY PROGRAM
MBA specialisations include:
Health or Finance

TAKE THE LEAD IN HEALTH
The combined degree of Master of Business Administration/
Master of Health Administration prepares students to investigate
advanced issues in health management with a strong foundation
of business knowledge. This course prepares students for
a successful career as a manager in the private, not-forprofit, government and public sectors. The course prepares
graduates for entry to the Australasian College of Health Service
Management and assists medical practitioners to enter the Royal
Australasian College of Medical Administrators.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/bt
CRICOS Code: Graduate Certificate – 038768E. Graduate
Diploma – 057077G. Masters – 043767G

39

> BUSINESS ADMINISTRATION
(CONTINUED)

CHEMISTRY

CHRONIC CONDITION MANAGEMENT

CLINICAL EDUCATION

Master of Science (Chemistry)

Graduate Certificate in Chronic Condition Management; Graduate Diploma
in Chronic Condition Management; Master of Public Health (Chronic
Condition Management)

Graduate Certificate in Clinical Education; Graduate Diploma in Clinical
Education; Master of Clinical Education

>

>

Course length:
2 years full-time*

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
AUD$33,000
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

* Students with a Bachelors degree in the same discipline may be
eligible for a 1.5 year full-time program.

“Studying at Flinders University taught me
a lot. As someone who was educated in
China, we used to be taught what to think,
not how to think, and studying at Flinders
University liberated my mind quite a bit.
I learned how to think. The staff were
fantastic and the campus was great.”
Mr Junling Liu is the ex-CEO and Co-Founder of
YiHaoDian, China’s largest online retailer, graduate
of Flinders Business School MBA and the 2012
Austrade Australia China Alumni Award recipient
for Entrepreneurship.
Junling Liu
Master of Business Administration
graduate

CAREER OUTCOMES
These programs provide a strong foundation in appropriate
business knowledge for a successful career in areas including
business, international marketing, banking and finance,
management consulting, and negotiation and planning. Potential
roles include senior product marketing manager, equity analyst,
operational risk manager, finance manager, process improvement
consultant and senior business development manager.

FURTHER COURSE INFORMATION >>>

Entry requirements: Applicants must normally hold an approved
Bachelor’s degree or equivalent with a major in Chemistry or a
closely related discipline from an approved institution. The Master
of Science is not available to students who hold an Honours
degree in the same discipline. A knowledge of at least second
year chemistry is assumed. The Faculty Board may, under certain
circumstances and subject to specific conditions, admit others
who can show evidence of fitness for candidature.
The Master of Science (Chemistry) is designed for students with
a chemistry rich background. The course builds on a student’s
existing chemistry knowledge with research and professional
skills to investigate, analyse and synthesise complex information,
problems, concepts and theories in the systematic development of
solutions to complex problems.
The Masters award provides graduates with not only the practical
and theoretical aspects of chemistry, but also an understanding
of professional and ethical responsibilities and an awareness of
social, economic, cultural and environmental aspects of chemistry
in a global community. Projects and coursework have been
designed to address topical concerns in industry and society,
preparing graduates for further enrolment in a research degree or
employment in chemistry-related fields.

STUDY PROGRAM
This course contains both coursework and research components
with a research project. This award is flexible and gives students
the opportunity to select coursework topics from a range of
disciplines and elective topics in areas including nanotechnology,
clean technology, polymer science, and ethics, and as well as in
various branches of chemistry.
Students will undertake advanced theoretical topics as well as
gaining exposure to advanced research skills before undertaking a
research project.

CAREER OUTCOMES
Chemistry graduates may start careers as Analysts, Research
Chemists, and may be employed in the wine, pharmaceutical,
paint, mining, petroleum and automotive industries.

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/ba

flinders.edu.au/courses/postgrad/scchem

CRICOS Code: Graduate Certificate – 028943M.
Graduate Diploma – 028947G. Master of Business
Administration – 071846K.

CRICOS code: 002646A

>

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Certificate:
AUD$15,250
Graduate Diploma:
AUD$30,500
Masters:
AUD$30,500
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent in a relevant
field from an approved tertiary institution. Applicants may be
admitted directly into the Masters program if they can show
evidence of two years’ relevant professional experience.
Note: As per Australian Government regulations, courses that have
a placement involving contact with children, young people and/or
vulnerable adults, will require students to undergo an Offender History
Record Check prior to placement.

The postgraduate programs in Chronic Condition Management
aim to meet the extended professional development needs of
graduates involved in the provision of policy, planning or delivery
of services to people with chronic physical or mental health
conditions. These courses seek to offer you an understanding
of the core principles and skills involved in developing and
implementing self-management enhancing programs in diverse
settings for health professionals and service users.

STUDY PROGRAM
Some of the topics that may be undertaken as part of these
programs include:
> Chronic Conditions Management for Specific Conditions,
Contexts or Populations
> Client-Centred Health Behaviour Change
> Managing Chronic Conditions: Self-Management Support
Approaches
> Implementing Change in Healthcare Systems Supporting
Chronic Condition Management
> The Person’s Experience of Self-Management

CAREER OUTCOMES
With growing demand for health services to address chronic
condition management in more systematic ways, graduates
of this program are highly valued by employers because of
their specialised knowledge and focus in the area. Graduates
are suitable for careers in a wide range of chronic condition
management areas. Many become dedicated chronic disease
coordinators or move into more focussed project and service
roles in this growing area. For students who are already in health
professional roles, this program offers greater opportunity for
promotion and the knowledge in which to lead system change
initiatives.

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

2018 fee:
Graduate Certificate:
AUD$15,250
Graduate Diploma:
AUD$30,500
Masters:
AUD$30,500

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: A Bachelor degree or equivalent
qualification in a health related area. Admission to the Masters
requires a Bachelor degree or equivalent qualification in a health
related area and at least 2 years of work experience in a relevant
clinical area.
The articulated program in Clinical Education is an emergent
speciality field of education characterised by a symbiotic
relationship between the learner, an experienced clinical
educator and the health service. These courses are suitable
for educators in both clinical and academic settings and will
provide health professionals with advanced knowledge to deliver
clinical education in health service settings. In addition, students
undertaking the Masters program will be able to contribute to
this specialist body of knowledge by undertaking a piece of
educational research.

STUDY PROGRAM
Topics undertaken may include:
> Symbiotic Clinical Education for the Health Professions
> Assessment of Learning for the Health Professions
> Reflective Learning and Teaching
> Leadership and Change for the Health Profession
> Research Skills in Clinical Education
> Research Project in Clinical Education (Masters)

CAREER OUTCOMES
Graduates are able to contribute to the education profession in
today’s dynamic and demanding health service settings through
new and innovative approaches to clinical education. Graduates
are suitable for careers in clinical teaching in the government and
private health sectors.

FURTHER STUDY
The courses articulate with sequentially developed topics that
allow progression through the awards.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ce
CRICOS Code: External only

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ccm
flinders.edu.au/courses/postgrad/mph
CRICOS Code: Graduate Certificate – External only.
Graduate Diploma – External only. Masters – 020926K
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CLINICAL REHABILITATION

COGNITIVE BEHAVIOUR THERAPY

COMPUTER SCIENCE

Graduate Certificate in Clinical Rehabilitation; Graduate Diploma in
Clinical Rehabilitation; Master of Clinical Rehabilitation

Graduate Certificate in Cognitive Behaviour Therapy; Graduate Diploma in
Cognitive Behaviour Therapy; Master of Cognitive Behaviour Therapy

Master of Science (Computer Science)

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

Intake:
Semester 1 • Semester 2

>

Opportunity for
industry experience

>

>

2018 fee:
Graduate Certificate:
AUD$15,250
Graduate Diploma:
AUD$30,500
Masters: AUD$30,500
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Graduate Certificate requires a bachelor
degree or equivalent in a health-related field. Graduate Diploma/
Masters requires a bachelor degree or equivalent in a healthrelated field and at least two years relevant work experience in a
relevant clinical area.
Note: As per Australian Government regulations, courses that have
a placement involving contact with children, young people and/or
vulnerable adults, will require students to undergo an Offender History
Record Check prior to placement.

These articulated courses aim to provide individuals from any
health professional background the opportunity to enhance
their knowledge and skills in the area of clinical rehabilitation. In
addition to gaining an understanding of the principles and practice
of clinical rehabilitation, students also have the opportunity of
studying in an area relevant to their field of clinical practice.
Students also receive training in research methods and can
develop either research expertise or advanced practice skills in the
area of clinical rehabilitation and apply this to a specific project.
The Research stream of the Master of Clinical Rehabilitation
allows students to understand the principles and practice of
clinical rehabilitation, receive training in research methods, and
undertake a significant research project in the form of a thesis.
Industry experience: Students can participate in a clinical
placement.

STUDY PROGRAM
Topics undertaken may include:
> Early Rehabilitation Following a Stroke
> Principles of Clinical Rehabilitation
> Rehabilitation of Degenerative Neurological Disorders

CAREER OUTCOMES
Graduates can work in both public and private health care
organisations. Potential roles include clinical nurse educator,
rehabilitation advisor, rehabilitation consultant, rehabilitation
counsellor and allied health coordinator (rehabilitation). Potential
organisations include hospitals, rehabilitation centres, community
health centres, schools and mental health services. They may also
work in teaching, managerial or research positions.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/cr
CRICOS Code: Graduate Certificate – 055067D.
Graduate Diploma – 060408A. Masters – 060409M

>

>

Course length:
Graduate Certificate:
6 months full-time 		
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Certificate: 		
AUD$15,250
Graduate Diploma: 		
AUD$30,500
Masters:
AUD$30,500
English requirements:
IELTS: 7 (S7 • W7 • R7 • L7)
PTE: 65^ (see pg 85)

Entry requirements: Applicants must normally hold an approved
undergraduate degree or equivalent in a health-related area – eg
behavioural science, counselling, medicine, nursing, occupational
therapy, psychology or social work.
It is preferable that prospective students have experience
working in a related context that complements the inherent
course requirements of the CBT postgraduate programs.
Experience working with people in a health related environment
is advantageous and will support successful progression in this
applied postgraduate course.
Note: As per Australian Government regulations, courses that have
a placement involving contact with children, young people and/or
vulnerable adults, will require students to undergo an Offender History
Record Check prior to placement.

Flinders University’s cognitive behaviour therapy (CBT) programs
provide you with clinical competencies and research skills
in CBT for high prevalence psychological disorders. You will
gain clinical training opportunities through industry practicums
modelled around a clinical supervision framework. You will have
the opportunity to develop knowledge in areas such as comorbid
mental health disorders, high prevalence psychological disorders,
and gambling disorders; and develop skills in areas such as
behavioural activation and motivational interviewing.
The courses are suited to new allied health graduates and health
professionals who are committed to ongoing professional development
and personal growth using accountable and ethical practice principles.

STUDY PROGRAM
Topics studied may include:
> Low Intensity Cognitive Behaviour Therapy for Psychological Disorders
> Fundamentals of Clinical Practice
> Theory and Models of Cognitive Behaviour Therapy
> Cognitive Behaviour Therapy for Psychological Disorders

CAREER OUTCOMES
Graduates of this program are competent and equipped to
contribute and ultimately improve mental health service delivery
because of their specialised knowledge and clinical competencies
in the area of cognitive behaviour therapy (CBT), high prevalence
psychological disorders and stepped-care models of mental health
care. Graduates can work in both private and public health care
organisations and are trained to work in a range of primary mental
health care roles. Graduates who are already in health professional
roles are well-placed to seek promotional opportunities in service
delivery, clinical supervision and leadership.

> COMPUTER SCIENCE (CONTINUED)
STUDY PROGRAM

>

Course length:
2 years full-time*

>

2018 fee:
AUD$29,900

Topics you may study include:

>

Intake:
Semester 1 • Semester 2

>

>

Professional accreditation

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

> Standards, Ethics and Compliance
> Project Management and Innovation
> Intelligent Systems

CAREER OUTCOMES
* Students with a Bachelors degree in the same discipline may be
eligible for a 1.5 year full-time program.
Entry requirements: Applicants must normally hold an approved
Bachelor’s degree or equivalent in Computer Science, Information
Technology, ICT-based engineering or a closely related discipline
from an approved institution. Applicants with an approved degree
in behavioural science or psychology, which includes a major in
Artificial Intelligence or Computer Science, are also eligible to apply.
A knowledge of second year information technology is assumed.
The Faculty Board may under certain circumstances, and subject to
specific conditions, admit others who can show evidence of fitness
for candidature. The Master of Science is not available to students
who hold an Honours degree in the same discipline.

The information technology and science departments of
major organisations in telecommunications, aerospace and
defence, government, higher education institutions and private
organisations are all in the market for computer science graduates.
Graduates gain positions as computer programmers, software
developers, business analysts, and in database development and
administration, hardware support, project management, sales and
marketing, telecommunications, web development and security.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/msccs
CRICOS Code: 073345D

The Master of Science (Computer Science) is designed for students
with a computer science, software/computer systems engineering,
information technology, information systems or an equivalent
computing rich background. The course builds on a student’s existing
computer science, research and professional skills. Flexibility is built
into the course and students have the opportunity to choose from a
variety of elective topics.
The Masters provides graduates with not only the practical and
theoretical aspects of computer science, but also an understanding
of professional and ethical responsibilities and an awareness of
social, economic, cultural and environmental aspects of computer
science in a global community. Projects and coursework have
been designed to address topical concerns in industry and society
preparing graduates for further enrolment in a research higher degree
or employment in a computing related field.
The course is offered at Flinders’ new Tonsley Campus, a stateof-the-art, 18,000 square metre facility that is the heart of South
Australia’s new industrial future. Flinders will be part of this exciting
new collaborative and high-value industry, education and residential
precinct at Tonsley – and serves as a remarkable site for experiential
learning, social innovation and inspiration. Flinders at Tonsley is a
place where students interact with business, and where business
interacts with researchers in the areas of engineering, medical
devices and nanoscale technologies to make the new products and
processes of the 21st century.
Professional accreditation: This program is accredited by the
Australian Computer Society at the Professional level. Courses
accredited at this level by the Australian Computer Society are
recognised internationally under the Seoul Accord.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/cbt
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CRICOS Code: Graduate Certificate – 088939K, Graduate
Diploma – 088940F, Master – 088941E
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DIGITAL PRODUCTION FOR
ENTERTAINMENT DESIGN
Graduate Certificate in Digital Production for Entertainment Design,
Master of Digital Production for Entertainment Design

DISASTER HEALTH CARE

DEVELOPMENT ADMINISTRATION

DISABILITY STUDIES

Graduate Certificate in Disaster Health Care, Graduate Diploma in Disaster
Health Care, Master of Disaster Health Care

Graduate Certificate in Development Administration

Graduate Certificate in Disability Studies; Master of Disability Policy
and Practice

>
>

>

>

Course length:
Graduate Certificate:
6 months full-time
Masters: 2 years full-time
Intake:
Semester 1
Opportunity for
industry experience

>

>

2018 fee:
Graduate Certificate:
AUD$13,400
Masters:
AUD$26,800
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution. In addition, an application form and
portfolio are required, including examples of creative work, for
one or more of the positions in the creative team.
Offered in collaboration with CDW Studios, this high-level
training program is designed specifically for the rapidly changing
commercial world of visual effects and all areas of entertainment
design. This innovative new course operates in a production
style environment and is based around students working in
small creative teams throughout the course to develop their own
intellectual property from idea development through to design and
implementation of complex story and animation projects. You will
develop knowledge and skills in the latest industry techniques and
technologies, and will have the opportunity to develop networks
and contacts with leading industry professionals.
Industry experience: The course is taught by currently practicing
industry professionals who have worked at major companies
such as Wizards of the Coast, Blizzard Entertainment, Universal
Pictures, Disney and LEGO.

STUDY PROGRAM
In the first semester of year one you are provided with training on
how to work within a creative team and a production ‘pipeline’.
This involves each team developing a creative solution to a brief
and producing a short animated story as the end product. In the
second semester of year one, students will continue to work within
their team and undertake classes to further develop and refine
their technical skills and creative thinking. The teams will work
on a semester-long project which will result in the development
of a short film. In year two, you will work on developing your own
creative intellectual property. The final result will be in the form of an
animated short film that can be used as a proof of concept for a TV
show, film or game project when the masters program is completed.

CAREER OUTCOMES
Graduates of this course will be able to obtain employment in a
range of organisations including: commercial film studios, film and
TV production companies, film companies, game development
companies, and production houses. Potential occupations include:
3D animator, 3D modeller, character designer, compositor, matte
painter, video game designer, concept artist, texture artist, lighter,
rigger, digital design and advertising, film and visual effects, art
director, graphic designer, illustrator, story artist, and comic book
artist.
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>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters: 1.5 years full-time
Intake:
Graduate Certificate:
Semester 1
Graduate Diploma and
Masters:
Semester 1 • Semester 2

>

>

2018 fee:
Graduate Certificate:
AUD$15,250
Graduate Diploma:
AUD$30,500
Masters:
$30,500

>

Course length:
6 months full-time

>

2018 fee:
AUD$14,050

>

Intake:
Semester 1

>

>

Opportunity for
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

English requirements:
IELTS:
6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

Entry requirements: Applicants must normally hold an
approved bachelor degree or equivalent qualification in a health
profession, and have at least two years’ professional experience
in the health care sector following completion of the degree or
equivalent qualification.
However, the Faculty Board may, under certain circumstances
and subject to specific conditions, admit others who can show
evidence of fitness for candidature. Credit may be granted for
comparable prior studies.
The Disaster Health Care program is designed to provide
students who are working in health care, whatever their
professional background, with the opportunity to advance their
theoretical and practical knowledge and skills in disaster health
management and response and to apply these in a range of
disaster situations.
The course builds on students’ current workplace and/or disaster
response training and experience and allows them to proceed, if
they wish, to further graduate-level coursework.
The program was developed in collaboration with the National
Critical Care and Trauma Response Centre (NCCTRC) and is
offered in external study mode through Flinders University.

STUDY PROGRAM
Topics studied as part of this program include:
> Introduction to Disaster Health
> Health Management of Major Incidents
> Clinical Decision Making in Disaster Health Care
> International Disaster Practice

CAREER OUTCOMES
Graduates of the Master of Disaster Health Care will have
the theoretical and operational knowledge to enhance their
employability with government and non-government disaster relief
agencies. Some graduates will be prepared for involvement in
international response to disaster, including resilience building and
mitigation in the recovery phase. In addition the course will offer
clinicians the opportunity to increase their knowledge of disaster
preparedness and awareness in the domestic context, to better
prepare them to respond to a disaster. This is a unique program to
the region and graduates will be well placed to gain or advance in
employment as a result of completing the course.

FURTHER COURSE INFORMATION >>>

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/dped

flinders.edu.au/courses/postgrad/dhc

CRICOS Code: Graduate Certificate – 085898E,
Masters – 085901D

CRICOS Code: Graduate Certificate – External only. Graduate
Diploma – External only. Master – External only.

>

>

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.
The Graduate Certificate in Development Administration is
designed to provide participants with a comprehensive knowledge
of developmental issues and to enhance their capabilities
and skills necessary to plan, implement, manage and evaluate
development programs. In this context, it is a basic development
qualification with direct relevance to public sector, international
development agencies and non-government operation. As the
first step in the Graduate Program in Public Administration,
the Graduate Certificate provides a basic entry point to more
advanced studies up to masters level, as well as self-contained
mid-career development options.
Industry experience: Students have the opportunity to
undertake an internship.

STUDY PROGRAM
You will study the following topic, plus electives:
> Development Administration
Elective topics cover aspects of Development Administration,
including issues relating to policy, sustainability, international
development, governance, and management.

CAREER OUTCOMES
The program provides a conceptual and practical framework
for individuals wishing to proceed with careers in government,
international development agencies and various non-governmental
organisations. Potential roles include sustainable development
officer, regional development manager, strategic analyst, project
officer, international policy advisor and public relations officer.

FURTHER STUDY
The Graduate Certificate in Development Administration
articulates with the Graduate Diploma in Public Administration and
the Master of Public Administration.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/gcda
CRICOS Code: 069209B

Course length:
Graduate Certificate:
6 months full-time
Masters:
2 years full-time
Masters Advanced:
1.5 years full-time
Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Certificate:
AUD$15,250
Masters: AUD$30,500

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Graduate Certificate: Bachelor degree,
diploma or equivalent qualification in a relevant area from an
approved tertiary institution. Masters - Full Program Entry Level:
An approved Bachelor degree of 3 or more years duration in an
area related to disability. Advanced Program Entry Level: An
approved Bachelor degree in Disability from an approved tertiary
institution, or an approved Bachelor degree of four or more years
duration in an area closely related to Disability and two years of
relevant professional experience, an Honours degree In Disability
or a closely related discipline from an approved tertiary institution
or a Graduate Certificate in Disability or a closely related
discipline.
Disability professionals play an important role in assisting
people with disabilities to participate in the economic and social
mainstream of society and be seen as valued members of their
local communities. The interests of disability professionals are
broad, incorporating community rehabilitation, health, education,
technology, advocacy, recreation, community living, employment
and the arts. Moreover, disability professionals are able to apply
their skills and knowledge to the diverse needs of people with
developmental or acquired disabilities.

STUDY PROGRAM
Topics available include:
> Communication Difficulties
> Autism Spectrum Disorder
> Intellectual Disability
> Transition from School to Adult Life
> Design and Evaluation of Disability Programs
> Leisure, Disability and The Arts
> Perspectives on Ageing and Disability
> Disability: Individual, Family and Society

CAREER OUTCOMES
This is a professionally orientated program designed to meet the
needs of practitioners working in education, health, and community
services and of teachers seeking specialised education in this
field. Graduates are suitable for careers in a wide variety of fields
supporting people with disabilities. Disability Studies graduates
can work as disability liaison officers, service coordinators, welfare
officers, social and community workers, counsellors, administrators,
managers and employment placement consultants. Potential
employers include disability support services, schools, government
and community agencies worldwide.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ds
CRICOS Code: Graduate Certificate – 027987G. Masters –
085325J. Masters Advanced – 085326G.
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EDUCATION

> EDUCATION (CONTINUED)

> EDUCATION (CONTINUED)

The Master of Education and specialisations seek to provide
an introduction to the traditions of thought and analysis used to
discuss and illuminate matters of educational policy and practice.
It gives advanced insights into theoretical and practical matters
in education in such a way as to improve professional decision
making. You will gain an opportunity to specialise in educational
topics of particular value or interest to you, and will be given an
introduction to the variety of educational research methods and be
able to compare their effectiveness.

STUDY PROGRAM

Graduate Certificate in Education; Master of Education

>

>

Course length:
Graduate Certificate:
6 months full-time
Masters:
1.5 years full-time
Masters:
2 years full-time
Intake:
Graduate Certificate
(Cognitive Psychology
and Education 		
Practice) and
Graduate Certificate
(Special Education):
Semester 1
All other:
Semester 1 • Semester 2

>

>

2018 fee:
Graduate Certificate:
AUD$13,100
Masters: AUD$26,200
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent in an
approved field of study. Some specialisations have additional
requirements, such as a degree in a relevant field and/or relevant
employment experience.
Study Mode:
Internal/External
Graduate Certificate:
Graduate Certificate in Education
Graduate Certificate in Education (Languages Education)
Graduate Certificate (Leadership & Management)
Graduate Certificate (Special Education)
Masters:
Master of Education
Masters (Cognitive Psychology and Educational Practice)
Masters (Gifted Education)
Masters (Languages Education)
Masters (Leadership and Management)
Masters (Special Education)
Master (Wellbeing and Positive Mental Health)
Internal only
Masters (International Baccalaureate)
Masters (Educational Research, Evaluation and Assessment)
External only
Graduate Certificate (Cognitive Psychology & Educational
Practice)
Graduate Certificate (Higher Education)
Masters (Higher Education)
Graduate Certificate (International Baccalaureate Middle Years)
Graduate Certificate (Language Education)
Graduate Certificate (Vision Impairment)
Graduate Certificate (Gifted Education)
Graduate Certificate (Wellbeing and Positive Mental Health)
The Graduate Certificate in Education is intended for people
currently employed in education, special education or education
management, and for those who have an interest in developing
their knowledge and practice in these areas. It provides you with
an introduction to knowledge and skills in your area of interest,
with a focus on understanding and changing practice.
The highly-regarded Master of Education and specialisations are
aggregated into a flexible single program, greatly enhancing the
potential for students to create individual programs to suit their
interests and thus shape their own educational pathways. These
specialisations reflect new areas of strength within the School of
Education and a commitment to be responsive to the professional
needs of the education community. The structure also offers a
high level of quality research training.
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Vision Impairment is designed for practising teachers, school
leaders and advisory personnel who work with students with
vision impairment, those who have a general interest in developing
their knowledge in this area and those who aspire to enter this
specialisation.
The Cognitive Psychology and Educational Practice
specialisation will help you develop an understanding of the
cognitive psychology of learning and investigate how this can be
applied to problems that arise in learning and teaching.
Postgraduate programs in Gifted Education are dynamic and
are regularly revised and updated in the light of current research,
new publications and contemporary practices. The courses
are designed to prepare educators for professional work and
leadership in Gifted Education.
International Baccalaureate programs will enhance your
teaching in International Baccalaureate schools. Flinders was
the first tertiary institution in the world to be accredited to offer
a postgraduate award for school educators teaching in the
International Baccalaureate Middle Years Program (IBMYP).
The Languages Education specialisation is the only course of
its kind currently offered in South Australia. As it is non-language
specific, it will enable you to gain broad perspectives in the field of
languages education, as well as allow you in-depth exploration of
its theory and practice.
The Leadership and Management program is especially suitable
for current and future human resource managers, knowledge
managers, school principals and departmental officers, policy
developers, vocational education sector managers, and leaders of
university academic and administration units.
Special Education is the joint responsibility of special and
regular teachers working closely together with parents, and in
multidisciplinary teams with other professionals such as school
psychologists and speech/language pathologists. Education
appropriate to each child’s level of development and in the least
restrictive environment is a fundamental principle underlying
special education.
Educational Research, Evaluation and Assessment combines
the study of research design and methods, evaluation and
assessment with a research focus on major contemporary
education policy issues. The program is designed for people
pursuing research and academic careers in education, social
science and human services.
Wellbeing and Positive Mental Health is a new and growing
area of the curriculum for teachers and educators, as evidenced
by the current and emerging education policy and curriculum
frameworks at international, federal, state and community levels.

Students undertaking the Graduate Certificate in Education may
choose to focus on a number of specialisations, including:
> Cognitive Psychology and Educational Practice
> Gifted Education
> Higher Education
> International Baccalaureate Middle Years Program (IBMYP)
> Languages Education
> Leadership and Management
> Special Education
> Vision Impairment
> Wellbeing and Positive Mental Health
Masters students complete an in-depth coursework program
either in Education or chosen from the following streams:
> Cognitive Psychology and Educational Practice
> Educational Research, Evaluation and Assessment
> Gifted Education
> Higher Education
> Languages Education
> International Baccalaureate
> Leadership and Management
> Special Education
> Wellbeing and Positive Mental Health

Masters: 1.5 Years
Masters - 085902C
Master of Education (International Baccalaureate) - 091854M
Master of Education (Cognitive Psychology and Educational
Practice) - 091851C
Master of Education (Educational Research, Evaluation and
Assessment) - 091852B
Master of Education (Gifted Education) - 091853A
Master of Education (Higher Education) - External
Master of Education (International Baccalaureate) - 091854M
Master of Education (Languages Education) - 091860B
Master of Education (Leadership and Management) - 091855K
Master of Education (Special Education) - 091856J
Master of Education (Wellbeing and Positive Mental Health) 091858G
Masters: 2 Years
Masters – 002648K
Masters (Cognitive Psychology & Education Practice) – 059360M
Masters (Gifted Education) – 053055B
Masters (Higher Education ) - External
Masters (International Baccalaureate) – 091850D
Master of Education (Languages Education) - 091859F
Masters (Leadership and Management) – 002617F
Masters (Educational Research Evaluation and Assessment) –
053056A
Masters (Special Education) – 053058K
Masters (Wellbeing and Positive Mental Health) – 091857G

CAREER OUTCOMES
Graduates are suitable for careers in a variety of positions ranging
from work as teachers in school classrooms, school coordinators
and principals, curriculum and policy advisors in departments of
education and as advisors to government departments and other
policy makers. Please note that the Master of Education courses
do not lead to teacher registration. For a career as a teacher, see
under Teaching.

FURTHER STUDY
The Graduate Certificate and Master of Education articulate, with
sequentially developed topics that allow progression through
the two awards. Students who undertake a substantial research
component with the Master of Education may be considered for
further study at the PhD or Doctor of Education level.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ed
CRICOS Code:
Graduate Certificate (Cognitive Psychology and Educational
Practice) – External
Graduate Certificate in Education – 023586A
Graduate Certificate (Higher Education) - External
Graduate Certificate (Languages Education) - External
Graduate Certificate International Baccalaureate – External
Graduate Certificate (Leadership & Management) – 058441G
Graduate Certificate (Special Education) – 053134C
Graduate Certificate (Vision Impairment) – External
Graduate Certificate (Gifted Education) – External
Graduate Certificate (Wellbeing and Positive Mental Health) –
External
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ENGINEERING (BIOMEDICAL)

ENGINEERING (CIVIL)

ENGINEERING (ELECTRONICS)

Master of Engineering (Biomedical)

Master of Engineering (Civil)

Master of Engineering (Electronics)

>

Course length:
2 years full-time

>

2018 fee:
AUD$33,600

>

Course length:
2 years full-time

>

2018 fee:
AUD$33,600

>

Course length:
2 years full-time

>

2018 fee:
AUD$33,600

>

Intake:
Semester 1 • Semester 2

>

>

Intake:
Semester 1 • Semester 2

>

Intake:
Semester 1 • Semester 2

>

Opportunity for
industry experience

>

>

Professional accreditation

>

Professional accreditation

Opportunity for
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Opportunity for
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Professional accreditation

Entry requirements: For all prerequisites and entry
requirements please refer to:
flinders.edu.au/courses/postgrad/eb

Entry requirements: For all prerequisites and entry
requirements please refer to:
flinders.edu.au/courses/postgrad/engciv

Entry requirements: For all prerequisites and entry
requirements please refer to:
flinders.edu.au/courses/postgrad/esi

This course meets the needs of people who already have an
undergraduate degree with expertise in electronic engineering and
would like to broaden their expertise or specialise in the field of
Biomedical Engineering as practising Engineers. In addition, the
coursework Masters can, subject to meeting a credit average in
the course, provide a quality, qualifying pathway into a Biomedical
Engineering PhD for students who have not completed an
undergraduate award in that area.

The Master of Engineering (Civil) is an accredited postgraduate
qualification in Civil Engineering. It will prepare you for a career
in planning, design and maintenance of infrastructure such as
the built environment, water resources, mining and transport.
Civil engineers plan, design, build and maintain a wide variety of
physical infrastructure such as bridges, buildings, airports, roads,
railways, ports, mines, water and wastewater supply, treatment
and reuse systems. They also help to maintain sustainable natural
environments. The solutions developed by civil engineers must take
into consideration social, environmental and financial constraints.
The course has been designed to provide graduates with:
•
a strong foundation in both the theoretical and practical
aspects of Civil Engineering
•
an awareness of social, economic, cultural and environmental
aspects of Civil Engineering
•
an ability to critically analyse and evaluate information and
solve civil engineering related problems

The world of instrumentation and control is rapidly evolving to
include sophisticated, intelligent devices that can sense their
environment, autonomously correct for disturbances and interpret
data from multiple sensing modalities to facilitate intelligent
control of complex systems. Designing and developing these
is the responsibility of electronic engineers who are playing
an increasingly important role in the development of smart
structures for automotive, aerospace and maritime engineering;
bioinstrumentation; intelligent robotics and environment
monitoring. Engineering at Flinders is distinguished by the focus
of strengths in instrumentation and control, including imbedded
systems and the electronics of medical devices.

The course is offered at Flinders’ new Tonsley Campus, a
state-of-the-art, 18,000 square metre facility that is at the heart
of South Australia’s industrial future. Flinders is part of this
exciting new collaborative and high-value industry, education and
residential precinct at Tonsley – and serves as a remarkable site
for experiential learning, social innovation and inspiration. Flinders
at Tonsley is a place where students interact with business,
and where business interacts with researchers in the areas of
engineering, medical devices and nanoscale technologies to make
the new products and processes of the 21st century.
Industry experience: 12 week industry placement.
Professional accreditation: This program is fully accredited
by Engineers Australia at the level of professional engineer.
Professional engineering courses accredited by Engineers Australia
are recognised internationally under the Washington Accord. Once
fully accredited graduates will meet the academic requirements for
attaining chartered professional engineering status.

STUDY PROGRAM
Topics studied may include:
> Physiological Measurement
> Standards, Ethics and Compliance
> Biomechanics
> Biomedical Instrumentation

CAREER OUTCOMES
Graduates work in a variety of areas including the design and
production of diagnostic and therapeutic medical equipment
in hospitals, devices to assist in home-based health care and
rehabilitation and sensory and control systems. Potential roles
include biomedical engineer, medical device assessor, clinical
support specialist, field service engineer, pathology and specialist
product educator/biomedical.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/eb
CRICOS Code: 055942K
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“As an international student, it can
sometimes be hard to speak English
fluently, but all the lecturers, staff and
students at Flinders University have
always been really supportive and
understanding. My course has showed me
that there are a lot of options and career
opportunities in Biomedical Engineering
that I can pursue after my degree.”
Haryati Akmal Borhan
Biomedical Engineering student

Industry experience: The course includes a work experience
component where student will get hands on real world industry
experience in Civil Engineering practice.
Professional accreditation: This program is provisionally
accredited by Engineers Australia at the level of professional
engineer. Full accreditation is normally granted when the first
cohort of students graduate from the program. Professional
engineering courses accredited by Engineers Australia are
recognised internationally under the Washington Accord.
Graduates meet the academic requirements for attaining
chartered professional engineering status.

STUDY PROGRAM
This course covers the four traditional sub-disciplines of Civil
Engineering, Geotechnical, Structural, Transport and Water
Engineering, with the flexibility to choose specialist topics that will
enhance knowledge within a particular Civil discipline. This flexibility
is complemented by a major thesis (subject to receiving a credit
average) or project that allows students to explore a particular
aspect of civil engineering in depth. The course also includes a
work experience component where students will get hands on real
world industry experience in Civil Engineering practice.

The course is offered at Flinders’ new Tonsley Campus, a
state-of-the-art, 18,000 square metre facility that is at the heart
of South Australia’s industrial future. Flinders is part of this
exciting new collaborative and high-value industry, education and
residential precinct at Tonsley – and serves as a remarkable site
for experiential learning, social innovation and inspiration. Flinders
at Tonsley is a place where students interact with business,
and where business interacts with researchers in the areas of
engineering, medical devices and nanoscale technologies to make
the new products and processes of the 21st century.
Industry experience: The course includes a work experience
component where student will get hands on real world industry
experience in Engineering practice.
Professional accreditation: This program is fully accredited
by Engineers Australia at the level of professional engineer.
Professional engineering courses accredited by Engineers
Australia are recognised internationally under the Washington
Accord. Once fully accredited graduates will meet the academic
requirements for attaining chartered professional engineering
status.

STUDY PROGRAM
Topics studied as part of this program may include:
> Computer Organisation and Design
> Sensors and Actuators
> Signal Processing

CAREER OUTCOMES

CAREER OUTCOMES

Civil engineers work closely with architects, planners and the
community to ensure that what is constructed is what is needed.
And unlike many disciplines, the fruits of civil engineering often last
a very long time. Civil engineering graduates are in great demand
with career destinations including building and construction,
transport and the mining industries.

Potential roles include electronics engineer, broadcast engineer,
project coordinator, test engineer, regulatory analyst and scientist.
There are many employment opportunities in some of the fastest
growing areas in defence, medicine, telecommunications, building,
manufacturing, construction and mining.

FURTHER COURSE INFORMATION >>>

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/esi

flinders.edu.au/courses/postgrad/engciv

CRICOS Code: 061252G

CRICOS Code: 091861A
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ENGINEERING (MATERIALS)

ENGINEERING SCIENCE

ENGINEERING SCIENCE

Master of Engineering (Materials)

Graduate Diploma in Engineering Science

Master of Engineering Science (Specialisations)

Civil engineering graduates are in great demand with career
destinations including building and construction, transport and the
mining industries.
ELECTRICAL AND ELECTRONIC

>

Course length:
2 years full-time

>

2018 fee:
AUD$33,600

>

Intake:
Semester 1 • Semester 2

>

>

Opportunity for 		
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Applicants normally must hold the Flinders

University Graduate Diploma in Engineering Science (specialisation M1M2) with an average grade of credit or higher, or a relevant Bachelor of
Engineering, Bachelor of Engineering Technology, Bachelor of Engineering
Science with an average grade of credit or higher, or an equivalent overseas
qualification including an average grade of credit or higher. Students
without such a qualification should apply for the Graduate Diploma in
Engineering Science. The Faculty Board may, under certain circumstances
and subject to specific conditions, admit others who can show evidence of
fitness for candidature. Students who have completed a relevant Bachelor
of Engineering with honours may receive up to 36 units of credit towards
the Masters degree.

Materials represents an important component of many technological
products and the engineering of materials connects to a variety of
research areas including nanotechnology, biomedical engineering,
mechanical engineering, chemical sciences, electrical engineering
and civil engineering. This Masters program provides a broad
extension to a student’s undergraduate study focussing on the
selection, production and behaviour of practical materials used
in engineered products. Materials engineers also look closely at
materials failure—fracture, corrosion, wear—destructive and nondestructive testing, and are generally interested in solid materials
as they are primarily the materials used for manufacture. Materials
engineering involves whole-of-life considerations, including recycling,
and generally involves using materials in bulk.
Flinders University has a research strength in Materials Engineering.
Our leading researchers and well-equipped laboratories at Tonsley
such as Advanced Materials Laboratory, Solid Mechanics and
Materials Laboratory, and Large Scale Material Testing Laboratory
together with the Centre for NanoScale Science and Technology, and
materials characterization facilities located at Bedford Park provide an
excellent research environment for advanced research activities in the
area of Materials Engineering.

STUDY PROGRAM
This program offers a unique combination of advanced areas such
as Materials Selection in Design, Metal Forming, Nanomaterials,
Polymers, Biomaterials, Corrosion, Fatigue & Fracture,
Characterisation Techniques, Organic Synthesis, and Materials for
Civil, Electrical and Optical applications. The course is designed
to present practical aspects of materials engineering. Subject to
receiving a credit average students will also be able to undertake
research project topics which will enable them to develop their
research skills be developing solutions to large and complex
problems. These skills are the foundation for further post-graduate
work at the PhD level.

CAREER OUTCOMES
Materials Engineers are able to find jobs in almost all fields in
which technology is developed providing a great range of career
opportunities to work as a metallurgist, process engineer, corrosion
engineer, polymer engineer, ceramist, quality control engineer, and
surface coatings scientist.

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/engmat
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CRICOS Code: 088514B

>

Course length:
1 year full-time

>

2018 fee:
AUD$33,600

>

Course length:
2 years full-time

>

2018 fee:
AUD$33,600

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: The admission requirements for the award are
either an engineering degree; a science degree; a medical science
degree (for later articulation to the Master of Engineering (Biomedical)
which must include study in biology, chemistry/materials and human
physiology); computer science of information technology degree (for
later articulation to the Master of Engineering (Electronics) which
must include study in either programming or digital electronics);
a chemical sciences degree (for later articulation to the Master of
Engineering (Materials) which must include study in chemistry/
materials); an Australian TAFE Diploma or Advanced Diploma (AQF
Level 5) qualification in an appropriate field plus 7 years relevant work
experience; or an equivalent international qualification.
In addition, whatever qualification is held, students are expected to
be able to demonstrate previous study or recognised prior learning
in communication and planning skills, mathematics (equivalent to
first-year university mathematics) and science (equivalent to university
undergraduate topics in chemistry and physics). Some basic knowledge
of other relevant sciences will be assumed.

The Graduate Diploma in Engineering Science has four
specialisations including Biomedical, Civil, Electronic and Materials
Engineering. This program can be used as pathway to the Flinders
Master of Engineering (Biomedical), Master of Engineering (Civil),
Master of Engineering (Electronics) and Master of Engineering
(Materials) for graduates of science and non-accredited
engineering degrees, as well as being a standalone course. To
progress to these Masters degrees you will need to receive at least
a credit average for studies. You will study both the theoretical
and practical aspects of engineering, building on your previous
experience and knowledge.

STUDY PROGRAM
Biomedical Specialisation may include topics such as:
Electronics, Human Physiology, Microprocessors
Civil Specialisation may include topics such as Civil Engineering
Design, Engineering Mechanics, Engineering Geology and
Geomechanics
Electronics Specialisation may include topics such as Automation
and Industrial Control, Engineering Programming, Analysis of
Engineering Systems
Materials Specialisation may include topics such as Solid Mechanics,
Mechanics and Structures, Engineering Physics and Materials

CAREER OUTCOMES
Graduates can work in an engineering related field where the skills
and knowledge of engineering fundamentals and the ability to
communicate with engineering professionals are needed.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/engsc
CRICOS Code: 077361E

Entry requirements: For all prerequisites and entry
requirements please refer to:
flinders.edu.au/courses/postgrad/engsc
Flinders University’s postgraduate programs in engineering are
multidisciplinary in approach and provide you with access to the latest
technical resources.
This course allows students to undertake a Specialisation in
Biomedical; Civil; Electrical and Electronic; Materials; Mechanical or
Software Engineering.
This course builds on the knowledge a student has gained from
their first degree by providing study in a wide range of foundation
and advanced course related to engineering. The course includes a
major project in which students study an area of interest. The course
is flexible allowing students who have studied similar material before
to modify their program of study.
Professional accreditation: This course is not accredited but
students who have completed at least twelve months with a credit
average or higher may transfer to the relevant accredited Master of
Engineering (Biomedical); Master of Engineering (Civil); and Master
of Engineering (Electronics).
BIOMEDICAL
The Master of Engineering Science (Biomedical) equips students
with the skills to investigate, plan, design, manufacture and maintain
systems and equipment that are used in all aspects of health care.
Throughout the course, there is a strong emphasis on practical skills
and teamwork. Graduates often work in multi-disciplinary teams with
health professionals and medical specialists in hospitals and public
and private sector organisations. They use their professional skills and
knowledge in the systematic development of complex systems with
particular emphasis on biomedical systems. This includes the design
or production of:
• A wide range of sophisticated diagnostic and therapeutic medical
equipment in hospitals; and
• Devices to assist in home-based health care and rehabilitation,
including prosthetic and biomechanical devices.
CIVIL
Civil engineers develop and maintain a wide variety of physical
infrastructure such as bridges, buildings, airports, roads, railways,
ports, mine sites, water and wastewater supply, treatment and reuse
systems. They also help to maintain sustainable natural environments.
They are highly creative and innovative problem solvers who design,
construct, manage, maintain, or rehabilitate all aspects of this
infrastructure. The technical solutions developed by civil engineers
must take into consideration social, environmental and financial
constraints. The Master of Engineering Science (Civil) provides a
broad range of skills to investigate, plan, design and maintain complex
civil engineering solutions. Throughout the course, there is a strong
emphasis on practical skills and teamwork.
Civil engineers work closely with architects, planners and the
community to ensure that what is constructed is what is needed. And
unlike many disciplines, the fruits of civil engineering often last a very
long time.

Electrical engineering is concerned with large scale electrical systems
such as power supply, renewable power generation and motors
while electronic engineering is typically concerned with small scale,
often lower voltage electronic systems such as computer systems,
communication networks and integrated circuits. This degree adds
to a student’s previous study and covers both types of engineering.
The Master of Engineering Science (Electrical and Electronic)
equips students with the skills and knowledge to plan, design and
build the electrical and electronic circuitry that is integral to so many
high technology applications. Students also have the opportunity to
focus on niche areas including renewable technologies such as wind
farms, and electrical drive systems such as those used on ships and
submarines and in emission-free vehicles.
Electrical and electronic engineers are involved in developing
technology used in areas such as aircraft systems, media and
sound broadcasting, power distribution systems, traffic and urban
management, medical equipment, robotics, broadband systems, and
scientific devices.
High demand exists for qualified professional electrical and electronic
engineers in areas such as defence, medicine, telecommunications,
building, manufacturing and mining.
MATERIALS
Materials represents an important component of many technological
products and the engineering of materials connects to a variety of
research areas including nanotechnology, biomedical engineering,
mechanical engineering, chemical sciences, electrical engineering
and civil engineering. This program provides an extension to a
student’s undergraduate study focusing on the selection, production
and behaviour of practical materials used in engineered products.
Materials engineers also look closely at materials failure - fracture,
corrosion, wear - destructive and non-destructive testing, and
are generally interested in solid materials as they are primarily the
materials used for manufacture.
Materials engineering involves whole-of-life considerations, including
recycling, and generally involves using materials in bulk.
Materials Engineers are able to find jobs in almost all fields in
which technology is developed providing a great range of career
opportunities to work as a metallurgist, process engineer, corrosion
engineer, polymer engineer, ceramist, quality control engineer, and
surface coatings scientist.
SOFTWARE
Software engineering is a dynamic engineering discipline that
is concerned with all aspects of software use, from design and
development to maintenance and management. The Master of
Engineering Science (Software) equips students with the skills to
combine the art and skill of engineering with the power of computer
technology. Software engineering develops programs and products
that meet the demands of the modern economy.
Graduates will be equipped to work as software designers in areas
as diverse as smart cards, mobile commerce and communications,
simulators, medical and imaging equipment, internet computing and
defence systems.

FURTHER STUDY
Master of Engineering (Biomedical), Master of Engineering
(Electronics), Master of Engineering (Civil), Master of Engineering
(Materials), Master of Engineering by Research, Doctor of Philosophy.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/engsc
CRICOS Code: 094010J
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ENVIRONMENTAL HEALTH

ENVIRONMENTAL MANAGEMENT

Graduate Diploma in Environmental Health Practice;
Master of Environmental Health

Graduate Certificate in Environmental Management; Graduate Diploma in
Environmental Management; Master of Environmental Management

>

>

>

Course length:
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

Intake:
Semester 1 • Semester 2

>

Professional 		
accreditation

2018 fee:
Graduate Diploma:
AUD$31,000
Masters:
AUD$31,000
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent with a
minimum of one successful semester of full-time study in basic
sciences such as chemistry, physics, microbiology, physiology or
life sciences.
Note: Some topics in the Graduate Diploma are taught in intensive
delivery mode.

Environmental Health is the study of how the environment
impacts on our health – the physical, biological, chemical and
sociological factors external to us that determine our health and
well-being. Environmental health is the branch of public health that
is concerned with all aspects of the natural and built environment
that affect our health, such as water, food, air, buildings and waste.
The postgraduate courses in Environmental Health aim to provide
you with the professional qualifications to enter or enhance career
opportunities in the area of environmental health. This pathway
program provides you with advanced knowledge in the theory and
application of environmental health and environmental health risk
assessment.
Professional accreditation: The Graduate Diploma and
the Masters have been designed to fit the requirements for
Environmental Health Australia (EHA) accreditation, enabling
practice across Australia and internationally.

STUDY PROGRAM
Topics may include:
> Environmental Health Concepts
> Human Systems in Environmental Health
> Sustainable Development - Health Issues
> Legislation Relevant to Environmental Health
> Microbiology and Communicable Diseases

CAREER OUTCOMES
Graduates of the Graduate Diploma in Environmental Health
Practice will be qualified to practise as EHOs, however some
further study may be required for international students to be
recognised under their domestic legislation. Graduates of the
Masters program will be qualified for employment in both the
public and private sector, especially local government, state
health departments, private environmental consulting firms and
mining companies. Graduates will gain the project management,
research, communication and report writing skills that are critical
to the senior and specialist roles in environmental health.

FURTHER COURSE INFORMATION >>>

>

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

Intake:
Graduate Certificate:
Semester 1
Graduate Diploma and
Masters:
Semester 1 • Semester 2

>

2018 fee:
Graduate Certificate:
AUD$15,500
Graduate Diploma:
AUD$31,000
Masters:
AUD$31,000
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent
qualification from an approved tertiary institution.
Human-environment interactions pose some of the most
compelling and fraught challenges of the 21st century
(climate change, deforestation, water resource availability,
energy consumption, urban expansion, population growth and
food security). Understanding these challenges and solving
environmental problems requires both knowledge of ecological
and physical processes and insight into the cultural, demographic,
economic, geographical, political aspects of human-environment
connections. Environmental management is therefore complex
and requires interdisciplinary approaches to resolving challenges
posed by human-environment interactions.

STUDY PROGRAM
The program is international in scope but case study material
draws strongly on the experience of Australia and other countries
within the Asia-Pacific region. All three programs combine
important theoretical knowledge with the opportunity to complete
skill based topics. There is a large range of option topics to
choose from so that programs can be built to suit student’s
interests and current or future employment requirements.

CAREER OUTCOMES
Potential positions include policy, research or planning officers
and on-ground management. Graduates of the Environmental
Management program are suited to a diverse range of positions
across a range of employers, including government, nongovernment organisations and the private sector.

FURTHER STUDY
The Graduate Certificate in Environmental Management articulates
with the Graduate Diploma in Environmental Management and the
Master of Environmental Management.

GENDER, DEVELOPMENT AND
WOMEN’S STUDIES

GENDER MAINSTREAMING POLICY
AND ANALYSIS

Graduate Diploma in Gender and Development; Master of Arts (Women’s Studies)

Graduate Certificate in Gender Mainstreaming Policy and Analysis

>

>

Course length:
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Diploma:
AUD$28,100
Masters:
AUD$28,100
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Course length:
1 year part-time

>

2018 fee:
AUD$14,050

>

Intake:
Semester 1 • Semester 2

>

>

Opportunity for
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent
qualification from an approved tertiary institution.

Entry requirements: Bachelor degree or equivalent qualification
from an approved tertiary institution.

The Graduate Diploma in Gender and Development is a
structured, multidisciplinary program combining Women’s Studies
with Politics, Sociology and other disciplines as approaches
to the broad issues of gender, development and the rights of
people in society. It introduces students to the theoretical and
empirical analysis of a wide range of issues and focuses on the
development of flexible skills suited to a variety of situations and
contexts. The Master of Arts (Women’s Studies) is available in a
coursework stream and a research stream. Gender issues shape
political, cultural and social institutions, as well as personal identity
and relationships. The interdisciplinary field of Women’s Studies
reflects the wide scope by including social, cultural and political
perspectives.

Gender analysis is a foundational base for all economic and social
development policy and development programs. This course
is designed to provide you with specialised knowledge related
to the integration of gender considerations into policy making,
project design and implementation, monitoring and evaluation. The
specialised skills it offers in gender mainstreaming and gender
analysis are applicable both in Australia and internationally. Staff
teaching the core topics in the Graduate Certificate in Gender
Mainstreaming Policy and Analysis were awarded a citation in
2011 for outstanding contributions to student learning by the
Australian Learning and Teaching Council.

STUDY PROGRAM

Industry experience: The course also provides opportunities to
apply this knowledge in simulated virtual learning environments
designed to enhance work related learning and understanding of
real-world workplace contexts.

Topics undertaken in both the Graduate Diploma and Masters
programs may include:

STUDY PROGRAM

> The Global Woman: Introduction to Gender and Development
> Introduction to Women’s Studies: Sex, Gender and Identities
> Women in World Religions
> Gender Analysis

CAREER OUTCOMES
This course provides students with specialist knowledge
which can be applied in the gender and development field or
associated areas of employment and/or research. Graduates are
suitable for careers in environments that specialise in gender or
women’s issues. Potential roles include gender mainstreaming
specialist, women’s project coordinator (refugee services),
fundraising program officer and international development officer.
Areas of employment exist in government departments, nongovernment organisations, international development consultancy
organisations and private sector industries with a gender equality
or equal opportunity policy and strategy.

FURTHER COURSE INFORMATION >>>

Topics may include the following:
> Gender Analysis
> Gender Mainstreaming
> Applied Development Studies
> Development Problems, Policies and Programs

CAREER OUTCOMES
Graduates are suitable for careers in environments that specialise
in gender or women’s issues. Potential roles include quantitative
researcher, business operations head, public policy officer and
gender mainstreaming specialist. Areas of employment exist
in government departments, non-government organisations,
international development consultancy organisations and private
sector industries with a gender equality or equal opportunity policy
and strategy.

FURTHER STUDY

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/maws

The Graduate Certificate in Gender Mainstreaming Policy and
Analysis articulates with the Graduate Diploma in International
Development, the Master of Arts (International Development), and
the Master of International Development.

flinders.edu.au/courses/postgrad/emg

CRICOS Code: Graduate Diploma – 028944K.
Masters – 008136G

FURTHER COURSE INFORMATION >>>

CRICOS Code: Graduate Certificate – 039965C. Graduate
Diploma – 039964D. Masters – 030806B

flinders.edu.au/courses/postgrad/gdpgd

flinders.edu.au/courses/postgrad/gcgmpa
CRICOS Code: External only

flinders.edu.au/courses/postgrad/gdpehp
CRICOS Code: Graduate Diploma - External only. Masters 080526G.
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GERONTOLOGY

GEOSPATIAL INFORMATION SCIENCE

GLOBAL POINT-OF-CARE TESTING

GROUNDWATER HYDROLOGY

Graduate Certificate in Applied Gerontology; Graduate Diploma in Applied
Gerontology; Master of Applied Gerontology

Graduate Certificate in Geographical Information Systems; Graduate Diploma in
Geographical Information Systems; Master of Geospatial Information Science

Graduate Certificate in Global Point-of-Care Testing

Graduate Certificate in Science (Groundwater Hydrology); Graduate
Diploma in Science (Groundwater Hydrology); Master of Science
(Groundwater Hydrology)

>

>

>

Course length:
Graduate Certificate:
1 year part-time		
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

Intake:
Semester 1 • Semester 2

>

Opportunity for
industry experience

2018 fee:
Graduate Certificate:
AUD$15,250
Graduate Diploma:
AUD$30,500
Masters:
AUD$30,500

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Entry requirements: Graduate Certificate/Diploma – Bachelor
degree or equivalent in a health-related field and at least one year
relevant ageing work experience. Masters – Bachelor degree or
equivalent and at least two years experience in palliative care,
aged care or related field.
This articulated, multidisciplinary program was developed to
address the professional needs of graduates involved with policy,
planning or service delivery for older people. These courses
feature seven key perspectives throughout each topic:
> healthy, positive ageing;
> life-course framework for understanding ageing;
> multidisciplinary approach;
> multicultural awareness and a global viewpoint;
> lifelong learning and e-learning for improving professional
practice;
> research, evaluation and evidence-based planning and service
delivery;
> ethical decision making.
Industry experience: Masters students have the opportunity to
undertake a practicum.

STUDY PROGRAM
Topics in these programs may include:
> Introduction to Social Gerontology
> Introduction to Clinical Gerontology
> Psychological Dimensions of Ageing
> Understanding Literature for Evidence-Based Practice

CAREER OUTCOMES
Career opportunities in the field of gerontology are expanding
rapidly with global ageing, in a wide variety of areas. Gerontologists
work in a range of employment settings including health care
settings such as aged care homes, community care and acute
hospitals as well as government departments (national, regional
and local), universities and private businesses. Nurses, physicians,
allied health and non clinicians from a range of professions will
be able to use gerontological knowledge for policy, planning and
practice to meet the needs of older people.

FURTHER STUDY
The Graduate Certificate in Applied Gerontology articulates to the
Graduate Diploma and the Master of Applied Gerontology.
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Course length:
Graduate Certificate:
6 months full-time		
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Certificate:
AUD$15,500
Graduate Diploma:
AUD$31,000
Masters:
AUD$31,000
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent qualification
from an approved tertiary institution.
Geospatial information science (GISc) is the study of the theory
and practice of spatial analysis through the use of geographical
information systems and remote sensing technologies. This
articulated program provides students with advanced knowledge
in the theory and application of geographical information
systems and remote sensing and is intended for students with an
undergraduate degree that is not related to studies in Geospatial
Information Science. The program provides a theoretical and
practical framework for graduates from a range of backgrounds,
as well as those from the public sector and non-government
organisations wishing to extend their choice of career path by
acquiring knowledge and skills in the capture, analysis and
communication of spatially-referenced information. Students will
develop and implement GISc skills and knowledge applicable to
a range of areas, such as environmental management, urban and
regional planning, human geography and environmental health,
land-use dynamics, natural resources management, ecosystem
services, biological sciences, and archaeology.

>

Course length:
6 months full-time

>

2018 fee:
AUD$13,250

>

Intake:
Semester 1

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent qualification
from an approved tertiary institution.
Point-of-care testing (POCT) is pathology testing performed
by a trained operator in an on-site clinical setting at the time of
patient consultation on behalf of the treating medical practitioner.
This course provides advanced level preparation for health
professionals from both Australian and international backgrounds
wishing to specialise in point-of-care pathology testing and
particular emphasis will be placed on preparing students for
working within a multidisciplinary health care team in remote
or Indigenous primary care settings in their country of origin.
The course is particularly relevant for health professionals with
qualifications in the fields of health science, medical science,
nursing, medicine, nutrition, paramedic science, Indigenous health
or public health, and who would normally have experience, or be
currently practising, as a health professional. It will also appeal to
new graduates in these fields.

STUDY PROGRAM
Examples of topics studied include:
> Advanced Point-of-Care Testing 1 & 2
> Remote & Indigenous Primary Health Care
> Perspectives on Chronic Diseases Management

STUDY PROGRAM

CAREER OUTCOMES

Students select from a range of geospatial topics to build a
study program that suits their interests and future employment
requirements. The program is specifically designed to provide
flexibility to students with different levels of GIS and remote
sensing experience and skills. Globally relevant concepts taught in
the GIS graduate program include spatial data capture and input
protocols, database structures, spatial analysis, modelling and
communication practices.

Employment opportunities exist in selected fields where pointof-care testing is widely practiced; these include remote and
Indigenous health, chronic disease management, infectious
disease and disaster management. Graduates will be qualified
to practice as a point-of-care coordinator at a local, national or
international level.

CAREER OUTCOMES

flinders.edu.au/courses/postgrad/gcgpct

The use of geospatial information science technologies is
rapidly increasing. GISc technologies are now commonly used
in industries such as agriculture, forestry, mining, environmental
management, biodiversity conservation, archaeology, health and
the social sciences. Consequently, employers in these areas are
now requiring their staff to have more skills in GISc. Potential
roles include geographic analyst, GISc data coordinator, GISc
technician, geospatial specialist, mapping technology officer,
natural resource information officer, remote sensing officer, research
officer, spatial ecologist and spatial scientist. Typical employers
include government departments, regional development centres,
agriculture and horticultural centres, not for profit agencies, and
private companies that supply or collect spatial information.

FURTHER COURSE INFORMATION >>>

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/ag

flinders.edu.au/courses/postgrad/gis

CRICOS Code: Graduate Certificate – External only.
Graduate Diploma – 072483B. Masters – 072484A

CRICOS Code: Graduate Certificate – 064259K. Graduate
Diploma – 064260F. Masters – 079420E

FURTHER COURSE INFORMATION >>>
CRICOS Code: Online only

>

Course length:
Graduate Certificate:
6 months full-time		
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

2018 fee:
Graduate Certificate:
AUD$16,500
Graduate Diploma:
AUD$33,000
Masters:
AUD$33,000

>

Intake:
Semester 1 • Semester 2

>

>

Opportunity for
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent in any
relevant discipline of science or engineering from an approved
tertiary institution.
Note: Some topics not offered in Internal mode.

Flinders University is an international leader in groundwater
hydrology education and research with one of the largest groups in
any Australian university working in the area. Our strong teaching
program is complemented by a leading research program for
the training of Master of Science and PhD by research. Flinders
University is a key partner in the National Centre for Groundwater
Research and Training, which is located on the Flinders campus.
The National Centre provides strong links with industry and access
to a large range of expertise not otherwise available, with numerous
leading State and Federal agencies such as CSIRO Land and
Water, Department of Environment, Water and Natural Resources
and other partners. Students have access to National Groundwater
Short Courses for professional training which are credited to their
degrees, as well as to excellent industry-based research projects.
The Director of the National Centre for Groundwater Research and
Training, Professor Craig Simmons, was recently awarded the 2015
South Australian Scientist of the Year award.
Industry experience: Masters students have the opportunity to
undertake an industry placement.

STUDY PROGRAM
Topics studied may include:
> Public Health Aspects of Water Quality
> Ecohydrology
> Fundamentals of Groundwater

CAREER OUTCOMES
Groundwater hydrology is a major growth area for employment
worldwide and trained professionals in this area are in demand.
Potential roles include senior groundwater modeller, environmental
scientist/GIS, senior natural systems officer and water engineer.
Graduates have found jobs in natural resource and environment
agencies of government, environmental consultancies and in
industry sectors such as agriculture, mining, aquacultures and
water resource planning and management.

FURTHER STUDY
The Graduate Certificate articulates with the Graduate Diploma
and the Masters.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/gh
CRICOS Code: Graduate Certificate – 047375C.
Graduate Diploma – 047376B. Masters – 047377A
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HEALTH ADMINISTRATION
Graduate Diploma in Health Administration; Master of Health
Administration; Master of Science (Health Administration)
>

>

Course length:
Graduate Diploma:
1 year full-time
Master of Health:
1.5 years full-time
Masters of Science:
2 years full-time

>

Professional accreditation

>

2018 fee:
Graduate Diploma:
AUD$30,500
Masters:
AUD$30,500

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent and
four years (two for Graduate Diploma) of post-graduation
professional work experience in the health sector. Additionally,
Master of Science (Health Administration) applicants must
supply a CV and research proposal.
Note: Taught at Flinders City Presence, Victoria Square. Some topics
are taught in intensive delivery mode.

The Health Administration graduate program is designed to:
> develop an understanding of management theories and principles
and their application in health and aged care management;
> strengthen practical management skills;
> develop critical analytical skills applicable to current issues and
policy creation in health services;
> enhance understanding of the health and aged care systems
and their financial, economic and statistical models and methods;
> enhance understanding of the legal and ethical framework of
management practice in health and aged care.

HEALTH AND INTERNATIONAL
DEVELOPMENT
Master of Health and International Development
>

Course length:
2 years full-time

>

2018 fee:
AUD$30,500

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Applicants must normally hold an
approved degree or equivalent qualification from an approved
tertiary institution.
The Master of Health and International Development
acknowledges the increasing complexity of working in the
international development context. In particular it addresses
the need for a more thorough understanding of international
development by those working in the health sector, and the
need for a more informed understanding of the role of health
in development for international development managers and
practitioners. The course is designed for people working in
government, NGOs or private consulting organisations either
in Australia or overseas. The content has been developed to
meet the needs of both external advisors and local health and/or
development personnel.

STUDY PROGRAM
Topics undertaken may include:

Professional accreditation: Our Graduate Diploma and
Masters programs are accredited by the Australasian College of
Health Service Management (ACHSM). The Master of Health
Administration also meets the curriculum requirements of the
Royal Australasian College of Medical Administrators’ (RACMA)
Fellowship Training Program.

> Development Problems, Policies and Programs
> Gender Mainstreaming
> Social Determinants of Health and Wellbeing
> Primary Health Care Practice in Developing Countries
> Public Health Care Practice Development
> Gender Analysis
> Action on Social Determinants of Health

STUDY PROGRAM

CAREER OUTCOMES

Topics studied may include:
> Health and Aged Care Systems and Policy
> Health Law and Ethics
> Safety and Quality in Health Care

Health and international development is a fast-growing division
with long-term trends shaping the sector including an ageing
population and advancements in healthcare. Formal training in
international development is becoming increasingly important for
people wishing to obtain employment in development settings.
Graduates may gain employment as international public health
officers, international health managers, development field workers,
health work trainers, international development project officers
and international health research officers. Potential employers
include community health providers, government agencies,
development agencies, hospitals, non-government organisations
and research centres.

Take the Lead in Health
The Master of Business Administration, Master of Health
Administration prepares students to investigate advanced issues
in health management with a strong foundation of business
knowledge. This course prepares students for a successful
career as a manager in the private, not-for-profit, government and
public sectors. The course prepares graduates for entry to the
Australasian College of Health Service Management and assists
medical practitioners to enter the Royal Australasian College of
Medical Administrators.

CAREER OUTCOMES
Across the world, the health and aged care sectors are
experiencing substantial reform and are growing rapidly.
These courses allow individuals from any professional background
working in health-related areas to deepen the knowledge base on
which their practice is grounded.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mhid
CRICOS Code: 051002J

INFORMATION TECHNOLOGY
Graduate Diploma in Information Technology;
Master of Information Technology
>

Course length:
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

2018 fee:
Graduate Diploma:
AUD$29,900
Masters:
AUD$29,900

>

Intake:
Semester 1 • Semester 2

>

>

Professional 		
accreditation

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.
This articulated program was specifically designed to cater for
graduates with a previous degree in a non-information technology
area who are looking to upgrade and extend their knowledge and
skills in an area that has dramatically changed in recent years.
Graduates from the award have come from a diverse range of
backgrounds and have found employment in a range of areas
including, in some cases, areas related to their initial degree. This
program capitalises on the re-building demand for professionals
as information technology is applied across a continually widening
range of applications ranging from intelligent consumer goods such
as mobile phones and cars through to electronic medical records.
The course is offered at Flinders’ Tonsley Campus, a state-of-theart, 18,000 square metre facility. Flinders at Tonsley is a place
where students interact with business, and where business
interacts with researchers in the areas of engineering, medical
devices and nanoscale technologies to make the new products and
processes of the 21st century.
Professional accreditation: The Master of Information Technology
is accredited by the Australian Computer Society at the
Professional level. Courses accredited at this level by the Australian
Computer Society are recognised internationally under the Seoul
Accord.

STUDY PROGRAM
Topics undertaken may include:
> Fundamentals of Computing
> Software Engineering
> Database and Conceptual Modelling
> Statistical Science

CAREER OUTCOMES
From theory through programming to cutting-edge development
of computing solutions, information technology provides
students with a solid foundation and the ability to adapt to new
and innovative technologies. Potential roles include software
developer, software tester, IT project manager, systems analyst,
programmer, webmaster, researcher and developer, and
networking and communications specialist.

“I chose Flinders University because it
has a good reputation and a high standard
of educations and courses. My friends
in China who were recent graduates of
Flinders, strongly recommended that I
study here as I wanted to develop my
knowledge and skills, rather than just
receive a piece of paper.”
My course doesn’t just require me to
learn from textbooks – it also creates
opportunities for me to make connections
with real relevant businesses and
organisations, as well as many internship
opportunities.”
Wenxun Zhou (Vincent)
Information Technology student

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/it
CRICOS Code: Graduate Diploma – 038638D. Masters –
038636F

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/had
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CRICOS Code: Graduate Diploma – 023592C.
Master of Health Administration – 011341K. Master of Science
(Health Administration) – 023594A.
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INNOVATION AND ENTERPRISE

INTERNATIONAL DEVELOPMENT

INTERNATIONAL RELATIONS

JURIS DOCTOR

Graduate Certificate in Innovation and Enterprise
Graduate Diploma in Innovation and Enterprise

Graduate Certificate in International Development; Graduate Diploma in
International Development; Master of Arts (International Development);
Master of International Development

Graduate Certificate in International Relations; Graduate Diploma in
International Relations; Master of Arts (International Relations)

Juris Doctor

>
>

>

>

Course length:
Graduate Certificate:
6 months full-time		
Graduate Diploma:
1 year full-time

>

Intake:
Semester 1 • Semester 2

>

Opportunity for industry
experience

2018 fee:
Graduate Certificate:
AUD$15,350
Graduate Diploma:
AUD$30,700

>

English requirements:
IELTS:
6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

>

>

Entry requirements: Entry into the Graduate Certificate requires
a bachelor degree or 5 years work experience in a relevant area
(e.g. entrepreneurship, innovation, enterprise). Entry into the
Graduate Diploma requires a bachelor degree in any discipline,
or completion of the Graduate Certificate in Innovation and
Enterprise (or equivalent).
Our programs in Innovation and Enterprise are designed to
utilise creativity and innovation in strategy formation. Students
will immerse themselves in creative problem solving, applying
innovative principles, understanding disruptive markets, identifying
and maximising opportunities, as well as exploring novel new
business models and how to innovate and evaluate viability.
Flinders Business School’s teaching philosophy and small class
sizes ensure that you can really engage with your teacher, while
getting to know your fellow students. You will also have access to
workshops and events with experienced entrepreneurs and other
relevant industry practitioners.
Industry experience: Students may have the opportunity to
undertake an industry placement and/or project.

STUDY PROGRAM
Some of the topics studied as part of these programs may include:
> Innovative and Creative Thinking: Recognising Opportunities
> Social Entrepreneurship: Doing Good While Doing Well
> Crowd, Cloud and Open Innovation: Leveraging your
Ecosystem for Innovation
> Emerging Market Innovation
> New Venture creation
> Building Effectiveness and Efficiency

CAREER OUTCOMES
Graduates are equipped with practical tools to successfully start
and bring to maturity new ventures, or alternatively, grow new
revenue streams for employers. They will be better prepared
to engage in the industries of the future. Graduates can work
as a small and medium business owner across all industries.
Graduates can also obtain employment in mid-level management
as business consultants, sales, research and development, and
as not-for profit fundraisers. Potential roles include business
manager, CEO, opportunity assessor, entrepreneur, strategist
and innovation manager.

FURTHER COURSE INFORMATION >>>

>

Intake:
Semester 1 • Semester 2

>

Opportunity for industry
experience

2018 fee:
Graduate Certificate:
AUD$14,050
Graduate Diploma:
AUD$28,100
Master of Arts: 		
AUD$28,100
Master: AUD$28,100
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Graduate Certificate and Graduate
Diploma: Bachelor degree or equivalent from an approved
tertiary institution. Masters: Refer to flinders.edu.au/courses/
postgrad/id
The International Development programs, offered by the School of
History and International Relations, are interdisciplinary in nature
and explore the social, political and cultural forces transforming
developing countries within a global context. Staff across the social
sciences contribute elective topics covering a wide range of related
disciplines including area studies, demography, environment,
geography, international relations, public policy, political studies,
and public health. International development focuses on developing
countries of the Global South – their culture, economy, society,
history and politics. It analyses how societies are transformed
by historical and contemporary processes of social change and
examines efforts by governments, development agencies and
social movements to address vital common problems.
Industry experience: You will have the opportunity to put
theory into practice with local and international internships and
practicums available.

>

Course length:
Graduate Certificate:
6 months full-time		
Graduate Diploma:
1 year full-time
Masters:
2 years full-time
Intake:
Semester 1 • Semester 2

>

>

2018 fee:
Graduate Certificate:
AUD$14,050
Graduate Diploma:
AUD$28,100
Masters: AUD$28,100

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.
This program explores contemporary theory and research in
international relations and offers an opportunity to specialise in
international theory and the international relations of the AsiaPacific region. It provides a specialised postgraduate education
for students who may seek to pursue later doctoral studies or
professional employment in foreign affairs, defence, international
trade, journalism or related areas. The program is taught by
staff from Flinders University’s School of History & International
Relations, one of Australia’s leading centres of teaching and
research in international relations.

STUDY PROGRAM
Topics studied may include:
> New Security Agenda
> Global Inequality
> Debating International Relations
> International Human Rights: Theory and Practice

CAREER OUTCOMES

> Development Problems, Policies and Programs
> Sustainable Development
> Gender Analysis

CAREER OUTCOMES

FURTHER STUDY

STUDY PROGRAM
Areas of study may include:

International development offers a growing range of employment
opportunities. Potential roles include international development
officer, regional development manager, strategic analyst, project
officer, international policy advisor and international business
development manager. Employment opportunities include nongovernment organisations specialising in development (foreign
affairs, trade, and development assistance, amongst others), and
the development consultancy industry.

FURTHER STUDY
The International Development programs articulate with sequentially
developed topics that allow progression through the awards.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/id

flinders.edu.au/courses/postgrad/gdie

CRICOS Code: Graduate Certificate – 043147C. Graduate
Diploma – 028948F. Master of Arts – 079415B (1.5 years).
Master of International Development – 079414C

>

Course length:
3 years full-time

>

2018 fee:
AUD$28,800

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 7 (S7 • W7 • R7 • L7)
PTE: 65^ (see pg 85)

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Graduates are suitable for careers in foreign affairs, defence,
international trade and related areas. Potential roles include
international development officer, regional development manager,
strategic analyst, project officer, international policy advisor and
international business development manager. Typical employers of
international relations graduates include government departments,
councils, charities, accountancy and banking organisations, law
firms, retail and media companies.

flinders.edu.au/courses/postgrad/gcie
Graduate Certificate in Innovation and Enterprise - 092885G.
Graduate Diploma in Innovation and Enterprise - 092886F

58

Course length:
Graduate Certificate:
6 months full-time		
Graduate Diploma:
1 year full-time
Master of Arts:
1.5 years full-time
Masters: 2 years full-time

The International Relations programs articulate, with sequentially
developed topics that allow progression through the three awards.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ir
CRICOS Code: Graduate Certificate – 045233M. Graduate
Diploma – 045234K. Masters – 020923B

Entry requirements: Applicants must normally hold either
an approved Bachelor degree or equivalent qualification in a
discipline other than Law from an approved tertiary institution; or
an approved Bachelor degree or equivalent qualification in Law
that does not give entitlement to admission to practise law in
Australia.
The Juris Doctor (JD) seeks to provide the academic knowledge and
skills needed to embark upon a career as a practising lawyer, but was
also created in the knowledge that not all graduates want, or are able,
to work as barristers or solicitors.
It is taught in collaboration with the legal profession and provides
opportunities for learning in an authentic context, with real client work
experience a requirement of the course. The JD articulates with the
Graduate Diploma in Legal Practice, allowing graduates to satisfy
the academic and practical requirements for admission as a legal
practitioner. If you complete the Flinders JD you will normally receive
credit for two out of the eight topics in the Graduate Diploma.
This course is approved by the Legal Practitioners Education and
Admission Council (LPEAC).

STUDY PROGRAM
Topics studies may include:
> The Australian Legal System
> Professional Identity
> Clinical Legal Education
> Capstone Explorations of the Professional Environment
> Legal Analysis and Problem Solving
> Dispute Resolution
> Contract
> Torts
> Property, Equity and Trusts
> Constitutional Law
> Administrative Law
> Criminal Law
> Corporate Law
> Real Property Law
> Advanced Dispute Resolution
> Evidence

CAREER OUTCOMES
The Juris Doctor in combination with the Graduate Diploma in
Legal Practice will satisfy the academic and practical requirements
for admission to the legal profession under the rules of the Legal
Practitioners’ Education and Admission Council 2004. Graduates of
the Juris Doctor and Graduate Diploma in Legal Practice will qualify to
practise as a barrister and solicitor and work in law firms, government,
private-sector organisations, policy development, administration,
social justice and human rights, in Australia and internationally.

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/juris-doctor
CRICOS Code: External only
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LANGUAGE STUDIES

LANGUAGE TEACHING

Master of Language Studies

Graduate Certificate in Language Teaching; Graduate Diploma in Language
Teaching

>

Course length:
2 years full-time

>

2018 fee:
AUD$26,800

>

Intake:
Semester 1

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent that
includes a major completed with a GPA of 5.0 or higher in one
or more of the following languages: French, Modern Greek,
Spanish, Italian or Indonesian.
This course is designed to provide an advanced level of
understanding of one of the following areas of specialisation:
Cultural Studies, (relative to French, Italian, Indonesian, Modern
Greek, or Spanish), Applied Linguistics or Teaching English as
a Second Language (TESOL). The course will train students
to form broad conceptual understandings while gaining depth
of knowledge of a particular area of the above specialisations,
through coursework and through a dissertation-style research
project.

STUDY PROGRAM
Topics undertaken in the Master of Language Studies program
may be chosen according to the following program of study:
> Topics offered in Cultural Studies, Applied Linguistics, Teaching
English as a Second Language and Study Abroad
> Research Project

CAREER OUTCOMES
The Master of Language Studies provides advanced practical
language training and vocational knowledge and abilities in areas
relevant to the language profession. With the internationalisation
of the job market, graduates with a qualification in a foreign
language will have greater employment opportunities across the
globe. Potential roles include language teacher, communications
specialist, immigration officer, international student advisor,
interpreter, linguist, multicultural service officer, translator and
travel consultant. Potential areas of employment include tourism
agencies, foreign language teaching, international trade, finance
and commerce, diplomatic and defence agencies, translating
services, and international development.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mls
CRICOS Code: 064989J

>

>

Course length:
Graduate Certificate:
1 year part-time only
Graduate Diploma:
2-3 years part-time only

>

Intake:
Semester 1

>

2018 fee:
Graduate Certificate:
AUD$13,100*
Graduate Diploma:
AUD$26,200*
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

* External fee is 10% less than stated fee.
Entry requirements: Bachelor degree or equivalent. You must
also be eligible for registration as a teacher in Australia and have
had at least one year teaching experience in a school or other
approved institution.
Studying a second language is very rewarding. From the outset,
staff seek to stimulate students’ interest and make them want
to know more about their chosen language and the culture and
society in which it is used. As graduate qualifications, these
courses are valuable for the professional development of teachers,
since they offer them the possibility of improving career prospects
in both the public and private sector. The languages offered under
these awards are: French, Indonesian, Italian, Modern Greek and
Spanish.

STUDY PROGRAM
The initial first-semester topic for the Graduate Certificate and
Graduate Diploma presumes no previous knowledge of the
language. Both courses include the study of the language through
the four skills of listening, speaking, reading and writing; the study
of the society and culture of the country or countries where the
language is spoken; as well as an introduction to second language
acquisition through the following specifically-designed topic:
> Introduction to Second Language Acquisition
The methodology module for the Graduate Diploma comprises a
further topic chosen from either:
> Second Language Teaching Methodology, or
> Introduction to Classroom-based Research

CAREER OUTCOMES
With the internationalisation of the job market, graduates with a
qualification in language teaching will have greater employment
opportunities across the globe. Graduates of this articulated
program are suitable for careers teaching in Australia at private
language colleges, university language centres and overseas at
schools, universities and private language colleges.

FURTHER STUDY

LAWS (INTERNATIONAL LAW AND
INTERNATIONAL RELATIONS)

LOSS, GRIEF AND TRAUMA
COUNSELLING

Master of Law (International Law and International Relations)

Graduate Certificate in Loss, Grief and Trauma Counselling

>

Course length:
2 years full-time
1.5 years full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
AUD$28,800

>

Course length:
6 months full-time

>

2018 fee: 		
AUD$14,050

>

English requirements:
IELTS: 6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

>

Intake:
Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: 1.5 Years (54 units) - Applicants must
normally hold an approved bachelor degree or equivalent
qualification from an approved tertiary institution in Law or in
another discipline related to the field of study. 2 Years (72 units)
- Applicants must normally hold an approved bachelor degree or
equivalent qualifcations from an approved tertiary institution.
The Master of Laws (International Law and International Relations)
is a coursework and research program delivered fully online and
offered by the Flinders Law School in conjunction with the School
of History and International Relations. It is designed to provide
students with the opportunity to learn online and readily engage
with the person leading the learning while also interacting with
fellow students. Students will have access to interactive activities
and online group discussions which will expand their international
law and intentional relations skills into areas such as energy and
environmental security, human security, international relations in
the Asia/Pacific, causes and conduct of conflict and post-conflict
mechanisms.

STUDY PROGRAM
Topics studied may include:
> Approaches to International Relations
> Principles of Public International Law
> Research Paper International Law/International Relations

CAREER OUTCOMES
This course will equip you with the academic qualifications
necessary to a seek employment in government service in areas
of foreign affairs, international diplomacy, law, defence, foreign aid
and trade. It may also qualify you for positions with international
bodies and non-government organisations involved with the
implementation of international law (including international criminal
law), human rights advocacy, international relations including
humanitarian assistance, aid distribution and other associated
work auxiliary to government.

This course offers a great deal of choice and every attempt is
made to meet each candidate’s interests and learning needs.
This is a specialised course for social workers, nurses, teachers,
counsellors and other professionals who wish to gain the specific
skills and knowledge required to assist people suffering loss, grief
or trauma.

STUDY PROGRAM
Topics you may study include:
> Bereavement and Loss
> Interventions in Situations of Trauma
> Professional Practice Project

CAREER OUTCOMES
Potential future roles include community services project officer,
case manager, school counsellor, mental health nurse, social
research officer and youth pathways officer. Graduates of this
course are employed in governmental departments, hospitals,
health and community centres, correctional services, schools, and
welfare agencies.

FURTHER STUDY
Students accepted into Master of Social Work normally receive
4.5 units (one topic) of credit if successfully completed within the
Graduate Certificate.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/gclgtc
CRICOS Code: 036367E

FURTHER STUDY

Students who complete the 18-unit research project in the
Masters degree may be eligible to apply for entry into a PhD.

These courses articulate with the Master of Language Studies.

FURTHER COURSE INFORMATION >>>

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/lawilir

flinders.edu.au/courses/postgrad/lt

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.

CRICOS Code: Online only

CRICOS Code: External only
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MARITIME ARCHAEOLOGY

MATHEMATICS

MEDICINE

MIDWIFERY

Graduate Certificate in Maritime Archaeology; Graduate Diploma in
Maritime Archaeology; Master of Maritime Archaeology

Master of Science (Mathematics)

Doctor of Medicine

Graduate Diploma in Midwifery; Master of Midwifery (Coursework),
Master of Midwifery (Coursework and Research)

>

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Certificate:
AUD$13,400*
Graduate Diploma:
AUD$26,800
Masters:
AUD$26,800
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

* External fee is 10% less than stated fee.
Entry requirements: Graduate Certificate: An approved
bachelor degree or equivalent. Graduate Diploma: An approved
degree or equivalent qualification majoring in archaeology from
an approved tertiary institution, or the Graduate Certificate in
Maritime Archaeology Masters: An approved bachelor degree or
equivalent in archaeology or related discipline from an approved
tertiary institution with a GPA of 5.6 in upper level topics in the
major sequence in archaeology or closely related discipline;
or a Graduate Certificate/Diploma in Maritime Archaeology or
equivalent from an approved tertiary institution with a GPA of
5.6; or an approved Class 2A honours degree in archaeology or
a closely related discipline from an approved tertiary institution.
Note: Field school topic taught during the summer break.

The Graduate Program in Maritime Archaeology is the largest,
most successful and most active program of its kind in Australia,
and is rated as one of the top six programs of its kind in the world.
The graduate program is designed both to meet the needs of
students who have a degree in archaeology, maritime archaeology
or anthropology who wish to specialise in maritime archaeology,
as well as those who come from a different academic background
(such as history) and want to move to a different career path.

STUDY PROGRAM
Some of the topics offered may include:
> Maritime Archaeology in Australia
> The Archaeology of Seafaring
> Maritime Archaeology Field School

CAREER OUTCOMES
Career opportunities in underwater archaeology are steadily
growing. Potential roles include a conservation officer, museum/
gallery curator, museum education officer, higher education
lecturer, tourism officer, archivist and cartographer. Potential
employers include independent archaeological consultants,
heritage agencies, museums, academic institutions, the public
service, wildlife services and sanctuaries.

FURTHER STUDY
The Graduate Certificate in Maritime Archaeology articulates with
the Graduate Diploma in Maritime Archaeology and the Master of
Maritime Archaeology.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ma
CRICOS Code: Graduate Certificate – External only.
Graduate Diploma – 046437B. Masters – 075592F

>

Course length:
2 years full-time*

>

2018 fee:
AUD$33,000

>

Course length:
4 years full-time

>

2018 fee:
AUD$65,500

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Intake:
Semester 1

>

English requirements:
IELTS: 7 (S7 • W7 • R7 • L7)
PTE: 65^ (see pg 85)

* Students with a Bachelors degree in the same discipline may be
eligible for a 1.5 year full-time program.
Entry requirements: Applicants must normally hold an approved
Bachelor’s degree or equivalent in Mathematics or Statistics or a
closely related discipline from an approved institution. Applicants
with an approved degree that contains substantial mathematics
or statistics (up to second year level) are also eligible to apply.
The Faculty Board may, under certain circumstances and subject
to specific conditions, admit others who can show evidence of
fitness for candidature. The Master of Science is not available to
students who hold an Honours degree in the same discipline.

The Master of Science (Mathematics) is designed for students
with a mathematics or statistics degree or with a strong degree
containing a substantial amount of mathematics, such as a
mathematics major in a science or engineering degree. It builds on
your existing mathematical, statistical, research and professional
skills. The coursework has been designed to address topical
concerns in industry and society, preparing you for further
enrolment in a research degree or employment in one of the many
fields actively seeking mathematicians and statisticians.
The course is offered at Flinders’ new Tonsley Campus, a
state-of-the-art, 18,000 square metre facility that is at the heart
of South Australia’s industrial future. Flinders is part of this
exciting new collaborative and high-value industry, education and
residential precinct at Tonsley – and serves as a remarkable site
for experiential learning, social innovation and inspiration. Flinders
at Tonsley is a place where students interact with business,
and where business interacts with researchers in the areas of
engineering, medical devices and nanoscale technologies to make
the new products and processes of the 21st century.

Note: As per Australian Government regulations, courses that have
a placement involving contact with children, young people and/or
vulnerable adults, will require students to undergo an Offender History
Record Check and to comply with the School’s Policy on Immunisation
and Blood Borne Viruses prior to placement.

Intake:
Semester 1 • Semester 2

>

English requirement:
IELTS:
6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

Entry requirements: You must hold a midwifery degree or
equivalent, be a registered midwife, and hold a current practising
certificate in your country of residence.

Graduate Diploma and Masters (Coursework) topics may include:
> Introduction to Research
> Epidemiology and Population Studies for Health Care Practice

This course provides students with specialist knowledge that can
be applied in a range of employment areas, such as business
and finance, data science, environment, health, insurance and
logistics.

Upon graduation, you must complete a year as a hospital intern to
qualify for medical registration with the Medical Board of Australia.
After internship and a possible further year in a training position,
you can then apply to undertake specialist training with a medical
college. In addition to clinical practice in a wide range of medical
specialties, medical graduates may work in research, public health
or community aid around the world, or in health administration.

The School of Nursing and Midwifery at Flinders University
has a strong commitment to excellence in midwifery education,
practice and research with expert and experienced academics
to support this commitment. This includes developing strong
links with the profession in metropolitan, rural and remote areas
locally, nationally and internationally. Midwifery programs and
curricula reflect the philosophy that midwifery is a profession in its
own right, that midwives provide woman-centred care during the
childbirth experience, that this experience is viewed as a normal
life event and that care must be woman-centred and focused on
wellness and underpinned by the principles of primary health care.
The philosophy of the Australian College of Midwives has been
considered and embraced in developing all teaching programs.

STUDY PROGRAM

Masters (Coursework and Research) topics may include:
> Approaches to Research Designs
> Developing a Literature Review

CAREER OUTCOMES

This course has a specific application deadline. Please contact
the International Centre at internationalapply@flinders.edu.au
for more information.

Graduates will be able to work in leadership roles and contribute
to the development of the profession by advancing midwifery
knowledge and practice research, promoting excellence in
midwifery practice, developing inter-disciplinary and interorganisational partnerships and promoting woman centred
care through a primary health care approach. Graduates have
extensive midwifery career opportunities in community or hospital
clinical practice, research, education or management roles.
Potential roles include antenatal education facilitator/midwife,
clinical midwife, clinical midwife consultant, community midwife,
and research project officer. Please note, the postgraduate
Midwifery courses do not lead to registration as a Registered
Midwife.

FURTHER COURSE INFORMATION >>>

FURTHER COURSE INFORMATION >>>

flinders.edu.au/medicine/courses/medical-course/
medical-course-home.cfm

flinders.edu.au/courses/postgrad/mmid

CRICOS code: 077675J
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>

STUDY PROGRAM

CAREER OUTCOMES

CRICOS code: 083454E

2018 fee:
Graduate Diploma:
AUD$31,300
Masters:
AUD$31,300

The course aims to provide the opportunity for registered
midwives to deepen their knowledge and skills in midwifery and
prepare them for an expanded practice role in an innovative
program of study. This course will not lead to registration as a
midwife.

CAREER OUTCOMES

flinders.edu.au/courses/postgrad/scmaths

>

Medicine is one of the most rapidly changing fields of human
endeavour. This is both a challenge and a source of satisfaction
for medical graduates, who must commit to lifelong learning to
stay abreast of new developments in their profession. Research
is extending the boundaries of our understanding of health and
disease, creating new possibilities for prevention, treatment and
care. Community expectations of doctors and the healthcare
system are changing, and new ethical debates and social
challenges constantly emerge. The Flinders medical program aims
to develop those elements of knowledge, understanding and skill
central to varied areas of medical practice, producing graduates
well prepared to act as hospital interns and with the potential to
follow a full range of medical specialties in subsequent training.
Flinders has a strong profile in medicine both nationally and
internationally, and continues to be at the forefront of innovation
in teaching and research. We set new standards for student
placements and are leaders in the field of rural and remote health.
Please refer to course website for the most up to date information
on the Flinders medical program: flinders.edu.au/medicine/
courses/medical-course/medical-course-home.cfm

The course has flexibility to allow you to choose topics that both
complement and extend your undergraduate studies. Depending
on the results received either a Masters Project or Masters Thesis
will be undertaken in the final two semesters.

FURTHER COURSE INFORMATION >>>

Course length:
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

Entry requirements: For all prerequisites and entry requirements
please refer to: flinders.edu.au/MD/Int

The program focuses on student-centred learning with
longitudinal development of the knowledge, skills and personal
and professional attributes required of a doctor. Themes covered
in first year include the knowledge of health and illness, the
doctor and patient (including clinical and communication skills),
ethics, law, the humanity of medicine, and developing expertise in
research.

STUDY PROGRAM

>

CRICOS Code: Graduate Diploma – 071426G.
Masters – 028951M

63

NANOTECHNOLOGY

NURSING (ACUTE CARE)

NURSING (GLOBAL HEALTH CARE)

NURSING (PRIMARY HEALTH CARE)

Graduate Diploma in Nanotechnology; Master of Nanotechnology

Graduate Diploma in Nursing (Acute Care), Master of Nursing (Acute Care)

Graduate Diploma in Nursing (Global Health Care), Master of Nursing
(Global Health Care)

Graduate Diploma in Nursing (Primary Health Care), Master of Nursing (Primary
Health Care)

>

Course length:
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

2018 fee:
Graduate Diploma:
AUD$33,000
Masters:
AUD$33,000

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent in any
relevant discipline of science or engineering from an approved
institution. Examples of relevant disciplines include but are not
limited to chemistry, physics, materials engineering, chemical
engineering or biotechnology. The Faculty Board may, under
certain circumstances and subject to specific conditions, admit
others who can show evidence of fitness for candidature.
Nanotechnology is science at the molecular level. It is a term
that embraces a wide spectrum of technological endeavours
across a range of scientific and technological disciplines, such
as chemistry, physics, engineering and biological and biomedical
sciences. It is also attracting tremendous attention in industrialised
countries worldwide both in terms of fundamental scientific
research and technological development. The primary aim of
this suite of degrees is to facilitate skills transfer from another
relevant area of engineering, science or technology to the study of
nanotechnology.

>

Course length:
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

2018 fee:
Graduate Diploma:
AUD$31,300
Masters:
AUD$31,300

>

Course length:
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

2018 fee:
Graduate Diploma:
AUD$31,300
Masters:
AUD$31,300

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

Entry requirements: Graduate Diploma and Masters: you must
hold an approved degree or equivalent qualifications, and be a
registered nurse. However, the Faculty Board may, under certain
circumstances and subject to specific conditions, admit others
who can show evidence of fitness for candidature.

The Acute Care Nursing specialisation is specifically designed
for international post graduate students. It aims to facilitate
the development of specialised knowledge and skills to enable
application and critical analysis of concepts and theories relating
to the recognition, response and management and care of the
acute, complex and/or critically ill deteriorating patient in a range
of acute health care settings.

The Global Health Care specialisation provides the opportunity for
health professionals anywhere in the world to develop and apply
advanced knowledge, skills and attributes related to nursing and
midwifery in a global context.

STUDY PROGRAM
The Graduate Diploma in Nanotechnology provides a
comprehensive coverage of the fundamental knowledge and skills
in the core areas of nanotechnology.

This will enable students to contextualise care in Australia and
exchange information about nursing practices in their country
of origin.

The Master of Nanotechnology covers fundamental knowledge
and skills in core areas and subsequently extends this via
advanced study of selected areas. Project work is a key part
of the Masters degree, which is designed to develop research
and problem solving skills. At the core of the second year is
an extended research project in which the knowledge and
skills gained in the first year are applied to a specific problem.
The project will also equip you with expert skills in advanced
experimental tools in the area of nanotechnology which will further
enhance your employment prospects in the industry.

CAREER OUTCOMES
Whatever the environment, commercial or research, employment
opportunities will be at the cutting edge of technology. Potential
occupations include nanofabrication technologist, nanomaterial
scientist, nanomaterials business manager, nanosystems scientist,
production supervisor, research officer and technical officer.
Graduates of this specialisation may find research-based careers.

FURTHER STUDY
The Graduate Diploma in Nanotechnology articulates with
the Master of Nanotechnology.

In an increasingly connected world with growing demand for health
services in developing countries, the time is right for you to step up
and into the global health care arena.
Take the next step in your nursing career to develop the skills and
knowledge to transform your nursing work for an international
workforce. In a multicultural Australia, everything you learn will also
help you become a contemporary nursing leader.

STUDY PROGRAM
Three study pathways are available: Leading Quality and Safety,
International Health Care and Learning and Teaching.

STUDY PROGRAM

Topics studied in the pathways may include:

Topics studied may include:

> Global Perspectives on Policy and Political Contexts
of Health Care
> Quality and Safety: A Global Health Approach
> Measuring Health Service Outcomes
> Health and Sustainable Development
> International Strategies and Programs in Health Care
> Enhancing the Learner Experience
> Planning for Learning: Curriculum Development

> Prevention of Cardiovascular Disease
> Managing High Acuity Surgical Care
> Managing High Acuity Medical Care
> Acute Care Observational PEP
> Contemporary Issues in Paediatric Nursing
> Critical Care Nursing Theory
> Acute Mental Health Nursing Theory
> Principles of Emergency Nursing

CAREER OUTCOMES
Graduates are suitable for careers in a wide range of nursingrelated fields. Our courses will give registered nurses the
opportunity to provide specialised care to individuals across the
lifespan in a range of acute care settings. They will be able to
make an impact in their field by taking on leadership roles in a
variety of clinical nursing settings. Potential occupations include
case coordinator, clinical nurse specialist, injury management
officer, mental health nurse, nurse research assistant, registered
nurse and rehabilitation consultant.

FURTHER COURSE INFORMATION >>>

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/nt

flinders.edu.au/courses/postgrad/ngac

CRICOS Code: Graduate Diploma – 057869J.
Masters – 057870E

CRICOS Code: Graduate Diploma – 088942D. Master –
088943C.

Course length:
Graduate Diploma:
1 year full-time
Masters: 1.5 years full-time

>

Intake:
Semester 1 • Semester 2

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

Entry requirements: You must hold a nursing degree or
equivalent and must be a registered nurse. In addition, applicants
must provide a supporting statement nominating their area
of clinical preference for university sourced observational
professional experience placement.

You can select topics from a range of specialisations including
cardiac care, critical care, high dependency and emergency
nursing, paediatric and mental health nursing. Students have the
opportunity to undertake an observational professional experience
placement (PEP) in a South Australian acute care setting.

>

CAREER OUTCOMES
Graduates are suitable for careers in a wide range of international
health care settings including developing policy for practice,
the teaching and learning environment, hospital administration
and quality process in Australia and overseas and international
strategies and programs in health care.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/nginthlth
CRICOS Code: Graduate Diploma – 088950D, Master –
088951C

>

2018 fee:
Graduate Diploma:
AUD$31,300
Masters:
AUD$31,300

>

English requirements:
IELTS:
6.5 (S6 • W6 • R6 • L6)

PTE: 58* (see pg 85)

Entry requirements: You must normally hold an approved degree
or equivalent qualification and must be a registered nurse in
a country other than Australia. In addition, you must provide a
supporting statement nominating your area of clinical preference
for university sourced observational professional experience
placement. However, the Board may, under certain circumstances
and subject to specific conditions, admit others who can show
evidence of fitness for candidature.
The Primary Health Care (Nursing) specialisation is specifically
designed for international postgraduate students. It aims to facilitate
the development of specialised knowledge of the constructs and
contexts of working with individuals, groups, families and communities
within a broad primary health care framework.
You can select topics from a range of specialisations including
aged care, child and family health nursing, diabetes management
and education, general practice and community nursing. Uniquely,
students also have the opportunity to undertake an observational
professional experience placement (PEP) in a South Australian
primary health care setting.
This will enable you to contextualise care in Australia and exchange
information about nursing practices in their country of origin.

STUDY PROGRAM
Topics studied in the pathways may include:
> Primary Health Care Constructs and Contexts
> Social Context of Health and Ageing
> Introduction to Working with Infants, Children and Families
> Health Management for Infants, Children and Young People
> Diabetes Management
> Community and Primary Health Care Nursing
> Observational Professional Experience Placement

CAREER OUTCOMES
Graduates are suitable for careers in a wide range of nursing-related
fields. Our courses will give registered nurses the opportunity to
provide skillful care to individuals, families and communities to
prevent illness, promote healthy lifestyles and manage a range
of emerging complex health issues. They will be able to take on
leadership and specialised care roles in a variety of clinical nursing
settings. Potential occupations include case coordinator, clinical
nurse specialist, health promotion nurse, community health nurse,
injury management officer, mental health nurse, nurse research
assistant, registered nurse and rehabilitation consultant. A nursing
career could encompass: schools, scientific research, home health
services, rehabilitation, extended care, drug and alcohol services,
family and child health and public environmental health.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ngphc
CRICOS Code: Graduate Diploma – 088948J,
Master – 088949G
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65

NURSING (COURSEWORK AND
RESEARCH)

NUTRITION AND DIETETICS

OCCUPATIONAL THERAPY

ORGANISATIONAL LEARNING

Master of Nutrition and Dietetics

Master of Occupational Therapy

Graduate Certificate in Organisational Learning

Master of Nursing (Coursework and Research)
>

Course length:
1.5 years full-time

>

2018 fee:
AUD$31,300

>

Course length:
2 years full-time

>

2018 fee:
AUD$35,200

>

Course length:
2 years full-time

>

2018 fee:
AUD$35,200

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

>

Intake:
Semester 1

>

English requirements:
IELTS:

>

Intake:
Semester 1

>

English requirements:
IELTS:

>

Opportunity for
industry experience

>

Opportunity for
industry experience

>

Professional accreditation

>

Professional accreditation

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

Entry requirements: Applicants must normally hold an approved
degree or equivalent qualification and must be registered nurses.
Applicants for this pathway will be required to provide a brief
statement (research proposal) regarding the area of research
they would like to undertake. Research proposals are subject to
Course Coordinator approval and the School’s ability to provide
suitable research supervision to students depending on their
proposed research topic. Under certain circumstances and
subject to specific conditions, the Board may admit others who
can show evidence of fitness for candidature.
This course aims to provide advanced studies in nursing practice
and research to prepare nurses to contribute to the present
and future development of health care services and the nursing
profession.
In addition to developing specialist nursing skills and
competencies, you will have the opportunity to conduct research
in an area of interest with the support of individualised supervision
from the School of Nursing & Midwifery.
Throughout the program, you will be introduced to the drivers
for research within industry and the broader community; learn to
identify and apply appropriate research paradigms and methods,
and develop sound project management skills.
You will become competent at reviewing, critiquing and
synthesising literature to support their research and will develop
skills for completion and submission of research grant proposals
for ethical approval and funding applications.
Successful completion of the program through submission of
an (18 unit) minor thesis prepares students for higher degree
research studies (PhD) and/or research in the clinical setting.

STUDY PROGRAM
Topics studied may include:
> Introduction to Research
> Developing a Literature Review
> Approaches to Research Designs
> Writing Research Proposals for Ethical and
Funding Requirements

CAREER OUTCOMES
The Master of Nursing (Coursework and Research) will open a
new door on your health career. Potential graduate outcomes
include working as a clinical nursing specialist, healthcare
researcher, educator, manager or policy leader. Offered by the
School of Nursing & Midwifery, this program enables you to gain
specialist skills whilst undertaking a research project. It also has
the potential to lead to a PhD.

FURTHER COURSE INFORMATION >>>

66

7 (S6.5 • W6.5 • R6.5 • L6.5)
PTE: 65* (see pg 85)

Entry requirements: Approved bachelor degree or equivalent
with a credit average, which includes, 40% of undergraduate
topics in human nutrition and food science, at second year level,
at least 25% of a full-time load of biochemistry topics and 15%
of a full-time load of physiology topics.
Note: As per Australian Government regulations, courses that have
a placement involving contact with children, young people and/or
vulnerable adults, will require students to undergo an Offender History
Record Check prior to placement.

The Master of Nutrition and Dietetics offers advanced studies in
nutrition and dietetics, the patho-physiology of nutrition related
illnesses, health promotion, communication skills and clinical,
community and public health nutrition skills. The aim is to train
nutritionists and dietitians who are able to integrate and apply their
knowledge, skills and attributes to the promotion of health and the
prevention and treatment of illness by optimising the nutrition of
communities and individuals.
Industry experience: Students will undertake a clinical
placement.
Professional accreditation: The course equips graduates
to meet the entry level competency standards specified by
the Australian professional accrediting body, the Dietitians
Association of Australia (DAA).

STUDY PROGRAM
Topics you may study include:
> The Nutrition Care Process
> Food Service and Professional Practice
> Research Methods and Critical Thinking in Human Nutrition
> Communication and Nutrition Counselling
> Clinical Nutrition and Dietetics

CAREER OUTCOMES
Potential roles include clinical dietitian, community health worker,
nutritionist, health promotion officer and research project officer.
Employment opportunities are plentiful across a variety of settings
including hospitals, community health centres, private practice
and consultancy, food industries, and research institutions.
This course has a specific application deadline. Please contact
the International Centre at internationalapply@flinders.edu.au
for more information.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mnd
CRICOS Code: 002655M

7 (S6.5 • W6.5 • R6.5 • L6.5)
PTE: 65* (see pg 85)

Entry requirements: Applicants must normally hold an
approved degree with a GPA of no less than 5.0, or an
equivalent qualification; and have either completed the Bachelor
of Health Sciences (Principles of Occupational Therapy) at
Flinders University OR demonstrated that they have completed
the following pre-requisite topics: the equivalent of 9 units of
study focussed on an understanding of body structures and
function such as human biology, physiology and anatomy
including detailed musculoskeletal anatomy with an emphasis
on the upper limb; the equivalent of 4.5 units of study focussed
on an understanding of the human and social environment and
social perspectives in health such as psychology and sociology;
the equivalent of 4.5 units study of research methods; and the
equivalent of 4.5 units of study in communication skills.
This course aims to prepare students for professional practice as
occupational therapists (OT). Graduates will be able to practice
across a range of settings, including rural and remote areas.
Emphasis will be placed on preparing a contemporary health
professional able to be client-centred and to work effectively within
an interdisciplinary team. Close partnerships with clinical agencies
ensure supported placement experiences.
Industry experience: Students undertake 1050 hours of clinical
placement in accordance with the accreditation standards of the
Occupational Therapy Council of Australia.
Professional accreditation: This course has been developed
to meet the Occupational Therapy Council’s Accreditation
Standards (2012) and also the requirements of the World
Federation of Occupational Therapy in regard to occupational
therapy programs. The Master of Occupational Therapy has
fulfilled the requirements for entry level education of occupational
therapists and has been awarded the status of Accredited
Occupational Therapy Course by Occupational Therapy Australia
and the World Federation of Occupational Therapists.

STUDY PROGRAM
Topics you may study include:
> The Occupational Therapy Process
> Occupational Science
> Occupational Therapy Evaluation and Practice 1
> Information and Technology in Occupational Therapy

CAREER OUTCOMES
Prospective employers include State government departments
such as health, disability and education. Non-government
organisations who employ occupational therapists includes large
agencies such as Novita, private hospitals, aged care providers,
schools and private rehabilitation companies.

>

Course length:
6 months full-time

>

2018 fee:
AUD$13,100

>

Intake:
Semester 1* • Semester 2**

>

>

Opportunity for industry
experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

*External only. **Internal only.
Entry requirements: Bachelor degree or equivalent and a
minimum of two years relevant work experience.
The Graduate Certificate in Organisational Learning is designed
for professionals who aim to build the human capital of their
organisations to achieve its mission and strategic goals. It is of
direct relevance to those individuals in leadership positions and
human resources/organisational development roles. The Graduate
Certificate in Organisational Learning seeks to provide students
with the ability to analyse the existing learning and knowledge
context for their own organisation; formulate strategies to develop
and improve the organisational learning in their workplace; and
harness organisational and individual knowledge to achieve
strategic goals.
Industry experience: Students may have the opportunity to
undertake an internship.

STUDY PROGRAM
Topics you may study include:
> Knowledge Management for Organisational Learning
> Evaluation Methods
> Action Learning Project/Internship
> Leaders and Leadership
> Managing Innovation in Organisations
> Critical Systems: Thinking and Practice

CAREER OUTCOMES
Graduates can go on to further their careers in roles such
as knowledge managers, human resource managers, school
principals, university administrators, and line managers with a
strong focus in human resource and organisational development.

FURTHER STUDY
The Graduate Certificate in Organisational Learning can be taken
as a standalone course, or can be articulated into one of a range
of highly regarded Flinders University masters programs including
the Master of Education or Master of Public Administration.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/gcol
CRICOS Code: 055238A

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/ngcr

flinders.edu.au/courses/postgrad/mot

CRICOS Code: 088952B

CRICOS Code: 090620D
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PALLIATIVE CARE

PALLIATIVE CARE IN AGED CARE

PARAMEDIC SCIENCE

PHYSICS

Graduate Certificate in Palliative Care; Graduate Diploma in Palliative
Care; Master of Palliative Care

Graduate Diploma in Palliative Care in Aged Care;
Master of Palliative Care in Aged Care

Master of Paramedic Science

Master of Science (Physics)

>

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

Intake:
Graduate Certificate:
Semester 2
Graduate Diploma,
Masters: Semester 1 •
Semester 2

>

2018 fee:
Graduate Certificate:
AUD$15,250
Graduate Diploma:
AUD$30,500
Masters:
AUD$30,500
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Must hold an approved Bachelor degree
or equivalent from an approved tertiary institution. Graduate
Certificate: must meet the above requirements and have no less
than one year clinical experience in health care. Graduate Diploma
and Masters: must meet the above requirements and have no less
than two years’ clinical experience in health care.
The Palliative Care program provides an opportunity for
professionals from any health discipline to deepen their
knowledge base in palliative care within a global context. The
programs aim to develop independent critical thinkers who will
be able to contribute to the appraisal, assessment and problemsolving required of a multidisciplinary/multi-professional team.

STUDY PROGRAM
Topics studied may include:
> Communication at the End of Life
> Oncology for Palliative Care
> Issues in the Care of the Spirit in Palliative Care
> Palliative Care in Aged Care Settings
> Palliative Clinical Management
> Suffering, Futility and Ethics in Palliative Care
> Understanding Cancer
> Design and Ethics in Research with Vulnerable Populations
Master of Palliative Care students:
> Independent Inquiry for Evidence-Based Practice

CAREER OUTCOMES
Palliative care has an increasingly significant focus on
development at local and national levels within multiple healthcare
settings including hospitals, nursing homes and community
care. Organisations require practitioners with the specialist skills
and attitudes provided by this course, whether experienced
practitioners or graduates with basic palliative care skills.
Graduates find careers in areas ranging from rural and remote
acute/community/aged care settings to palliative care units and
hospice care.

FURTHER STUDY
The sequentially developed topics allow progression through
these awards.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ppc
CRICOS Code: Graduate Certificate in Palliative Care –
072249A. Graduate Diploma in Palliative Care – 051998D.
Master of Palliative Care – 024776J
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>

>

Course length:
Graduate Diploma:
1 year full-time
Masters:
1.5 years full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Diploma:
AUD$30,500
Masters:
AUD$30,500

>

Course length:
2 years full-time

>

Intake:
Semester 1

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Must hold an approved Bachelor degree
or equivalent from an approved tertiary institution. Graduate
Certificate: must meet the above requirements and have no
less than one year clinical experience in health care. Graduate
Diploma and Masters: must meet the above requirements and
have no less than two years clinical experience in health care.
The Palliative Care in Aged Care programs are designed
to provide education for practitioners with backgrounds in
gerontology, aged care or palliative care who are involved in policy,
planning, or the delivery of palliative care services to older people
in a range of aged care settings. The programs introduce the
basic skills and principles of palliative care within a broader study
of ageing, which includes an examination of different views of
ageing and the concepts of ageing and dying in a global context.

STUDY PROGRAM
Topics studied may include:
> Introduction to Social Gerontology
> Communication at the End of Life
> Understanding Literature for Evidence-Based Practice
> Palliative Care in Aged Care Settings
> Introduction to Clinical Gerontology
> Psychological Dimensions of Ageing
> Healthy Ageing (Mental Health)
> Medication and Ageing
> Best Practice in Dementia Care
> Design and Ethics in Research with Vulnerable Populations

CAREER OUTCOMES
Palliative care in aged care has an increasingly significant focus on
development at local and national levels within multiple healthcare
settings including hospitals, nursing homes, community care and
hospices. These courses are designed to provide professional
development, planning and delivery of palliative care services to
older people in a range of aged care settings. Graduates can find
careers in areas ranging from governmental agencies, rural and
remote acute/community/aged care settings to palliative care
units and hospice care.

>

>

2018 fee:
Graduate Diploma: 		
AUD$29,600
Masters:
AUD$29,600

Course length:
2 years full-time*

>

2018 fee:
AUD$33,000

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Applicants must hold either a Bachelor of
Paramedic Science or an equivalent degree, or possess a formal
vocational ambulance qualification which permits authority to
practice at a paramedical level. A minimum of two years industry
experience as a practicing paramedic is required.
The Faculty Board may, under certain circumstances and subject
to specific conditions, admit others who can show evidence of
fitness of candidature.
The Master of Paramedic Science will build upon the Intensive
Care Paramedic knowledge and add additional knowledge to
support practice at extended care level or alternatively (depending
upon the stream) industrial paramedic.

STUDY PROGRAM
First year topics include:
> Principles of Industrial Health Practice
> Principles of Extended Care Paramedic Practice
> Advanced Health Care Assessment and Diagnosis
> Advanced Primary Health Care for Paramedics 1
> Advanced Primary Health Care for Paramedics 2
> Research Project
> Research Thesis

CAREER OUTCOMES
The intensive care course equips paramedics with the knowledge
required to support intensive care practice. This Masters course
builds upon the intensive care course equipping paramedics with
knowledge to support practice as an extended care paramedic, an
industrial paramedic or for a research career.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/paramedst
CRICOS Code: 088779K

>

*Students with a Bachelors degree in the same discipline may be
eligible for a 1.5 year full-time program.
Entry requirements: Applicants must normally hold an approved
Bachelor’s degree or equivalent with a major in Physics or
a closely related discipline from an approved institution. A
knowledge of at least second year physics and mathematics is
assumed. The Faculty Board may, under certain circumstances
and subject to specific conditions, admit others who can show
evidence of fitness for candidature. The Masters of Science is not
available to students who hold an Honours degree in the same
discipline.
The Master of Science (Physics) is designed for students with
a physics-rich background. The course builds on a student’s
existing physics, research and professional skills.
The Masters award provides graduates with not only the practical
and theoretical aspects of physics, but also an understanding
of professional and ethical responsibilities and an awareness of
social, economic, cultural and environmental aspects of physics
in a global community. Projects and coursework have been
designed to address topical concerns in industry and society,
preparing graduates for employment in a physics-related field or
further enrolment in a research higher degree.
A masters thesis is normally taken in the final two semesters of
study and develops research, communication and technical skills.
An in-depth investigation of a particular area is completed under
the guidance of a supervisor and students can opt to research
advanced areas within the discipline.

STUDY PROGRAM
The topics involve both course work and research components
with core topics focussing on professional studies. These
include nuclear and quantum physics and standards, ethics and
compliance. In addition to the core topics, students can choose
electives including partial differential equations, methods of
applied mathematics and complex analysis.

CAREER OUTCOMES
Career options exist in areas such as optics, telecommunications,
instrumentation development, acoustics, research and
development laboratories and geophysics.

FURTHER STUDY

FURTHER COURSE INFORMATION >>>

The sequentially developed topics allow progression through
these awards.

flinders.edu.au/courses/postgrad/scphy
CRICOS code: 083454E

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ppcac
CRICOS Code: Graduate Diploma – 072485M. Masters –
072486K
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PHYSIOTHERAPY

PRIMARY HEALTH CARE

PSYCHOLOGY

PUBLIC ADMINISTRATION

Master of Physiotherapy

Graduate Certificate in Primary Health Care in Developing Countries

Master of Psychology (Clinical)

Graduate Certificate in Public Policy; Graduate Certificate in Public Sector
Management; Graduate Diploma in Public Administration; Master of Public
Administration; Master of Public Administration (Management); Master of
Public Administration (Policy)

>

Course length:
2 years full-time

>

2018 fee:
AUD$37,300

>

Course length:
6 months full-time

>

2018 fee:
AUD$15,250

>

Course length:
2 years full-time

>

2018 fee:
AUD$31,600

>

Intake:
Semester 1

>

English requirements:
IELTS:

>

Intake:
Semester 1

>

>

Intake:
Semester 1

>

English requirements:
IELTS:

>

Opportunity for
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

>

Opportunity for
industry experience

>

Professional accreditation

>

Professional accreditation

7 (S6.5 • W6.5 • R6.5 • L6.5)
PTE: 65* (see pg 85)

Entry requirements: Bachelor degree or equivalent from an approved
tertiary institution with a GPA of no less than 5.0, or an equivalent
qualification. For further entry requirements and pre-requisites refer to
flinders.edu.au/courses/postgrad/mpt

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.

This program in Primary Health Care has been designed for health
professionals seeking specialist qualifications with vocational
Police check: Students will be required to complete a National Police Check
relevance. The aim is to enhance their knowledge and skills
prior to undertaking any placement.
in ways that enable them to better plan, develop, manage and
Student registration: The Health Practitioner Regulation National Law (South
Australia) Act 2010 requires students undertaking clinical training to be
evaluate initiatives and programs to promote health and prevent
registered with the relevant national board via the Australian Health Practitioner diseases. The Graduate Certificate aims to provide students with
Regulation Agency (AHPRA). The law requires all students in this program to
the knowledge and skills to incorporate the principles of primary
be registered with the Physiotherapy Board of Australia, and for this registration
health care in order to reduce the inequalities in health care
to be maintained throughout the duration of the course. You will be provided
access and health outcomes. This course articulates with the
with further information about this upon commencing the course.
Master of Public Health.
This is an entry-level qualification designed to enable graduates
to register and practice as a Physiotherapist. Applicants who are
overseas trained physiotherapists and are eligible to apply for Australian
registration by the Australian Physiotherapy Council are encouraged
to seek advice before submitting an application for this course.
Physiotherapists work to develop, maintain and restore movement and
functional ability throughout the lifespan. They work in settings across
both public health and private practice. The physiotherapy profession
has well established research and evidence-based practice, which you
will analyse and apply in this course. Physiotherapists are in demand
across the health sector and this outlook is projected to continue. Our
teaching is embedded with clinical settings in South Australia and has
links with industry to best prepare you for professional practice as a
physiotherapist. Emphasis is placed on preparing you to become a
contemporary health professional who is able to work effectively across
a range of setting and locations.
Industry experience: Includes 26 weeks of clinical placement.
Professional accreditation: The Master of Physiotherapy is
accredited by the Australian Physiotherapy Council, and satisfies the
academic requirements for registration as a physiotherapist with the
Physiotherapy Board of Australia.

STUDY PROGRAM
First year topics may include:
> Musculoskeletal Practice 1 and 2
> Performance of Movement and Function
> Cardiorespiratory Practice

Topics undertaken as part of Primary Health Care in Developing
Countries may include:
> Social Determinants of Health and Wellbeing
> Primary Health Care Practice in Developing Countries

CAREER OUTCOMES
Students graduate fully equipped with the knowledge and skills
required to incorporate the principles of primary health care into
specific fields of practice. Graduates typically gain employment in
areas promoting health and disease prevention, improving health
care access and outcomes in both developing and developed
countries. Graduates can go on to gain employment in a number
of fields and settings including government departments and nongovernment agencies internationally.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/gcphcdc
CRICOS Code: 073815A

Entry requirements: Applicants must hold an honours degree
at high 2A level or better in psychology.
This course aims to prepare you for professional work in a wide
variety of settings, ranging across community mental health,
hospital and health care facilities, community welfare, and
correctional service settings. It provides you with theoretical
knowledge, research and clinical skills leading to professional
registration. Experience is provided in both adult and child
domains of clinical psychology.
Industry experience: Students complete clinical placements as
part of their program.
Professional accreditation: Meets the requirements for general
registration as a psychologist with the Psychology Board of
Australia and membership of the Australian Psychological Society
(APS).

STUDY PROGRAM
The Master of Psychology (Clinical) is made up of coursework,
supervised practica and a research project. Some of the topics
may include:
> Cognitive Behaviour Therapy
> Clinical Child Psychology
> Psychological Assessment
> Research Methods

CAREER OUTCOMES
Graduates of the Master of Psychology (Clinical) meet the
requirements for registration as a Psychologist and are suitable for
careers in a wide variety of mental health service settings. Many
people with existing careers in human services such as nursing,
teaching, the public service, social work and human resources
undertake this course to better understand human behaviour and
to add depth to their knowledge and work skills.
The Master of Psychology (Clinical) has a specific application
deadline. Please contact the International Centre at
internationalapply@flinders.edu.au for more information.

CAREER OUTCOMES

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/psc

flinders.edu.au/courses/postgrad/mpt
CRICOS Code: 079421D

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

2018 fee:
Graduate Certificate:
AUD$14,700
Graduate Diploma:
AUD$29,400
Masters:
AUD$29,400

>

Intake:
Semester 1 • Semester 2

>

>

Opportunity for
industry experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

7 (S7 • W7 • R7 • L7)
PTE: 65^ (see pg 85)

Physiotherapists work in a wide variety of settings including
hospitals, community health centres, Aged Care Facilities, mental
health services, rehabilitation centres, sports clinics and fitness
centres, government departments, and schools and universities.
Physiotherapists can also work in managerial and research positions.
Opportunities also exist to become self-employed in private practice
or to work part-time. This course has a specific application deadline.
Please contact the International Centre at internationalapply@
flinders.edu.au for more information.

FURTHER COURSE INFORMATION >>>
70

STUDY PROGRAM

>

CRICOS Code: Masters – 051844M

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.
Note: Graduate Certificate in Public Sector Management: Some topics
are taught in Online and intensive delivery modes. The MPA Online is
delivered in four, 10 week study periods throughout the year.
Flinders University is proud to be one of the first universities in Australia
to deliver a Master of Public Policy and Management entirely online.

This articulated program comprises coursework awards at the
Graduate Certificate, Graduate Diploma and Masters level.
It provides opportunities for current and aspiring public and
non-government managers and policy makers to enhance
their understanding, knowledge and skills through a mixture of
compulsory and elective topics as well as individual research.
Specialisations are available in: Development Administration,
Public Administration, Policy and Management
Industry experience: Graduate Diploma and Masters students
have the opportunity to undertake an internship.

STUDY PROGRAM
Some of the topics studied as part of these programs may include:
> Contemporary Cases in Public Policy
> Contemporary Public Policy: Theoretical Perspectives
> Ethics in Public Administration
> Governance and Public Policy

CAREER OUTCOMES
Graduates are suitable for careers in management or
administrative roles in public or non-government organisations.
Key jobs that exist in the public administration sector include
community development worker, operational officer, administrative
officer, policy researcher, tax inspector, tourism officer, trading
standards officer and policy development officer.

FURTHER STUDY
This program articulates with sequentially developed topics that
allow progression through the awards.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/pa
CRICOS Code: Graduate Certificate in Public Policy – 053050G.
Graduate Certificate in Public Sector Management – 024781A.
Graduate Diploma in Public Administration – 051988F. Master of
Public Administration – 051989E. Master of Public Administration
(Management) – 051990A. Master of Public Administration (Policy) –
051991M
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PUBLIC HEALTH

RESEARCH METHODS

SCREEN AND MEDIA PRODUCTION

SOCIAL WORK

Graduate Certificate in Health Promotion; Graduate Certificate in Public
Health; Master of Public Health

Graduate Diploma in Research Methods

Graduate Certificate in Screen and Media Production; Graduate Diploma in
Screen and Media Production; Master of Screen and Media Production

Master of Social Work

>

>

Course length:
Graduate Certificate
in Health Promotion:
6 months full-time
Graduate Certificate in
Public Health:
6 months full-time		
Masters:
1.5 years full-time

>

Graduate Certificate in
Health Promotion:
Semester 1
Graduate Certificate in
Public Health:
Semester 1
Masters:
Semester 1 • Semester 2

>

2018 fee:
Graduate Certificate in
Health Promotion:
AUD$15,250
Graduate Certificate in
Public Health:
AUD$15,250
Masters:
AUD$30,500
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Graduate Certificate: Bachelor degree
or equivalent. Masters: Bachelor degree in a related field.
Applicants for the Health Service Management stream must
have at least four years approved work experience in the health
sector.
The Discipline of Public Health provides a range of courses that
encourage students to explore and redefine public health practice
in light of contemporary knowledge in order to promote health.
The courses are founded on a commitment to the advancement of
quality and integrity in multidisciplinary practice, and principles of
equity, inclusiveness, accountability and community participation.
The courses create opportunities for practitioners to examine
workplace issues and to formulate new ways of addressing them
and putting them into practice. The teaching and learning focuses
primarily on helping practitioners change their practice in light
of new insights. Topic assignments may be related to workplace
issues and problems.
Masters specialisations include: cancer prevention, primary
health care, public health, public health research, public health
epidemiology, public health nutrition, health service management,
chronic condition management.

STUDY PROGRAM
Topics studied may include:
> Action on Social Determinants of Health
> Social Determinants of Health and Wellbeing
> Critical Practice in Indigenous Health

CAREER OUTCOMES
Public health has become an increasingly significant focus of
government plans worldwide, initiating developments at local and
national levels within multiple healthcare settings. Graduates are
expected to progress into employment in public health policy,
management and practice. Potential roles include public health
officer, nutrition advisor, public health senior consultant, health
promotion planning and evaluation officer, health information
officer and health and safety manager.
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>

Course length:
1 year full-time

>

Intake:
Semester 1 • Semester 2

>

2018 fee:
Graduate Diploma:
AUD$26,800		

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Applicants must normally hold an approved
degree or equivalent qualification from an approved tertiary
institution and have achieved a grade point average of 5.00 or
greater. Under exceptional circumstances and subject to specific
conditions, the Faculty Board may admit others who can show
evidence of fitness for candidature. This course is unavailable
for the School of Psychology due to accreditation and topic
prerequisites.

This unique course provides students with high-level knowledge
and skills in research methods as a pathway towards further
learning at research higher degree level.
Students may choose to exit from the Graduate Diploma
in Research Methods with the exit award of the Graduate
Certificate in Research Methods, provided that they have met the
requirements for that award.
The Graduate Diploma in Research Methods is designed to
provide you with high-level knowledge of and skills in research
methods and the opportunity to develop further depth and breadth
of knowledge in your area of study as a pathway to research higher
degree study (conditions apply).
It includes a substantial 18-unit research thesis/project, which
provides the eligibility required to apply for various scholarship
opportunities and entry into a research higher degree (conditions
apply).

STUDY PROGRAM
This course can be pursued in most disciplines of the university
(with the exception of Psychology).

CAREER OUTCOMES
Graduates are suitable for careers in areas such as the
government sector, private or corporate consulting sectors and
research institutions.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/rules/postgrad/gdprm.cfm
CRICOS Code: Graduate Diploma – 088512D

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters: 2 years full-time
Masters Advanced:
1 year or 1.5 years full-time

>

Intake:
Semester 1

>

Opportunity for industry
experience

>

>

2018 fee:
Graduate Certificate:
AUD$13,400
Graduate Diploma:
AUD$26,800
Masters:
AUD$26,800
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Graduate Certificate and Graduate
Diploma: Must normally hold an approved bachelor degree or
equivalent qualification from an approved tertiary institution.
Masters (2 years): An approved bachelor degree in any
discipline; Masters Advanced (1.5 years): An approved bachelor
degree in Screen and Media, an honours degree in any
discipline; or a Graduate Certificate in Screen and Media, or
a related discipline; Masters Advanced (1 year): the Graduate
Diploma in Screen and Media Production or an honours degree
in Screen and Media Production
The Screen and Media Production program provides you with an
understanding of screen and media production and post-production
skills; research and writing skills in screen studies; and a practical
understanding of professional activities in a related field of study. In
addition, the Master of Screen and Media Production provides you with
in-depth knowledge of a specific area of screen production, obtained
through a combination of coursework and research; vocational
knowledge and skills in the fields of screen studies; and increased
specialisation within a systematic and coherent body of knowledge
relating to documentary film-making, digital media and screen studies.

Course length:
2 years full-time

>

2018 fee:
AUD$28,100

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

>

Opportunity for
industry experience

>

Professional accreditation

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

Entry requirements: There are two points of entry into the
Master of Social Work: 1. Applicants who have completed a
bachelor’s degree are eligible to apply for entry to the Master of
Social Work (Graduate Entry). 2. Applicants who have completed
a Bachelor of Social Work degree recognised by the Australian
Association of Social Work (AASW) or equivalent are eligible
to apply for entry to the Master of Social Work (Qualified Social
Worker Entry). Applicants for the MSW (Qualified) must have
completed either (a) an AASW-accredited Bachelor of Social
Work Honours or (b) an AASW-accredited Bachelor of Social
Work plus at least 2 years professional work experience (paid or
volunteer) or equivalent.
Note: Some topics are taught in intensive delivery mode. As per
Australian Government regulations, courses that have a placement
involving contact with children, young people and/or vulnerable adults
will require students to undergo an Offender History Record Check prior
to placement.

The Master of Social Work is a coursework program designed
to provide a higher degree coursework masters award following
a bachelor degree. The Master of Social Work is available via
Qualified Social Worker Entry or Graduate Entry.

Industry experience: Students will undertake two field
placements totalling 500 hours each and there are opportunities
Industry experience: Students have the opportunity to undertake a for overseas placements. These placements are designed to
provide students with learning opportunities in a range of practice
practicum.
settings, with varied practice methodologies and different client
groups.

STUDY PROGRAM

Topics taken may include:
> Production
> Post-Production
> Minor Project
> Research and Writing
> Documentary Camera
> Major Project Script and Pre-Production
> Non-fiction Form and Ethics
> 3D Animation and the Screen

CAREER OUTCOMES
This articulated course is intended to provide skills and knowledge
to enter a range of professional roles including presenter, broadcast
monitor, filmmaker, content strategist, creative writer, media advisor,
multimedia researcher, production coordinator and video journalist.
Employment opportunities exist in a varied range of sectors including
in the public service (for example, media and public affairs units),
community groups, industry, education media, film and TV production
companies, publishers, advertising, and arts organisations.

FURTHER COURSE INFORMATION >>>

FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/gchp
flinders.edu.au/courses/postgrad/mph

flinders.edu.au/courses/postgrad/screenmedia

CRICOS Code: Graduate Certificate in Health Promotion –
073816M. Graduate Certificate in Public Health - 094009B.
Masters – 020926K

>

CRICOS Code: Graduate Certificate – 071843B.
Graduate Diploma – 071844A. Masters – 071845M; Masters
Advanced 1 year – 085903B; Masters Advanced 1.5 years –
085904A

Professional accreditation: Master of Social Work graduates are
eligible for membership with the Australian Association of Social
Workers (AASW). Students must have completed an accredited
degree and also meet the AASW English language requirements.

STUDY PROGRAM
Topics you may study include:
> Social Work with Diverse Populations
> Complexities in Work with Children and Families
> Mental Health through the Life Course
> Trauma and Resilience

CAREER OUTCOMES
Graduates can go on to secure positions in a variety of settings
within a framework of relevant legislation and procedures,
supporting individuals, families, and groups within the community.
Potential roles include community services project officer, case
manager, advocacy worker, mental health worker, social research
officer and youth pathways project officer. Social workers are
employed in governmental departments, hospitals, health and
community centres, correctional services and welfare agencies.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/msw
CRICOS Code: 019222G
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SPEECH PATHOLOGY

TEACHING

Master of Speech Pathology

Master of Teaching (Early Childhood); Master of Teaching (Primary R-7);
Master of Teaching (Secondary); Master of Teaching (Special Education)

>

Course length:
2 years full-time

>

2018 fee:
AUD$39,200

>

Course length:
2 years full-time

>

2018 fee:
AUD$26,200

>

Intake:
Semester 1

>

English requirements:
IELTS:

>

Intake:
Semester 1

>

English requirements:
IELTS:

>

Opportunity for
industry experience

>

Opportunity for
industry experience

>

Professional accreditation

>

Professional accreditation

7 (S6.5 • W6.5 • R6.5 • L6.5)
PTE: 65* (see pg 85)

Entry requirements: Approved bachelor degree with a minimum
of credit average. No specific undergraduate degree is required
for admission. Admission will be based on the combined
scores from a structured interview (may be by Skype) and
the applicant’s best GPA from a previous bachelor degree or
equivalent.
Note: A limited number of places are available. Some topics are taught
in intensive delivery mode. As per Australian Government regulations,
courses that have a placement involving contact with children, young
people and/or vulnerable adults will require students to undergo an
Offender History Record Check prior to placement.

Speech pathologists provide professional services for persons
across the lifespan whose educational, vocational, personal and
social functioning is impaired by disorders of speech, language,
voice, swallowing, fluency and hearing. Communication and
swallowing disabilities may severely impact people’s quality of life
and result from developmental difficulties, social disadvantage,
illness or accident. Our award winning teaching staff work closely
with the speech pathology profession to ensure that our graduates
are well equipped to enter this diverse and interesting profession.
This coursework program uses an innovative, inquiry-based
curriculum, incorporating a problem-based learning format.
Industry experience: You will undertake extensive clinical
experience throughout the course, commencing in the first 5
weeks of the program. Placements may be in Adelaide, country
areas of South Australia or the Northern Territory, and in some
circumstances, overseas.
Professional accreditation: Graduates will meet the entry-level
standards of Speech Pathology Australia (SPA), the national
accrediting body, which will enable them to practise in Australia and
many other countries around the world including the UK and Asia.

STUDY PROGRAM
Topics studied as part of this program include:
> Professional Studies and Communication Sciences
> Speech Pathology Skills and Practice
> Research Methods

CAREER OUTCOMES
Speech pathology graduates are employed in a wide range of settings
and work with people of all ages, their carers/families, services,
communities and other professionals across a wide variety of agencies.
These include schools, hospitals, aged care services, universities, early
childhood services, rehabilitation centres, community health centres,
private practice and mental health services.
This course has a specific application deadline. Please contact
the International Centre at internationalapply@flinders.edu.au
for more information.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mspp
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> TEACHING (CONTINUED)

CRICOS Code: 054304D

7.5 (S7.5 • W7.5 • R7.5 • L7.5)

PTE: 73* (see pg 85)

Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution. In addition, admission is by quota,
based on academic merit and a Pass average or better is
required. Some courses also have additional or alternative entry
requirements. Check the website for details.
Note: As per Australian Government regulations, courses that have
a placement involving contact with children, young people and/or
vulnerable adults will require students to undergo a Child-Related
Employment Screening prior to placement. Applicants offered a
place in the Master of Teaching (Early Childhood) or in the Master
of Teaching (Special Education) must apply for their screening
immediately in order to be ready for placement in Semester 1. The
process is managed by the Department for Communities and Social
Inclusion (DCSI) Screening Unit. Applications can only be made to
DCSI via Australia Post. More information and a partially completed
form is available at flinders.edu.au/ehl/education/professionalexperience/preparation-for-placement/obtain.cfm. Please
complete each section of the Child-Related Employment Screening
form in full, otherwise your application will be returned and you will
experience a delay in obtaining your screening clearance.

Flinders University’s postgraduate programs in Teaching offer core
topics in education studies, curriculum studies, and professional
experience as well as professional placements.
Early Childhood is designed to prepare early childhood
educators (birth to age eight). You will be provided with the
background and skills necessary for early childhood teaching. The
course includes education studies and curriculum studies.
Industry experience: Professional experience and placements in
early childhood centres/schools.
Primary R-7 is offered to graduates who wish to teach at
the primary school level. The course provides you with the
background necessary to apply for registration as a Primary
R-7 teacher and includes education studies, curriculum studies,
professional experience and placements in schools.

Graduate Certificate in TESOL; Graduate Diploma in TESOL; Master of
TESOL; Master of Arts (TESOL)

STUDY PROGRAM
Early Childhood topics may include:

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters: 2 years full-time
Master of Arts:
2 years full-time

>

2018 fee:
Graduate Certificate:
AUD$13,100
Graduate Diploma:
AUD$26,200*
Masters: AUD$26,200*
Master of Arts: 		
AUD$26,200*

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS:

Primary R-7 topics may include:
> Teaching In and Through the Expressive Arts
> Researching Learners and Learning
> Introduction to Teaching and Research in the Education 		
Profession
> Thinking and Working Scientifically in the Primary Years
Secondary topics may include:
> Curriculum Studies: Developing Curriculum in Context in the
Middle Years
> Understanding Curriculum Development
> Professional Issues in Secondary Education
> Literacies for the Middle and Secondary Years
Special Education topics may include:
> Interventions for students with literacy difficulties
> Teaching In and Through the Expressive Arts
> Supporting Positive Behaviour in Schools
> Assessment in Education
Professional accreditation: Graduates will be provided with
an academic qualification that will enable them to apply for
registration with the Teachers Registration Board of South
Australia, interstate and some overseas countries (exact
requirements may vary).

CAREER OUTCOMES
Master of Teaching (Early Childhood/ Primary R-7/Secondary/
Special Education) prepares graduates to enter the teaching
profession with confidence and competence. Graduates are
suitable for careers as teachers in early childhood centres, primary
schools and secondary schools, and as special education teachers.
Although the majority of education graduates go on to employment
as a teacher in the public or private sector, some choose to follow
other pathways. Graduate roles include community education
officer, and education and engagement officer.

FURTHER STUDY
Graduates can pursue further study by undertaking a Doctor of
Education.

The Secondary stream is offered to graduates who wish to
teach in secondary schools. The course provides you with the
background necessary to apply for registration as a secondary
school teacher. Topics covered during the two years include
specialist curriculum studies and a number of topics devoted to
issues in education.

FURTHER COURSE INFORMATION >>>

Special Education programs at Flinders are designed for those
who wish to teach students in regular classroom settings as well
as students with special education needs in secondary or special
settings. They combine studies in primary or secondary education
with studies in special education. Included are curriculum studies
and special education studies.

>

> Making Meaning in the Expressive Arts
> The Numerate and Literate Infant
> Thinking and Working Scientifically in the Early Years
> Pedagogies of Belonging

Industry experience: The course includes extensive professional
experience.

Industry experience: The course includes extensive
professional experience.

TEACHING ENGLISH AS A SECOND
LANGUAGE (TESOL)

flinders.edu.au/courses/postgrad/mtec
flinders.edu.au/courses/postgrad/mtjp
flinders.edu.au/courses/postgrad/mts
flinders.edu.au/courses/postgrad/mtse
CRICOS Code: Early Childhood – 063695J. Primary R-7
– 063696G. Secondary – 063697G. Special Education –
063698F

6.5 (S6 • W6 • R6 • L6)
PTE: 58* (see pg 85)

* External fee is 10% less than stated fee.
Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.
Note: Some option topics at Masters level taught in intensive delivery mode

These courses are aimed at the development of skills in the area of
Teaching English as a Second Language (TESOL). They are also
designed to facilitate the development of disciplinary knowledge
in the area of second language acquisition, as well as specific
knowledge in the area of TESOL. The combination of theoretical
knowledge and teaching methodology equips prospective TESOL
practitioners with tools for classroom practice. The flexibility of
delivery of the four topics in the Graduate Certificate in Teaching
English as a Second Language will cater for graduates who do
not have a formal teaching qualification and wish to teach English
as a second language; qualified teachers who require specialised
knowledge in TESOL; or qualified teachers of other subjects
which are taught using English as the language of instruction.

STUDY PROGRAM
Topics studied may include:
> Second Language Learning and Teaching
> Second Language Testing
> Introduction to English Linguistics
> TESOL Methodology
> English as a Global Language
> Directed Studies in TESOL
> Cross-cultural Pragmatics and Intercultural Communication

CAREER OUTCOMES
With the internationalisation of the job market, graduates with
a qualification in a foreign language teaching will have greater
employment opportunities. Graduates are suitable for careers
teaching English at private language colleges, schools, or
university language centres (subject to employer requirements).
Potential roles include English language teacher, assistant
language teacher, communications specialist, immigration officer,
international student advisor, interpreter, linguist, multicultural
service officer, translator and travel consultant.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/tesl
CRICOS Code: Graduate Certificate – 053051F. Graduate
Diploma – 062068M. Masters – 060015G. Master of Arts –
060014G

Industry experience: The course includes extensive
professional experience.
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THEOLOGICAL STUDIES

TOURISM

WATER RESOURCES MANAGEMENT

Graduate Certificate in Theological Studies; Graduate Diploma in
Theological Studies; Master of Theological Studies

Graduate Diploma in Tourism; Master of Tourism

Graduate Certificate in Science (Water Resources Management);
Graduate Diploma in Science (Water Resources Management); Master of
Science (Water Resources Management)

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters: 2 years full-time

>

Intake:
Semester 1 • Semester 2

>

>

2018 fee:
Graduate Certificate:
AUD$13,400*
Graduate Diploma:
AUD$26,800*
Masters:
AUD$26,800*
English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

* External fee is 10% less than stated fee.
Entry requirements: Bachelor degree or equivalent from an
approved tertiary institution.
Note: Offered at Adelaide College of Divinity, Brooklyn Park,
South Australia.

This course is designed to provide a sound understanding
of contemporary theology and biblical studies and to provide
opportunities to reflect on theological dimensions of professional
and social life. The course is suitable for professionals in the field
of religion or related disciplines, and people with a general interest
in religion. The Graduate Diploma of Theological Studies expands
a student’s investigation of a range of theological and biblical
studies. The Master of Theological Studies offers students the
opportunity to extend their knowledge and skills in a particular
area of theological study and to undertake a research project on a
theme of relevance to their own professional work.

STUDY PROGRAM
Topics undertaken as part of this program may include:
> Theology of Jesus Christ
> Interpreting the Old Testament
> Introduction to Christian Thought
> Biblican Hermeneutics
> Interpreting the New Testament

CAREER OUTCOMES
Theology graduates work in a variety of different roles in many
employment sectors. Graduates are suitable for careers as
teachers of religious education and other professional positions
in the field of religion. Potential roles include higher education
lecturer, primary school teacher or secondary school teacher,
social researcher, youth worker, charity officer and international
aid/development worker. Potential employers include public and
private sector organisations, universities, financial firms, legal
organisations and government agencies employ graduates in
administration, financial and general management positions.
Libraries, charities, television companies and publishing houses
also employ theology graduates in different roles.

>

Course length:
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

2018 fee:
Graduate Diploma:
AUD$26,800
Masters:
AUD$26,800

>

Intake:
Semester 1

>

>

Opportunity for industry
experience

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Graduate Diploma: Bachelor degree or
equivalent with a major in Tourism or related discipline. Masters:
Bachelor degree or equivalent qualification in Tourism, Hospitality
or a related discipline from an approved tertiary institution with
a GPA of 5.0 in upper level topics; or a Graduate Diploma in
Tourism, or equivalent qualification from an approved tertiary
institution, with a GPA of 5.0; or an honours degree in Tourism or
a closely related discipline from an approved tertiary institution.
Note: Some topics are taught in intensive delivery mode.

This course provides you with a broad understanding of tourism,
both in Australia and worldwide; enables you to implement
research concepts to examine the arts, culture and heritage of
a place; and allows you to benefit from our strong links to the
tourism industry and industry-focused core topics.
Industry experience: Industry based practicum and research.

STUDY PROGRAM
Topics you may study as part of the Tourism stream include
those related to tourism management, site interpretation and
research skills.

CAREER OUTCOMES
Potential roles include business development manager, cultural
tourism officer, events and sponsorship manager, corporate
groups consultant and tourism marketing. Graduates are suitable
for careers in areas such as market planning, advertising and
promotion, brochure production and tour planning. Employers
include travel agencies, airlines, convention/exhibition centres and
government.

FURTHER COURSE INFORMATION >>>

>

Course length:
Graduate Certificate:
6 months full-time
Graduate Diploma:
1 year full-time
Masters:
2 years full-time

>

2018 fee:
Graduate Certificate:
AUD$16,500
Graduate Diploma:
AUD$33,000
Masters:
AUD$33,000

>

Intake:
Semester 1 • Semester 2

>

English requirements:
IELTS: 6 (S6 • W6)
PTE: 50* (see pg 85)

Entry requirements: Bachelor degree or equivalent in a
relevant discipline of science and engineering, from an approved
tertiary institution.
These programs aim to train students to understand the scientific
problems involved with the management of water. Our Water
Resources Management programs are designed to meet the
needs of students from different scientific disciplines and provide
real flexibility both in terms of content and modes of delivery. The
program offers a number of streams which can be blended to
produce either a degree of significant depth or a much broader
program with generalised understanding of a wide range of water
resources management subjects.
We train you to apply management fundamentals to solve current
problems and to anticipate, mitigate and prevent future problems
in the area of water resources management.
Masters students have the opportunity to undertake a major
research project or a minor research project combined with an
industry placement.

STUDY PROGRAM
Topics undertaken may include:
> Fundamentals of Groundwater
> Ecohydrology
> Public Health Aspects of Water Quality
> Geographical Information Systems
> Project Management
(Please note, some topics are only offered externally. Students are
encouraged to check visa requirements and compliance before
enrolling in external topics.)

flinders.edu.au/courses/postgrad/tr

CAREER OUTCOMES

CRICOS Code:
Graduate Diploma – 059257K. Masters – 059258J.

Graduates of these programs will be equipped for employment
with government departments; engineering, environmental and
water management consultancies; water management bodies;
local government; aid organisations; commercial organisations;
and agricultural organisations.

FURTHER COURSE INFORMATION >>>

FURTHER STUDY

flinders.edu.au/courses/postgrad/wrm

The Graduate Certificate in Theological Studies articulates with
the Graduate Diploma in Theological Studies and the Master of
Theological Studies.

CRICOS Code: Graduate Certificate – 079417M. Graduate
Diploma – 079418K. Masters – 079419J

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ths
CRICOS Code: Graduate Certificate – 048611K. Graduate
Diploma – 043146D. Masters – 014823A
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COURSE
DURATION

INTAKE
SEMESTER 1/2

OVERALL

SPEAKING

WRITING

READING

LISTENING

OVERALL

SPEAKING

WRITING

READING

LISTENING

CAMBRIDGE
ADVANCED CAE

PEARSON
OVERALL

•

•

72

18

18

•

•

B2

50*

PEARSON
OVERALL

6

CAMBRIDGE
ADVANCED CAE

6

LISTENING

6

READING

S1/S2

WRITING

2

SPEAKING

29,900

OVERALL

073345D

LISTENING

2018
FEE
(AUD)

READING

CRICOS

36

Master of Accounting

064258M

30,700

2

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

43

36

Master of Accounting and Finance

089466G

30,700

2

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

DIGITAL PRODUCTION FOR ENTERTAINMENT DESIGN

CRICOS

PGPG

PG

ACCOUNTING

IELTS (ACADEMIC)

TOEFL (INTERNET)

COMPUTER SCIENCE

ARCHAEOLOGY & HERITAGE MANAGEMENT

Master of Science (Computer Science)

44

Graduate Certificate in Digital Production for
Entertainment Design

085898E

13,400

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

Master of Digital Production for Entertainment
Design

085901D

26,800

2

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

37

Graduate Certificate in Archaeology

external

13,400

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

37

Graduate Diploma in Archaeology and
Heritage Management

080523K

26,800

1

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

44

37

Master of Archaeology and Heritage
Management

080524J

26,800

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

DISASTER HEALTH CARE
44

Graduate Certificate in Disaster Health Care

external

15,250

0.5

S1

6.5

6

6

6

6

80

18

18

18

18

C

58*

37

Master of Archaeology and Heritage
Management (Advanced)

085900E

26,800

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

44

Graduate Diploma in Disaster Health Care

external

30,500

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

44

Master of Disaster Health Care

external

30,500

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

069209B

14,050

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

027987G

15,250

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

AQUACULTURE
37

Graduate Certificate in Science (Aquaculture)

082816C

16,500

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

37

Graduate Diploma in Science (Aquaculture)

082817B

33,000

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

37

Master of Science (Aquaculture)

082818A

33,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

AUDIOLOGY
38

Master of Audiology

027824D

41,200

2

S1

6.5

6

6

6

6

80

18

18

18

18

C

58*

BIOTECHNOLOGY

DEVELOPMENT ADMINISTRATION
45

Graduate Certificate in Development
Administration

DISABILITY STUDIES
45

Graduate Certificate in Disability Studies

45

Master of Disability Policy and Practice

085325J

30,500

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

45

Master of Disability Policy and Practice
(Advanced Program)

085326G

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

38

Graduate Certificate in Biotechnology

038768E

16,400

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

38

Graduate Diploma in Biotechnology

057077G

32,800

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

EDUCATION

38

Master of Biotechnology Studies

043767G

32,800

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate in Education

023586A

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education

085902C

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education

002648K

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate in Education (Cognitive
Psychology and Educational Practice)

external

13,100

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Cognitive Psychology and
Educational Practice)

091851C

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Cognitive Psychology and
Educational Practice)

059360M

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Gifted Education)

091853A

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Gifted Education)

053055B

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate in Education (Higher
Education)

external

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Higher Education)

external

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Higher Education)

external

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate in Education (International
Baccalaureate Middle Years)

external

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (International
Baccalaureate)

091854M

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (International
Baccalaureate)

091850D

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate of Education (Languages
Education)

external

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Languages Education)

091860B

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Languages Education)

091859F

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate in Education (Leadership
and Management)

058441G

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Leadership and
Management)

091855K

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Leadership and
Management)

002617F

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Educational Research
Evaluation and Assessment)

091852B

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Educational Research
Evaluation and Assessment)

053056A

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

BUSINESS
39

Master of Business

085302E

30,700

2

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

BUSINESS ADMINISTRATION
39

Graduate Certificate in Business Administration

028943M

15,900

0.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

39

Graduate Diploma in Business Administration

028947G

31,800

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

39

Master of Business Administration

071846K

31,800

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

002646A

33,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

41

Graduate Certificate in Chronic Condition
Management

external

15,250

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

41

Graduate Diploma in Chronic Condition
Management

external

30,500

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

CHEMISTRY
40

Master of Science (Chemistry)

CHRONIC CONDITION MANAGEMENT

41

Master of Public Health (Chronic Condition
Management)

020926K

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

CLINICAL EDUCATION
41

Graduate Certificate in Clinical Education

external

15,250

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

41

Graduate Diploma in Clinical Education

external

30,500

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

41

Master of Clinical Education

external

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

CLINICAL REHABILITATION
42

Graduate Certificate in Clinical Rehabilitation

055067D

15,250

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

42

Graduate Diploma in Clinical Rehabilitation

060408A

30,500

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

42

Master of Clinical Rehabilitation

060409M

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

COGNITIVE BEHAVIOUR THERAPY

78

2018 POSTGRADUATE
COURSE INDEX

WRITING

TOEFL (INTERNET)

SPEAKING

IELTS (ACADEMIC)

ENGLISH REQUIREMENTS

OVERALL

2018
FEE
(AUD)

INTAKE
SEMESTER 1/2

2018 POSTGRADUATE
COURSE INDEX

COURSE
DURATION

ENGLISH REQUIREMENTS

42

Graduate Certificate in Cognitive Behaviour
Therapy

088939K

42

Graduate Diploma in Cognitive Behaviour
Therapy

088940F

42

Master of Cognitive Behaviour Therapy

088941E

For notes on entry requirements, please see pg 85

15,250
30,500
30,500

0.5
1
2

S1/S2
S1/S2
S1/S2

7
7
7

7
7
7

7
7
7

7
7
7

7
7
7

96
96
96

24
24
24

24
24
24

24
24
24

24
24
24

C
C
C

65^
65^
65^

For notes on entry requirements, please see pg 85

79

18

•

•

B2

50*

GROUNDWATER HYDROLOGY

46

Master of Education (Special Education)

091856J

26,200

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

55

46

Master of Education (Special Education)

053058K

26,200

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate in Education (Vision
Impairment)

external

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate of Education (Gifted
Education)

external

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Graduate Certificate of Education (Wellbeing
and Positive Mental Health)

external

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

46

Master of Education (Wellbeing and Positive
Mental Health)

091858G

46

Master of Education (Wellbeing and Positive
Mental Health)

091857G

26,200

2

S1/S2

6

6

6

•

•

72

18

18
18

•
•

•
•

B2
B2

PEARSON
OVERALL

PEARSON
OVERALL

18

18

CAMBRIDGE
ADVANCED CAE

CAMBRIDGE
ADVANCED CAE

72

72

LISTENING

LISTENING

•

•

READING

READING

•

•

WRITING

WRITING

6

6

SPEAKING

SPEAKING

6

6

OVERALL

OVERALL

6

6

LISTENING

LISTENING

S1

S1/S2

READING

READING

0.5

1.5

2018
FEE
(AUD)

WRITING

WRITING

13,100

26,200

CRICOS

SPEAKING

SPEAKING

053134C

TOEFL (INTERNET)

OVERALL

OVERALL

46

Graduate Certificate in Education (Special
Education)

PG

IELTS (ACADEMIC)

INTAKE
SEMESTER 1/2

2018
FEE
(AUD)

2018 POSTGRADUATE
COURSE INDEX

COURSE
DURATION

CRICOS

INTAKE
SEMESTER 1/2

ENGLISH REQUIREMENTS

COURSE
DURATION

ENGLISH REQUIREMENTS

Graduate Certificate in Science (Groundwater
Hydrology)

047375C

16,500

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

55

Graduate Diploma in Science (Groundwater
Hydrology)

047376B

33,000

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

55

Master of Science (Groundwater Hydrology)

047377A

33,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

2018 POSTGRADUATE
COURSE INDEX
PG

50*
50*

IELTS (ACADEMIC)

TOEFL (INTERNET)

HEALTH ADMINISTRATION
56

Graduate Diploma in Health Administration

023592C

30,500

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

56

Master of Health Administration

011341K

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

56

Master of Science (Health Administration)

023594A

30,500

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

051002J

30,500

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

HEALTH AND INTERNATIONAL DEVELOPMENT
56

Master of Health and International Development

ENGINEERING

INFORMATION TECHNOLOGY

48

Master of Engineering (Biomedical)

055942K

33,600

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

57

Graduate Diploma in Information Technology

038638D

29,900

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

49

Master of Engineering (Civil)

091861A

33,600

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

57

Master of Information Technology

038636F

29,900

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

49

Master of Engineering (Electronics)

061252G

33,600

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

INNOVATION AND ENTERPRISE

50

Master of Engineering (Materials)

088514B

33,600

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

ENGINEERING SCIENCE
50

Graduate Diploma in Engineering Science

077361E

33,600

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

51

Master of Engineering Science
(Specialisations)

094010J

33,600

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

ENVIRONMENTAL HEALTH
52

Graduate Diploma in Environmental Health
Practice

52

Master of Environmental Health

58

Graduate Certificate in Innovation and
Enterprise

092885G

15,350

0.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

58

Graduate Diploma in Innovation and Enterprise

092886F

30,700

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

043147C

14,050

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

INTERNATIONAL DEVELOPMENT
58

Graduate Certificate in International
Development

58

Graduate Diploma in International Development

028948F

28,100

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

58

Master of Arts (International Development)

079415B

28,100

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

Master of International Development

079414C

28,100

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

045233M

14,050

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

external

31,000

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

080526G

31,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

58

52

Graduate Certificate in Environmental
Management

039965C

15,500

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

59

Graduate Certificate in International Relations

59

Graduate Diploma in International Relations

045234K

28,100

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

52

Graduate Diploma in Environmental
Management

039964D

31,000

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

59

Master of Arts (International Relations)

020923B

28,100

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

52

Master of Environmental Management

030806B

31,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

online

28,800

3

S1/S2

7

7

7

7

7

96

24

24

24

24

C

65^

064989J

26,800

2

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

Graduate Certificate in Language Teaching

online

13,100

1
(PT)

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

Graduate Diploma in Language Teaching

online

26,200

2-3
(PT)

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

INTERNATIONAL RELATIONS

ENVIRONMENTAL MANAGEMENT

JURIS DOCTOR
59

GENDER, DEVELOPMENT AND WOMEN’S STUDIES

Juris Doctor

53

Graduate Diploma in Gender and Development

028944K

28,100

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

LANGUAGE STUDIES

53

Master of Arts (Women’s Studies)

008136G

28,100

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

60

LANGUAGE TEACHING

GENDER MAINSTREAMING POLICY AND ANALYSIS
53

Graduate Certificate in Gender Mainstreaming
Policy and Analysis

external

14,050

1
(PT)

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

GERONTOLOGY
54

Graduate Certificate in Applied Gerontology

Master of Language Studies

60
60

external

15,250

1
(PT)

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

LAWS
61

Master of Laws (International Law &
International Relations)

external

28,800

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

61

Master of Laws (International Law &
International Relations)

external

28,800

2

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

036367E

14,050

0.5

S2

6

6

6

•

•

72

18

18

•

•

B2

50*

external

13,400

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

54

Graduate Diploma in Applied Gerontology

072483B

30,500

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

54

Master of Applied Gerontology

072484A

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

GEOSPATIAL INFORMATION SCIENCE (GIS)
54

Graduate Certificate in Geographical
Information Systems

064259K

15,500

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

LOSS, GRIEF AND TRAUMA COUNSELLING

54

Graduate Diploma in Geographical Information
Systems

064260F

31,000

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

61

54

Master of Geospatial Information Science

079420E

31,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

online

13,250

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

GLOBAL POINT-OF-CARE TESTING
55

Graduate Certificate in Global Point-of-Care
Testing

Graduate Certificate in Loss, Grief and Trauma
Counselling

MARITIME ARCHAEOLOGY
62

Graduate Certificate in Maritime Archaeology

62

Graduate Diploma in Maritime Archaeology

046437B

26,800

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

62

Master of Maritime Archaeology

075592F

26,800

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

083454E

33,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

MATHEMATICS
62

80

For notes on entry requirements, please see pg 85

Master of Science (Mathematics)

For notes on entry requirements, please see pg 85

81

24

24

C

65^

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

26,800

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

2018
FEE
(AUD)

15,250

IELTS (ACADEMIC)

TOEFL (INTERNET)

PUBLIC HEALTH

MIDWIFERY
63

Graduate Diploma in Midwifery

071426G

31,300

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

63

Master of Midwifery

028951M

31,300

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

NANOTECHNOLOGY

72

Graduate Certificate in Health Promotion

073816M

72

Graduate Certificate in Public Health

094009B

15,250

72

Master of Public Health

020926K

30,500

088512D

RESEARCH METHODS
72

64

Graduate Diploma in Nanotechnology

057869J

33,000

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

64

Master of Nanotechnology

057870E

33,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

NURSING

Graduate Diploma in Research Methods

SCREEN AND MEDIA PRODUCTION
73

Graduate Certificate in Screen and Media
Production

071843B

13,400

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

1

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

64

Graduate Diploma in Nursing (Acute Care )

088942D

31,300

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

73

Graduate Diploma in Screen and Media
Production

071844A

26,800

64

Master of Nursing (Acute Care)

088943C

31,300

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

73

Master of Screen and Media Production

071845M

26,800

2

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

65

Graduate Diploma in Nursing (Global Health
Care)

088950D

31,300

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

73

Master of Screen and Media Production
(Advanced)

085904A

26,800

1.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

65

Master of Nursing (Global Health Care)

088951C

31,300

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

1

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

65

31,300

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

Master of Screen and Media Production
(Advanced)

26,800

088948J

73

085903B

Graduate Diploma in Nursing (Primary Health
Care)

65

Master of Nursing (Primary Health Care)

088949G

31,300

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

019222G

28,100

2

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

66

Master of Nursing (Coursework and Research)

088952B

31,300

1.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

054304D

39,200

2

S1

7

6.5

6.5

6.5

6.5

94

22

22

22

22

C

65*

NUTRITION AND DIETETICS
66

Master of Nutrition and Dietetics

67

Master of Occupational Therapy

002655M

35,200

2

S1

7

6.5

6.5

6.5

6.5

94

22

22

22

22

C

65*

090620D

35,200

2

S1

7

6.5

6.5

6.5

6.5

94

22

22

22

22

C

65*

ORGANISATIONAL LEARNING
67

Graduate Certificate in Organisational Learning

SOCIAL WORK
73

055238A

13,100

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

PALLIATIVE CARE

Master of Social Work

SPEECH PATHOLOGY
74

OCCUPATIONAL THERAPY

Master of Speech Pathology

TEACHING
74

Master of Teaching (Early Childhood)

063695J

26,200

2

S1

7.5

7.5

7.5

7.5

7.5

108

27

27

27

27

B

73*

74

Master of Teaching (Primary R-7)

063696G

26,200

2

S1

7.5

7.5

7.5

7.5

7.5

108

27

27

27

27

B

73*

74

Master of Teaching (Secondary)

063697G

26,200

2

S1

7.5

7.5

7.5

7.5

7.5

108

27

27

27

27

B

73*

74

Master of Teaching (Special Education)

063698F

26,200

2

S1

7.5

7.5

7.5

7.5

7.5

108

27

27

27

27

B

73*

TEACHING ENGLISH AS A SECOND LANGUAGE (TESOL)

68

Graduate Certificate in Palliative Care

072249A

15,250

0.5

S2

6

6

6

•

•

72

18

18

•

•

B2

50*

75

Graduate Certificate in TESOL

053051F

13,100

0.5

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

68

Graduate Diploma in Palliative Care

051998D

30,500

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

75

Graduate Diploma in TESOL

062068M

26,200

1

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

68

Master of Palliative Care

024776J

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

75

Master of TESOL

060015G

26,200

2

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

68

Graduate Diploma in Palliative Care in Aged
Care

072485M

30,500

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

75

Master of Arts (TESOL)

060014G

26,200

2

S1/S2

6.5

6

6

6

6

80

18

18

18

18

C

58*

68

Master of Palliative Care in Aged Care

072486K

30,500

1.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

•

72

18

18

•

•

B2

50*

PARAMEDIC STUDIES
69

Master of Paramedic Science

088779K

29,600

2

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

083454E

33,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

PHYSICS
69

Master of Science (Physics)

PHYSIOTHERAPY
70

Master of Physiotherapy

079421D

37,300

2

S1

7

6.5

6.5

6.5

6.5

94

22

22

22

22

C

65*

073815A

15,250

0.5

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

PRIMARY HEALTH CARE
70

Graduate Certificate in Primary Health Care in
Developing Countries

PSYCHOLOGY
71

Master of Psychology (Clinical)

051844M

31,600

2

S1

7

7

7

7

7

96

24

24

24

24

C

65^

PUBLIC ADMINISTRATION

82

PEARSON
OVERALL

24

CAMBRIDGE
ADVANCED CAE

24

LISTENING

96

READING

7

WRITING

PEARSON
OVERALL

7

SPEAKING

CAMBRIDGE
ADVANCED CAE

7

OVERALL

LISTENING

7

LISTENING

READING

7

READING

WRITING

S1

WRITING

SPEAKING

4

SPEAKING

OVERALL

Doctor of Medicine

CRICOS

PG

MEDICINE
63

OVERALL

LISTENING

65,500

PG

2018 POSTGRADUATE
COURSE INDEX

INTAKE
SEMESTER 1/2

READING

077675J

CRICOS

COURSE
DURATION

WRITING

TOEFL (INTERNET)

SPEAKING

IELTS (ACADEMIC)

ENGLISH REQUIREMENTS

OVERALL

2018
FEE
(AUD)

INTAKE
SEMESTER 1/2

2018 POSTGRADUATE
COURSE INDEX

COURSE
DURATION

ENGLISH REQUIREMENTS

71

Graduate Certificate in Public Policy

053050G

14,700

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

71

Graduate Certificate in Public Sector
Management

024781A

14,700

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

71

Graduate Diploma in Public Administration

051988F

29,400

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

71

Master of Public Administration

051989E

29,400

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

71

Master of Public Administration (Management)

051990A

29,400

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

71

Master of Public Administration (Policy)

051991M

29,400

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

For notes on entry requirements, please see pg 85

THEOLOGICAL STUDIES
76

Graduate Certificate in Theological Studies

048611K

13,400

0.5

S1/S2

6

6

6

•

76

Graduate Diploma in Theological Studies

043146D

26,800

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

76

Master of Theological Studies

014823A

26,800

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

TOURISM
76

Graduate Diploma in Tourism

059257K

26,800

1

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

76

Master of Tourism

059258J

26,800

2

S1

6

6

6

•

•

72

18

18

•

•

B2

50*

WATER RESOURCES MANAGEMENT
77

Graduate Certificate in Science (Water
Resources Management)

079417M

16,500

0.5

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

77

Graduate Diploma in Science (Water
Resources Management)

079418K

33,000

1

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

77

Master of Science (Water Resources
Management)

079419J

33,000

2

S1/S2

6

6

6

•

•

72

18

18

•

•

B2

50*

For notes on entry requirements, please see pg 85
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PEARSON
OVERALL

PEARSON
OVERALL

CAMBRIDGE
ADVANCED CAE

CAMBRIDGE
ADVANCED CAE

LISTENING

LISTENING

READING

READING

WRITING

WRITING

SPEAKING

SPEAKING

OVERALL

OVERALL

LISTENING

LISTENING

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Arts (Geography and Population
Studies)

073347B

28,200

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Arts (Environmental Studies)

073614K

28,200

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Arts (Humanities)

008138F

26,000

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Arts (Education)

008138F

26,000

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Arts (Social Science)

022482F

26,600

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Business (Research)

058780K

26,700

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

external

29,000

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Engineering

010609F

32,300

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Laws

020070J

27,900

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Biological Sciences)

053061D

32,300

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Chemistry)

002646A

32,300

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Computer Science)

053062C

32,300

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Earth Sciences)

053064A

32,300

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Health Administration)

023594A

29,900

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Environmental Health)

073348A

31,000

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

(PT) Part-time

Master of Science (Mathematics/Statistics)

002644C

32,300

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Medicine-Public Health)

045236G

29,900

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

International students cannot undertake external or part-time study whilst in
Australia on a student visa.

Master of Science (Medicine-Science based)

053066K

33,000

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Nursing/Midwifery)

033066J

29,900

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Science (Physical Sciences)

053067J

32,300

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Surgery

088953A

33,000

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Master of Theology

053068G

26,000

2

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Doctor of Public Health

039963E

29,900

3

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

Doctor of Education

024773A

26,000

3

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

2018 RESEARCH HIGHER
DEGREES (DOCTOR)

IELTS (ACADEMIC)

TOEFL (INTERNET)

NOTES
GENERAL NOTES

NOTES ON ENTRY REQUIREMENTS

2018 Tuition Fee is for a standard load of 36 units per year. The quoted fee
is a base fee that will be subject to an annual increase that is at least the
rate of inflation, but no more than 9%, for each of the subsequent years
of the program. The University’s Student Services and Amenities fee for
international students is included in the tuition fee. The fee covers the cost of
teaching and student support services.

Pearson English Test
50* Overall score of 50 with 50 in writing and speaking
58* Overall score of 58 with 50 in writing, speaking, listening and reading
65* Overall score of 65 with 58 in writing, speaking, listening and reading
65^ Overall score of 65 with 65 in writing, speaking, listening and reading
73* Overall score of 73 with 73 in writing, speaking, listening and reading

OVERALL
OVERALL

SPEAKING
SPEAKING

WRITING
WRITING

READING
READING

LISTENING
LISTENING

OVERALL
OVERALL

SPEAKING
SPEAKING

WRITING
WRITING

READING
READING

LISTENING
LISTENING

CAMBRIDGE
CAMBRIDGE
ADVANCED CAE

PEARSON
PEARSON
OVERALL

003487C

32,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Chemistry)

053045D

32,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Clinical Psychology)

039996G

31,600

4

S1/S2

7

7

7

7

7

96

24

24

24

24

C

65^

PhD (Computer Sciences)

004693M

32,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Creative Arts)

002577J

26,000

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Criminology)

002577J

26,000

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Earth Sciences)

003487C

32,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Education/Humanities)

002577J

26,000

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Engineering)

011338E

32,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Environmental Health)

073350G

31,000

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

> Admissions policies for international undergraduate,
postgraduate, Study Abroad and Exchange students including
basis of admission, and assessment of qualifications

CRICOS
CRICOS

2018
2018
FEE
FEE
($AUD)
(AUD)

COURSE
COURSE
DURATION
DURATION

INTAKE
SEMESTER
SEMESTER 1/2
1/2

INTERNATIONAL
STUDENT POLICY

PhD (Biological Sciences)

2018
RESEARCH
HIGHER
RESEARCH
HIGHER
DEGREES
DEGREES(PHD)
(PHD)

84

READING

READING

2

26,000

ENGLISH REQUIREMENTS

2018
FEE
(AUD)

WRITING

WRITING

26,000

008138F

Master of Clinical Education (Research)

CRICOS

SPEAKING

SPEAKING

008138F

Master of Arts (Criminology)

TOEFL (INTERNET)

OVERALL

OVERALL

Master of Arts (Creative Arts)

IELTS (ACADEMIC)

INTAKE
SEMESTER 1/2

2018
FEE
(AUD)

2018 RESEARCH HIGHER
DEGREES (MASTERS)

COURSE
DURATION

CRICOS

INTAKE
SEMESTER 1/2

ENGLISH REQUIREMENTS

COURSE
DURATION

ENGLISH REQUIREMENTS

IELTS
IELTS (ACADEMIC)
(ACADEMIC)

INTAKE

TOEFL (INTERNET)
(INTERNET)
TOEFL

The International Student policy and procedures statement details
the specific provisions which apply to international students
undertaking a Flinders University course, except where that course
is offered by another institution on behalf of the University. In such
instances, the other institution’s policies and procedures will apply.
The statement can be found at flinders.edu.au/ppmanual/
student/international-students.cfm.

It is important that students read and understand these provisions
prior to accepting their offer at Flinders University. Specific
provisions include;
> The Universities commitment to working within the Education
Services for Overseas Students (ESOS) Act and National Code
(2007)
> The University’s commitment to working within the Code of
Practice in the Provision of Education to International Students
> English language proficiency requirements

PhD (Environmental Studies)

073615J

27,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

> Tuition fees, the payment of tuition fees, and refund policies

PhD (Geography and Population Studies)

073349M

28,200

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Laws)

011339D

27,900

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

> Duration of study, deferrals, suspension, and cancellation of
student’s enrolment policies

PhD (Mathematics/Statistics)

003371D

32,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Medicine-Public Health)

053046C

29,900

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Medicine-Science based)

053047B

33,000

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Nursing/Midwifery)

010651D

29,900

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Physical Sciences)

003487C

32,300

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Social Sciences)

006809K

26,600

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

PhD (Theology)

053049M

26,000

4

S1/S2

6.5

6

6.5

6

6

80

18

18

18

18

C

58*

For notes on entry requirements, please see pg 85
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APPLYING TO FLINDERS
The following pages provide a summary of the application process.
For more detailed information, visit our website:
international.flinders.edu.au

86

87

ENTRY
REQUIREMENTS

PATHWAYS TO
FLINDERS

ACADEMIC ENTRY
ENGLISH LANGUAGE ENTRY
To enrol at Flinders as a
REQUIREMENTS
REQUIREMENTS
postgraduate student you
must meet the following
For applicants whose first language is not
For graduate certificates, graduate diplomas
English, you will need to have:
and masters programs:
academic and English language
• 	achieved the required test score for your
• 	For most degrees you must have
proficiency requirements for
course as listed in the course index at the
satisfactorily completed a degree
back of this publication. Test results must
considered comparable to an Australian
admission:
be no more than two years old on the
bachelors degree.

Don’t meet our academic
or English language entry
requirements? There are other
pathways to Flinders.

• Some degrees may require work
experience to meet the entry requirements.
A reference or statement from your
employer will be required.
For masters by research and doctor of
philosophy (PhD):
• For admission to a research higher degree
program, you normally need an Honours
Class 1 or 2A degree or equivalent,
although other qualifications may be
considered.
• Direct entry into a PhD is also dependent
on the strength of your research
background and you may be required
to undertake a qualifying program if
your research profile is not considered
sufficient.
Some specific courses have additional entry
requirements. These can be found at:
flinders.edu.au/postgrad/apply

88

Applicants who do not meet our English
language requirements and need to improve
their proficiency can do so through our
approved English language (ELICOS)
providers. This means you can attend
the required English language tuition at
approved ELICOS providers and gain
direct entry into Flinders once meeting the
required level, without having to sit an IELTS
or TOEFL test.

proposed date of commencement of the
course; or

Flinders’ approved ELICOS providers
include:

• successfully completed an approved
secondary or tertiary qualification,
taught in the English language in a
country where Flinders recognises
English as the official language or the
main language spoken (for up to an overall
IELTS of 6.5), with evidence no more than
five years old on the proposed date of 		
commencement of the course; or

• F
 linders International Study Centre
isc.flinders.edu.au

• 	successfully completed a pre-course
English program from an approved
ELICOS provider (evidence of completion
must be no more than two years old on the
proposed date of commencement of the
course).
Other evidence of English language
proficiency may be accepted.
For more information visit:
flinders.edu.au/englishrequirements

• Intensive English Language Institute (IELI)
located on campus at Flinders
ieli.sa.edu.au
• Eynesbury College
eynesbury.navitas.com
• English College of Adelaide
eca-jca.edu.au
• South Australian College of English
(SACE) sacecoll.sa.edu.au
For more information, please visit:
flinders.edu.au/international/pathways

PATHWAY TO A RESEARCH
HIGHER DEGREE
We offer a Graduate Diploma in Research
Methods as a pathway to a research higher
degree.
For more information, please see page 72
of this guide, or visit:
flinders.edu.au/graduate-research/
pathways

PRE-MASTERS BUSINESS
PROGRAM AT FLINDERS
INTERNATIONAL STUDY
CENTRE

CRICOS Code: Accelerated - 085891A
CRICOS Code: Standard - 085892M
Specifically designed for international
students, the Pre-Masters Business
Program is an advanced course of English
language and academic preparation. The
course will fully prepare you for joining the
Master of Business, Master of Accounting
or Master of Accounting and Finance
degree at Flinders University.
For more information, please visit:
isc.flinders.edu.au/our-courses/premasters-program

89

ADMISSION
PROCESS
Our admission process is a
simple four-step process.

1
2
3
4

YOUR APPLICATION

START YOUR
APPLICATION
YOUR APPLICATION

ARRIVAL AND ORIENTATION

Submit your application, making sure you
include all the required documents as
attachments.

Pre-arrival information to assist you prior to
your departure for Adelaide is also available
in the International Student Handbook at:
flinders.edu.au/international/services

Once your application is received by
Flinders University International Centre,
you will be sent an acknowledgement of
your application being received and we
will advise you if any further information or
documentation is required.

YOUR OFFER OF ADMISSION
YOUR OFFER
OF ADMISSION

CONFIRMATION
OF ENROLMENT

ARRIVAL AND
ORIENTATION

Your offer of admission is usually sent
out to you by email. If you do not have an
email address we will post the offer letter
directly to you or email your agent. We will
endeavour to send your offer letter within
10-14 working days, however there may
be delays where you have applied for a
course with strict quotas or additional entry
requirements, or where credit/exemption is
sought for previous study.
Included in the offer of admission is a
weblink to ‘Your Offer Letter Explained’. At
this stage you will be required to accept the
offer by completing the acceptance form
and any associated declarations. You will
also be required to pay the relevant tuition
fees for the first semester and visa-length
Overseas Student Health Cover (OSHC) as
detailed in your offer of admission.

CONFIRMATION OF
ENROLMENT
We will issue the Confirmation of Enrolment
(COE) upon receipt of the signed
acceptance, review of the declaration, and
payment of fees and OSHC.
With the COE you can apply for your
student visa. Please check your visa
requirements at:
border.gov.au

APPLYING
THROUGH AN
AGENT
Flinders University has a network of
agents situated in more than 400
offices around the world. We encourage
you to talk to someone face-to-face
about your unique situation to ensure
that any information you get is tailored
specifically for your needs.
Agents can provide you with:
• answers to specific questions that
relate to your own situation

If you require support
submitting your application
please contact us via our
website or contact an
agent in your country.
flinders.edu.au/
international/
recruitmentagents

STEP 1

SELECT YOUR COURSE
OR PROGRAM
Flinders University offers a wide range of postgraduate and
research programs. When choosing your course there is a
lot for you to consider. What type of course should you do,
what qualification will you get at the end and what are your
career goals? Take the time to research which course suits
your ambitions best.

STEP 2

CHECK ENTRY
REQUIREMENTS
Decided which course you would like to apply for? You
will need to check that you meet our entry requirements. If
you do not meet these requirements there are still options
available to you. Why not consider enrolling in one of our
pathway or preparatory programs? Please visit our website
for further information:
flinders.edu.au/international/pathways

STEP 3

COMPLETE AND SUBMIT
AN APPLICATION FORM
• Selected a course?
• Met our entry requirements?
• Checked credit transfer eligibility?

You are now ready to complete our application form.
You can apply online simply by clicking the ‘apply’ button
at: flinders.edu.au/international

• up-to-date and intensive education
counselling
• assistance in application and visa
processing
• pre-departure and arrival assistance
• IELTS and TOEFL support
• assistance with travel arrangements,
including obtaining a student visa

For more information visit:
flinders.edu.au/international/
recruitmentagents

90

Looking to
apply for a course at
Flinders? Follow our
step-by-step guide to
help you through the
application process.

APPLICATION FEE

Prospective and current students should not use
the Online Application System when applying for:
• a research higher degree
• a packaged program
• an internal transfer
• a deferral
Please email
internationalapply@flinders.edu.au or come
to the International Centre for details on how to
apply for these options.

NOTE: EXTERNAL COURSES
International students cannot undertake external
courses while in Australia on a student visa.

RESEARCH DEGREES
• You need to think about possible research
projects and topics that align with your interests,
qualifications and experience. Please view:
flinders.edu.au/expertise
•F
 ill in the online Expression of Interest form at:
flinders.edu.au/courses/rhd/interest
•O
 nce your research area is confirmed, you can
lodge a full application with the university. The
university will advise you of the outcome.

WHEN TO APPLY
Applications can be made at any time during the
year to available course intakes. Admission to some
programs is very competitive as places are limited.
Some courses have specific application deadlines.
Please contact the International Centre for more
information.

An application fee of AUD$60 is required upon
submission of the online application. If you need
assistance completing the online application form you
may wish to contact the International Centre or one of
our authorised agents who will be happy to help you.
The University does not charge an application fee if
you submit online via an agent. See our website for
details:
flinders.edu.au/international
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TERMINOLOGY
You may have come across some terms in this guide that are unfamiliar to you. This list of terminology will
help you to better understand what we mean. You may also find it handy when visiting our website.
ACADEMIC ENGLISH PREPARATION (AEP)

DIPLOMA

HONOURS DEGREE

POSTGRADUATE COURSES

Program aimed at improving your English language and
academic skills prior to commencing study at Flinders University.

A formal qualification usually requiring the equivalent of two
years of full-time study. At Flinders, the diploma can be studied
as a qualifying program for students who do not meet the entry
requirements for a bachelor degree.

Awarded to undergraduate students who choose to complete
an additional year of study. In the case of four-year degree
programs, honours may be awarded to students who perform
particularly well.

Students must normally have an undergraduate degree to begin
studying any postgraduate course; this is sometimes known as
graduate studies.

ELECTIVE TOPICS

INTERNATIONAL ENGLISH LANGUAGE TESTING
SYSTEM (IELTS)

ACADEMIC STAFF
All teaching and research staff, including professors (the most
senior), associate professors or readers, senior lecturers,
lecturers, associate lecturers and tutors.

ACADEMIC YEAR
Begins in late February or early March and ends in late
November.

ENGLISH LANGUAGE INTENSIVE COURSES FOR
OVERSEAS STUDENTS (ELICOS)

AUSTRALIAN CENTRAL STANDARD TIME (ACST)

Programs for students who require English language training
before commencing formal studies in Australia.

Time zone for Adelaide and South Australia.

AWARD
A degree, certificate, diploma, masters or PhD of the University
granted at the completion of a course of study .

BACHELOR DEGREE

EXCELLENCE IN RESEARCH FOR AUSTRALIA (ERA)
Australia’s national research evaluation framework.
Excellence in Research for Australia identifies and promotes
excellence across the full spectrum of research activity in
Australia’s higher education institutions.

Normally the basic (first) undergraduate degree.

EXTERNAL STUDENT

CENTRAL BUSINESS DISTRICT (CBD)

A person undertaking all of their study by correspondence on
either a full-time or a part-time basis, and who is enrolled as an
external student.

The commercial and business centre of a city.

CONFIRMATION OF ENROLMENT (COE)

FLINDERS LEARNING ONLINE (FLO)

Measures the language proficiency of people who want to study
or work where English is used as a language of communication.

INNOVATIVE RESEARCH UNIVERSITIES (IRU)
Innovative Research Universities (IRU) is a network of 6
comprehensive universities across Australia committed to
inclusive excellence in teaching and research.

INTERNATIONAL NETWORK UNIVERSITIES
(INU)
A global consortium comprised of higher education institutions
that actively seek international partnerships and experiences,
create innovative programming and delivery methods, and
embrace the internationalisation movement.

INTERNATIONAL STUDENT BAROMETER (ISB)
The global benchmark for the international student experience
conducted by iGraduate.

A COE is a document provided by the University to an
international student who studies in Australia on a student visa.
It confirms that an international student is eligible to enrol in
a course. You do not need a COE if you are a local student,
or an international student studying in Australia on an AusAID
Scholarship, or on a temporary residence or permanent residence
visa.

Flinders University’s core online learning and teaching application.

INTENSIVES

FLINDERS UNIVERSITY STUDENT ASSOCIATION
(FUSA)

Where a topic is studied over a short period of time (eg week or
weekend) with the same number of contact hours as a semester
length topic.

The on-campus student organisation that exists for the purpose of
representing students’ rights and interests.

INTERNATIONAL STUDENT SERVICES (ISS)

CORE TOPICS

FLINDERS INTERNATIONAL STUDY CENTRE (ISC)

Compulsory subjects that form the basis of a study program.

Flinders International Study Centre (ISC) offers academic English
preparation (AEP), foundation and diploma programs for students
who seek to qualify for Flinders undergraduate courses.

COURSE
A program of study leading to a degree or diploma.

COURSE COORDINATOR
The staff member who is responsible for a particular course.
The course coordinator is your main contact person at the
university. The course coordinator will advise you on matters like
enrolment, topic selection, study program, and problems with
study. The course coordinator consults with Enrolment Services
in authorising your enrolment in topics, amendment of enrolment
and withdrawal from topics for your course.

CREDIT
Credit is sometimes given for relevant topics or units previously
studied, for which a student is given an exemption.
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Topics which can be chosen to support core topics – often called
optional topics in science degrees.

International Student Services (ISS) is the first point of contact for
international students and offers a range of programs supporting
your enrolment, study and social life, as well as a referral service to
facilities on campus and within the local community.

MAJOR SEQUENCE

FOUNDATION PROGRAM

A sequence of topics that must be taken in all three years of a degree.

The Foundation Program is a comprehensive academic program
which prepares students for university-level learning.

MINOR SEQUENCE

GRADUATE
A person who has received his or her degree.

GRADUATION
A ceremony at which degrees are conferred and diplomas
awarded, and is usually held in April and December.

A small number of topics in one area of study.

NEW VENTURE INSTITUTE (NVI)
New Venture Institute is the centre of innovation and
entrepreneurship at Flinders University. Through programs
and activities they aim to inspire, connect and educate future
generations of entrepreneurs and innovators.

PREREQUISITE
A topic that must be completed before a higher-level topic can
be studied; it is the student’s responsibility to ensure that topic
prerequisites have been met.

PRE-MASTERS PROGRAM
A qualifying program for students who do not meet the entry
requirements for a postgraduate masters degree.

SEMESTER
The academic year is divided into two semesters – usually late
February to mid June, and late July to November.

STUDENT LEARNING CENTRE (SLC)
The Student Learning Centre (SLC) is a multidisciplinary
academic support service for Flinders University students.

TEST OF ENGLISH AS A FOREIGN LANGUAGE
(TOEFL)
A standardised test to measure the English language ability
of non-native speakers wishing to enrol in English-speaking
universities.

TOPIC
A subject that is studied as part of a degree program.

TOPIC CODES
Topic codes consist of a four-character alpha code followed by a
four-digit code. These eight characters form the total topic code, eg
EDUC1120 Teaching and Educational Contexts. These should be
quoted whenever you are making an enquiry about enrolling in a topic.

UNDERGRADUATE DEGREE
A first degree.

UNIT
The measure of weighting given to a topic as specified in the
syllabus for that topic. Each topic is given a weighting in units,
roughly proportional to its length. Most full-time students complete
36 units a year to gain the 108 units needed to qualify for their
degree if they are undertaking a three-year bachelor degree.

WORK INTEGRATED LEARNING (WIL)
A program designed to give students the opportunity to link theory
and practice with valuable workplace experience while studying.

PEARSONS TEST OF ENGLISH (PTE)
Pearson Test of English is an English language test for students
wishing to enrol in English-speaking universities.
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NOTES

USEFUL LINKS
These links may be useful as you plan your study at Flinders University and settle into life in Adelaide.

CONNECT WITH US:
DISCOVER FLINDERS:
FLINDERS LIVING:
flinders.edu.au/living

INTERNATIONAL CENTRE:
international.flinders.edu.au

INTERNATIONAL STUDENT SERVICES:
flinders.edu.au/international/services

LIFE IN ADELAIDE:
GETTING AROUND:
adelaidemetro.com.au
southaustralia.com/regions/adelaide-city-getting-here-around.aspx

MARKETS:
southaustralia.com/regions/adelaide-city-markets.aspx

SHOPPING:
southaustralia.com/regions/adelaide-city-shopping.aspx

EATING OUT AND ENTERTAINMENT:
southaustralia.com/DiningInAdelaide.aspx

ATTRACTIONS:
southaustralia.com/regions/adelaide-city-attractions.aspx

OTHER USEFUL LINKS:
DEPARTMENT OF IMMIGRATION AND BORDER PROTECTION:
immi.gov.au

ESOS FRAMEWORK:
aei.gov.au/Regulatory-Information

OVERSEAS STUDENT HEALTH COVER:
bupa.com.au/students

STUDY ADELAIDE:
studyadelaide.com
Disclaimer
The information contained in this publication is accurate at the time of publication: January 2017. Flinders University reserves the right to alter
any course, topic or fees contained herein without prior notice.
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